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Visit the Cross Portfolio Best Practices Library at https://hpln.hp.com/group/best-practices-hpsw to access
a wide variety of best practice documents and materials.
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Chapter 1: Lab Management at a Glance
HP ALM LabManagement enables you tomanage the resources that you use for ALM server-side
testing.

ALM tests can run using different modes of execution. If you are an ALM Edition or Performance Center
user, you have access to Functional and Performance test sets which can run immediate or scheduled
tests on remote testing hosts. You use ALM to deploy and test your builds in an end-to-end fashion, and
use LabManagement to manage the testing resources which form the infrastructure of ALM's server-
side testing functionality.

LabManagement consists of the following groups of modules: 

Lab Settings
Enable you tomanage how resources aremonitored, maintained, and distributed to your ALM projects.
This group consists of the followingmodules:

Project Settings Manage the settingsof each of your ALMprojects. Define host limit settingsand assign host pools to a
specific project.

Maintenance
Tasks

Monitor the taskswhich locate and repair failures in your system's keycomponents.

Cloud Settings
Allow you to add cloud accounts and host templates used to provision cloud testing hosts in ALM.

Cloud Accounts Add your external cloud accounts to ALM.

Host Templates Create andmodify the templatesused to provision cloud hosts.

Lab Resources
Enable you to create and define the testing hosts and pools available for server-side testing.

Hosts Create andmodify the testing hostsALM uses to run server-side tests.

Pools Create andmodify poolsof testing hosts. Host poolsare assigned to ALM projects.

Locations Define the locationswhich can be assigned to testing hosts.

Timeslots Schedule and reserve hosts for manualmaintenancework.

Performance Center
Enable you tomanage the resources, settings, and test result data relevant to Performance Center.

PC Test
Runs

View test result information for PerformanceCenter tests run acrossall projects.

Usage
Reports

Analyze PerformanceCenter site usersand resource usage.
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System
Health

Trackandmaintain the health of the system.

PC Licenses Maintain the PerformanceCenter and PerformanceCenter host licenses.

MI Listeners Create andmodifyMI Listeners, which enable you to run performance testsacrossa firewall.

Diagnostics Configure the integration of diagnosticmodules to enablemonitoring and analysis of the performance of
complexapplicationsunder test.

Patches Upload application patchesso theycan be installed on PerformanceCenter serversand hosts.

AUT Hosts Create andmodify themachineswhich host the Application Under Test (AUT) components.

AUT Host
Pools

Create andmodify poolsof AUT hosts.

Servers
Enable you to create and configure the servers used for performance testing and test deployment.

PC Servers Create PerformanceCenter serversandmange how theyare used for performance testing.

CDA Servers Create andmodifyHPContinuousDeliveryAutomation (CDA) servers, which enable ALM to dynamically
deployenvironments for server-side testing using the cloud.
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Chapter 2: Lab Management
Administration
This chapter includes:

• Introduction to LabManagement Administration 14
• How to Create LabManagement Administrators 14
• How toWork with LabManagement Administration 14
• LabManagement Administration User Interface 17
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Introduction to Lab Management
Administration
A LabManagement user must be assigned administrator privileges to perform administrator tasks,
such as creating andmaintaining hosts and host pools.

LabManagement users are defined or assigned an administrator role in ALM Site Administration. For
details on how to create a LabManagement administrator user, see "How to Create LabManagement
Administrators" below.

For related task details, see "How toWork with LabManagement Administration" below.

How to Create Lab Management Administrators
This task describes how to create a LabManagement administrator user, who is responsible for all
project administration tasks in LabManagement and in Site Administration.

Note:

l This task is a prerequisite for the task, "How toWork with LabManagement Administration"
below.

l This task is performed in Site Administration. For details about logging in to and using Site
Administration, refer to theHP Application Lifecycle Management Administrator Guide.

To create a Lab Management administrator user:

1. Log in to Site Administration.
2. In theSite Users tab, create a new user.
3. In the Lab Management tab, select the Lab Management Users tab. For user interface details,

see "LabManagement Tab" on page 18.
4. Add the user you created above, and select theProject Administrator option for the new user.

How to Work with Lab Management
Administration
This section lists the tasks that a LabManagement administrator can perform.

Some of the tasks below are available only for projects with Performance Center licenses.

l "Prerequisites" on the next page
l "Perform initial Performance Center configuration" on the next page
l "Create Performance Center projects and define project settings" on the next page
l "Manage andmaintain LabManagement lab resources" on the next page
l "View andmanage performance test runs" on the next page
l "View Performance Center usage reports" on the next page
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l "Upload application patches" on the next page
l "Manage Performance Center Servers" on the next page
l "Manage Performance Center and Performance Center host licenses" on the next page
l "Manage Diagnostic Servers andMediators" on the next page
l "Maintain system health" on the next page
l "Change the Performance Center system user" on the next page
l "Update the Communication Security passphrase" on the next page
l "Update the secure host communication settings" on the next page
l "Configure general Performance Center settings" on the next page

Prerequisites
To perform any of these tasks, youmust be a LabManagement administrator. For details on how to
create a LabManagement administrator, see "How to Create LabManagement Administrators" on the
previous page.

Perform initial Performance Center configuration
Immediately after installing the Performance Center components, the relevant component's
configuration tool opens, prompting you for initial configuration settings. If this configuration was
skipped, youmust configure the settings manually before you can start working with Performance
Center.

For details, refer to theHP ALM Performance Center Guide.

Create Performance Center projects and define project settings
You create projects in Site Administration, and define the limits and other settings for the project in Lab
Management, in the Project Settings module. For details, see "How to Create a Project" on page 22.

Manage and maintain Lab Management lab resources
Youmanage hosts, host pools, and host locations from the Lab Resources modules. For details, see
"How toManage Testing Hosts" on page 97.

When you plan to perform maintenance tasks on the hosts—such as installing patches, rebooting
hosts, and so on—it is recommended to reserve these hosts in timeslots. This way, you can be sure
that they are available for maintenance. For details, see "How to Reserve Timeslots" on page 105.

View and manage performance test runs
The test runs from all the LabManagement in the system can be viewed andmanaged in the Test Runs
module. For details, see "PC Test Runs ModuleWindow" on page 141.

View Performance Center usage reports
Performance Center usage reports provide you with an overall analysis of Performance Center site
users, resource usage, concurrent resource usage vs. license limitations, timeslot usage, as well as
resource usage by duration and runs. For details, see "How to Generate Usage Reports" on page 147.
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You can also export these reports to PDF and Excel format. For details, see "How to Export Reports to
PDF or Excel Formats" on page 148.

Upload application patches
Before you can install application patches on Performance Center Servers and hosts, youmust upload
the patches to the system. For details, see "How to Upload Patches to ALM" on page 212.

Manage Performance Center Servers
Youmanage Performance Center Servers in LabManagement from the PC Servers module. For
details, see "How toManage Performance Center Servers" on page 236.

Manage Performance Center and Performance Center host licenses
Youmanage the Performance Center license and Performance Center host license in LabManagement
from the Licenses module. For details, see "PC Licenses ModuleWindow" on page 185.

Manage Diagnostic Servers and Mediators
Integrating diagnostics modules with ALM enables monitoring and analysis of the performance of
complex applications under test. For details on setting up the diagnostics modules, see "Diagnostics
Management" on page 196.

Maintain system health
You track andmaintain the health of the system from the System Health module. For details, see
"System Health Overview" on page 179.

Change the Performance Center system user
You use the System Identity Utility, installed on the Performance Center Server, to change the
Performance Center system user on the Performance Center Server and hosts. For details, refer to the
HP ALM Performance Center Guide.

Update the Communication Security passphrase
You use the System Identity Utility, installed on the Performance Center Server, to update the
Communication Security passphrase on the Performance Center Server and hosts. For details, refer to
theHP ALM Performance Center Guide.

Update the secure host communication settings
Initially, you define secure communication settings on each Performance Center host or standalone
load generator using the Host Security Setup utility, installed locally on each host or load generator. For
details, refer to theHP ALM Performance Center Guide.

To update these settings on all the hosts and load generators simultaneously, you can use the Host
Security Manager, installed on the Performance Center Server. For details, refer to theHP ALM
Performance Center Guide.

Configure general Performance Center settings

Youmanage general Performance Center settings in LabManagement. On themasthead, click
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and select Performance Center General Settings. For user interface details, see "General Settings
Dialog Box" on page 19.

Lab Management Administration User Interface
This section includes:

• LabManagement Tab 18
• General Settings Dialog Box 19
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Lab Management Tab
The LabManagement tab in Site Administration enables you tomanage LAB_PROJECT project details
and define LabManagement users who are responsible for LabManagement administration tasks.

To access In Site Administration, click theLab Management tab.

Relevant tasks "How to Create Lab Management Administrators" on page 14

See also "Introduction to Lab Management Administration" on page 14

User interface elements are described below:

UI Elements Description

Edit Connection String.Edits the connection string for LabManagement. For details on editing the
connection string, refer to theHP Application Lifecycle Management Administrator Guide.

Ping Project.Checkswhether the project database isaccessible fromSite Administration.

Maintain Project. Enablesyou to verify, repair, and upgrade projects. For details, see theHP
Application Lifecycle Management Administrator Guide.

Activate/Deactivate Project.When you deactivate LAB_PROJECT, users cannot log in to Lab
Management. Anyusers currently connected to the project are forced to log out when you deactivate.
LAB_PROJECT isnot deleted from the server.

In addition, users cannot connect to projects linked to LAB_PROJECT, and currently connected usersare
disconnected.

Restore Lab Project.Restoresaccess to LAB_PROJECT and adds it to the LabManagement tab in
Site Administration. Restoring a LAB_PROJECT allowsyou to use onlyLabManagement projects that
were created in the restored LAB_PROJECT.

For more details on the restore process, refer to theHP Application Lifecycle Management
Administrator Guide.
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UI Elements Description

Remove Lab Project.RemovesLAB_PROJECT from the LabManagement tab in Site Administration.
Thisdoesnot delete LAB_PROJECT from the server and you can restore it if necessary. If the project is still
active, you are prompted to deactivate it.

Removing LAB_PROJECT deactivatesall associated LabManagement projects. These projects can be
enabled onlyby restoring this version of LAB_PROJECT.

Lab
Management
Details tab

Enablesyou to view and edit LAB_PROJECT details for working with LabManagement. For more
information on the viewing and editing project details, refer to theHP Application Lifecycle
Management Administrator Guide.

Lab
Management
Users tab

Enablesyou to assign userswho are responsible for LabManagement administration. For more
information, refer to theHP Application Lifecycle Management Administrator Guide.

General Settings Dialog Box
This dialog box enables you to define general settings for Performance Center.

To access
In LabManagement, on the ALMmasthead click and selectPerformance Center
General Settings.

Important
information

The settingsdefined here are general settings for the PerformanceCenter system.

Relevant tasks "How to Work with Lab Management Administration" on page 14

See also "Introduction to Lab Management Administration" on page 14

User interface elements are described below:

UI Elements Description

PC Server > PC Server
Settings page

Enablesyou to define PerformanceCenter Server cache setting:

l Unlimited cache size.ThePerformanceCenter Server cache size is unlimited
and the cache isnot cleaned.

l Cache size. The PerformanceCenter Server cache size in gigabytes.
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UI Elements Description

Default: 1GB

Data Processor > Data
Processor Settings page

Enablesyou to define data processor settings:

l Data Processor Timeslot minimum length (minutes).Theminimum
amount of time, inminutes, that a data processor timeslot should be allotted.

Default: 1minute
l Timeout for pending data processor task (minutes). The amount of time a

data processing taskshould be allowed to remain in a pending state.

Default: 30minutes

Apply Saves the settings that you have defined.

Use Default Restores the default PerformanceCenter Server andData Processor settings.

LabManagement Guide
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Chapter 3: Project Settings
This chapter includes:

• Project Settings Overview 22
• How to Create a Project 22
• Project Settings User Interface 24
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Project Settings Overview
The Project Settings module enables you tomonitor andmodify the project settings, including:

l General project details
l Using IP addresses as targets for performance testing
l VUDs Vusers allocation to the project and usage
l Timeslot settings for the project
l Controller settings for the project
For details about how to use Target IP Addresses, see "Using Target IP Addresses" below.

Using Target IP Addresses
Target IP addresses are assigned so that the addresses of all hosts on a given network share a
common prefix. The common prefix defines the network portion of the IP address, and the remainder
defines the host portion (also referred to as the local portion).

The term network in this context refers to a logical network whichmight span one or more physical
networks. The network portion of an IP address identifies a site and the local portion identifies a single
host at that site.

Using SubnetMasks
A site using subnet addressingmust specify a 32-bit subnet mask for each network. Each bit in the
subnet mask is set to 1 if the network treats the corresponding bit in the IP address as part of the
network address or 0 if it treats the corresponding bit in the IP address as part of the host ID.

Consider, for example, the subnet mask

11111111 11111111 0000000 0000000

(or in decimal form, 255.255.0.0). This subnet mask specifies that the first two octets identify the
network and the last two octets identify the host on that network.

The subnet mask 255.255.255.255 (or in binary form, 11111111 11111111 11111111 11111111), which
you add when defining individual IP addresses, specifies that all four octets in the IP address identify
the network and host as if there were no subnet mask. In practice, this means that null uses the exact
IP address to target performance tests.

How to Create a Project
This task describes how to create a project. You create projects in Site Administration, and define
project settings in LabManagement.

Note:
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l This task is part of a higher level task. For details, see "How toWork with LabManagement
Administration" on page 14.

l Product Feature Movie. To view amovie that demonstrates how to create a performance
testing project, select Help > Movies in the ALMmain window.

This task includes the following steps:

l "Log in to Site Administration" below
l "Create a project domain - optional" below
l "Create project administrator users" below
l "Create a new project" below
l "Assignmore project administrators to the project - optional" below
l "Define the project's settings" on the next page
l "Add and customize the project users " on the next page

1. Log in to Site Administration
Open yourWeb browser and type the ALM URL in the following format:

http://<ALM name>[<:port number>]/qcbin

In the HP Application Lifecycle Management window, click Site Administration.
Enter your Site Administrator user name and password and click Login.

2. Create a project domain - optional
Click theCreate Domain button and enter a name for the new domain, and click OK.

3. Create project administrator users
a. Select theSite Users tab, and click theNew User button. The New User dialog box opens.
b. Enter the details of the project administrator user, and click OK.
c. Select the user, click Password and enter the password. Click OK.

For more details, see theHP Application Lifecycle Management Administrator Guide.

4. Create a new project
a. Click theSite Projects tab, and select the domain in which you want to create the project.
b. Click theCreate Project button, and follow the steps to create the project. When prompted:

o Add the project administrator users you created above.
o If it is not enabled already, select ALM Lab Extension.
For more details, see theHP Application Lifecycle Management Administrator Guide.

5. Assign more project administrators to the project - optional
To add additional project administrators:
a. Click theSite Projects tab.
b. In theProjects list on the left, select the project you created.

LabManagement Guide
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c. In the right pane, click theProject Users tab.
d. Add another user, and select Project Administrator.

6. Define the project's settings
Projects are created with default settings which you canmodify if desired. You define the project
settings in Lab Management as follows:
a. Log in to Lab Management with your administrator user name and password.
b. On the Lab Management sidebar, under Lab Settings, select Project Settings.
c. Define at least the following settings: Host limit, Vuser limit, andConcurrent Run limit.

For user interface details, see " Project Settings Details Dialog Box" on page 28.

Note: Project administrators can view the project settings in the project in ALM, and can
modify some of the project settings. To access the project settings in ALM, on the ALM

masthead, click and select Lab Settings.

7. Add and customize the project users
This step is performed by the project administrator. For details, see theHP Application Lifecycle
Management Administrator Guide.

Project Settings User Interface
This section includes:

• Project Settings Module 25
• Project Settings ModuleMenus and Buttons 26
• Project Settings Module Fields 27
• Project Settings Details Dialog Box 28
• Performance Center Controller Options Dialog Box 33
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Project Settings Module
This module enables you to view andmanage all of the projects and their settings.

To access On the sidebar, under Lab Settings, selectProject Settings.

Important Information Thismodule displaysa list of all of the projects in ALM.

Alternatively, you can accessproject settings fromwithin a particular project.

Relevant tasks "How to Create a Project" on page 22

See also "Project Settings Overview" on page 22

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Project Settings
module common UI
elements>

l Project Settings module fields. For field definitions, see "Project Settings
Module Fields" on page 27.

l Project Settings module menus and buttons.For command and button
descriptions, see " Project Settings Module Menus and Buttons" on the next
page.

l ALM main menu and sidebar.For details on theToolsmenu,Helpmenu and
sidebar, see theHP Application Lifecycle Management User Guide.

<Project Settings grid> Displaysa list of the projects in ALMand their project settings.

PC VUDs transactions
tab

Displays the PC VUDs transactions in each projects. For details, see " Project Settings
Details Dialog Box" on page 28.

History tab Lists changesmade to the currently selected project. For more details, see theHP
Application Lifecycle Management User Guide.
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Project Settings Module Menus and Buttons
The Project Settings module enables you to view andmanage project settings.

To access l On the sidebar, under Lab Settings, selectProject Settings.

l Project administrator: In ALM, on themasthead, click and select Performance
Center Project Settings.

Important
information

If you are a project administrator, you can view the current project's settings in ALM. You can also
modify some of the settings.

Menus and toolbars of the Project Settings module are described below:

UI
Elements
(A - Z)

Where Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User Guide.

Copy URL Project
Settings
and
<right-
click
menu>

Copiesa selected project and pastes itsURL asa link. The project itself is not copied. Instead,
you can paste the address into another location, such asan email or a document. Clicking the
linkopensup ALMand takesyou to the project file or folder. If you are not already logged in,
ALM first prompts for login details.

Export Project
Settings
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the project settings in the grid as
a text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Choose one of the following options:

l All.Exports all project settings in the grid.
l Selected.Exports selected project settings in the grid.

Find
View Opens the Find dialog box, enabling you to search for project settings in themodule. For details

about search options, see theHP Application Lifecycle Management User Guide.

Go to
Project
Settings

Project
Settings

Opens theGo ToProject Settingsdialog box, enabling you to find a specific project settings
record by its ID number.

Grid Filters View and
<right-
click
menu>

Enables you to filter the data according to an entry in the filter box. For details about filtering
options, see theHP Application Lifecycle Management User Guide.

Information
Panel

View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

Organize
Favorites

Favorites Opens theOrganize Favoritesdialog box, enabling you to organize the list of favorite viewsby
changing propertiesor deleting views. For details, see theHP Application Lifecycle
Management User Guide.

Project Project Opens the Project SettingsDetails dialog box, enabling you to view and edit details of the
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UI
Elements
(A - Z)

Where Description

Settings
Details

Settings
and
<right-
click
menu>

selected project.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-
click
menu>

In the Project Details grid, opens theReplace dialog box, enabling you to replace a field value in
the grid. For more details, see theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in the
grid and their order. For more details, see theHP Application Lifecycle Management
User Guide.

For details about the project setting fields, see "Project Settings Module Fields" below.

Set
Filter/Sort

View Enables you to filter and sort the project settings in the grid. Anycurrently applied filtersor
sorting ordersare displayed below the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Update
Selected

Edit and
<right-
click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for amultiple
selection in the grid. For more details, see theHP Application Lifecycle Management
User Guide.

Project Settings Module Fields
This section describes the Project Settings module fields:

Field Description

AUT Pool TheAUT host pool of the project.

Build
Verification
Suite Auto-
Extend Duration

The number of minutesbywhich a build verification suite timeslot is automatically extended if the initial
timeslot is not long enough. Requires that AutomaticallyExtend Timeslot is enabled for the timeslot
and requires that the appropriate testing resourcesare available to extend the timeslot.

CDA Domain The domain of the CDA server.

CDA Server The name of the CDA server.

Concurrent Run
Limit

Themaximumnumber of concurrent test runsallowedwithin a project.
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Field Description

Diagnostics
Server

TheDiagnosticsServer defined for the project.

Domain Name The domain in which the project wascreated.

Functional Test
Auto-Extend
Duration

The number of minutesbywhich a functional test timeslot is automatically extended if the initial timeslot
is not long enough. Requires that AutomaticallyExtend Timeslot is enabled for the timeslot and
requires that the appropriate testing resourcesare available to extend the timeslot.

Host Limit The total number of hosts (Controller + load generators) reserved for a timeslot maynot exceed this
limit.

ID The project's ID.

Maximum Times
to Automatically
Extend Timeslot

Themaximumnumber of times that a timeslot can be automatically extended if the initial timeslot is not
long enough for the BVSor functional test set to complete.

Pool The project's host pool.

Project The name of the project.

VUDs
Consumed

The number of VUDsconsumed by the project.

VUDs Limit Themaximumnumber of VUDsavailable to the project.

VuGenWorking
Mode

Themode to use to upload scripts fromVuGen:

l Runtime Files mode.Uploadsonly the necessary files to replay the script correctly.
l User Defined mode. Uploadsanyavailable files including thumbnail images.

Vuser Limit Themaximumnumber of Vusersa project can run at once. The total number used byall of the
project's concurrent performance testsmust not exceed this limit.

Project Settings Details Dialog Box
This dialog box enables you to configure settings for a project.

To access In Lab Management:

1. On the sidebar, under Lab Settings, selectProject Settings.
2. Right-clicka project in the grid, and selectProject Settings Details.
In ALM:

On the ALMmasthead, click and selectPerformance Center Project Settings.

Important
information

TheController Optionspage isavailable onlywhen logged in to a particular project. You cannot set
Controller options in LabManagement.

Relevant tasks "How to Create a Project" on page 22

See also "Project Settings Overview" on page 22
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Common Elements
Common user interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of projects.

Available from: LabManagement only

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Project The name of the project.

Details Page
This page displays the general details about the selected project. For details, see "Project Settings
Module Fields" on page 27.

PC Target IPs Page
This page enables you to define IP addresses to use as targets for performance testing.

Important
Information

Target IP can be defined on PerformanceCenter hostsonly, and not on standalone load
generators.
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Relevant tasks "How to Create a Project" on page 22

See also "Using Target IP Addresses" on page 22

User interface elements are described below:

UI
Elements

Description

New.Opens theNew Target IP dialog box, enabling you to define an IP to use asa target for performance
testing.

Edit.Opens the Target IPDetails dialog box, enabling you to view and edit details of the selected target IP.

Delete.Enablesyou to delete the selected target IPs.

Refresh.Refreshes the grid so that it displays themost up-to-date information.

IP A target IP address.

Mask A32-bit subnetmask for each network.

PC VUDs Transactions Page
This page enables you to follow the PC VUDs transactions in your projects.

User interface elements are described below:

UI Elements
(A - Z)

Description

Action TheVUDsaction performed. For details about the possible actions, see "VUDs Actions" on the next
page.

In Use by Run
ID

The ID of the test run that is currently running the VUDs.

Owner Run ID The ID of the test run that originally issued the VUDs.
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UI Elements
(A - Z)

Description

Post Date The date that the transaction occurred.

Responsible
user name

The user, or automated system process responsible for the transaction.

Token Unique
ID

Identifiesall actions that belong to the same transaction.

Note: In one regular run that usesVUDs, there are three actions: Issued, Pending, and Expired.
Each of these actionshasa different transaction ID, but the same Token ID.

Updated in
use VUDs

The current number of VUDs that are running asa result of the transaction.

Updated
Pending
VUDs

The current number of VUDs that are in the Pending state asa result of the transaction.

Updated
project limit

The project'sVUDs limit asa result of the transaction.

VUDs
number

The amount of VUDs involved in the action.

VUDs
Transaction
ID

The action ID.

VUDs Actions
The following table lists the possible VUDs actions.

UI
Elements
(A - Z)

Description

Allocated VUDsadded to the project'sVUDs limit by the administrator.

Deallocated VUDs removed from the project'sVUDs limit by the administrator.

Expired VUD's removed from the license after their 24 hour active period hasended.

Note: VUDs that are involved in a performance test that exceeds24 hours continue to run until
completion before expiring.

Issued VUDsadded to a performance test.

Note:
l AllVUDs involved in a performance test are considered to be issued from the start of the test,

irrespective of whether theyhave started running or not.

l The amount of issued VUDsdecreases the project'sVUDs limit accordingly.

l All unused VUDsare returned to the project'sVUDs limit at the conclusion of the test.
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UI
Elements
(A - Z)

Description

Pending VUDswhich have completed a test run but are still available for further use as their 24 hour active period has
not yet ended.

Refunded VUDswhich were issued but not used in the test. These VUDsare returned to the project'sVUDs limit and
maybe reissued at a later date.

Reused Running VUDs that that are taken fromVUDs in the Pending state.

Note: ALMPerformanceCenter first reusesVUDs in the Pending state before issuing new VUDs.
For example, assume you define a performance test that includes100 VUDs, where the current
project limit is200, andwhere25 VUDsare currently in the Pending state. ALMPerformanceCenter
first reuses the25 Pending VUDsand only issues75 from the license. The new limit will be125.

Timeslot Settings Page
This page enables you to configure timeslot settings.

User interface elements are described below:

UI
Elements

Description

Send
Alerts To

The userswho should receive a timeslot alert:

l Timeslot creator.The user who reserved the timeslot.
l Timeslot modifier.The user who last modified the timeslot.
l Project administrators.Administratorsof the project in which the timeslot was reserved.
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UI
Elements

Description

Rules for
Alerts

The conditionsunder which timeslot alerts are sent (both conditionsmust hold):

l Send alerts for timeslots scheduled to start in the next <XX> hours.Sendsan alert when a
timeslot isXXhourswithin its due time to start.

Default value: 72 hours
Minimum value: 12 hours

l Send alert if timeslot is in failure state for at least <XX> minutes.Sendsan alert when the
timeslot hasbeen invalid for XXminutes.

Default value: 30minutes
Maximum value: 360minutes (6 hours)

Autostart
Retries

If a performance test linked to a timeslot is scheduled to autostart but doesnot start running, the system
continues to try to autostart the test until it starts running successfully.

TheAutostart Retries option enables you to specifywhen the system shouldstop trying to autostart the
test. In anyevent, retriesare stopped if there are 30minutesor less left of the timeslot.

Default value: 50%, that is the system stops retrieswhen half the timeslot haselapsed.

Maximum value: 99%;Minimum value: 1%

Note: The system tries to restart a performance test up to three times.

History Page
This page lists changes made to the project. For more details, see theHP Application Lifecycle
Management User Guide.

Performance Center Controller Options Dialog Box
This dialog box enables you to configure global Controller options for your Performance Center project.
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To access
On the ALMmasthead, click and select Performance Center Controller Options.

Note: Thispage isaccessible only from the ALMproject itself, and not from LabManagement.

Important
information

TheController is themanager of a performance test. TheController receives the scripts, their runtime
settings, and a list of the load generators to use. TheController issues instructions to the load generators
including which scripts to run, howmanyVusers to run per script, and the time at which to start running the
Vusers.

During the performance test, the Controller displaysonlinemonitoring information. At the conclusion of the
test run, the Controller collates the data for analysis.

Before you run a performance test, you can configure load generator and Vuser options for all your
performance tests in the project. Although the default settingscorrespond tomost environments, you can
modify the settings to customize the test behavior.

The settingsapply to all future test runs in the project and generally onlyneed to be set once. The settings
applyglobally to all the load generators in a performance test.

Relevant
tasks

"How to Create a Project" on page 22

See also "Project Settings Overview" on page 22

Run Options > Monitors
Enables you to activate the Transactionmonitor, configure the behavior of the transaction data, and set
the data sampling rate, debugging, and frequency settings for the onlinemonitors.

User interface elements are described below:

UI
Elements

Description

Transaction
Data

Configures the behavior of data for the Transaction, Data Point, andWebResource online graphs.

l Enable Transaction Monitor.Select this option to activate the online Vuser Transactionmonitor to
beginmonitoring transactionsat the start of a test run.

Sample information at frequency <>. Select the frequency, in seconds, at which the online
monitor samples the data to produce the Transaction, Data Point, andWebResource online graphs.

The higher the frequency, the lessnetwork traffic there is. The data is averaged for the frequencyperiod
defined, and onlyone value is sent to the Controller.

Default value: 5 seconds.

Examples:
l For a small test, use a frequencyof 1.

l For a large test, use a frequencyof 3 - 5.

Note: You cannotmodify these settingsduring a test run; youmust stop the test run before
deactivating themonitor or changing its frequency.

Send
information
in mode

Specifieshow to send data back to theController.

l Summary.Sendsa summaryof the transaction data back to theController.
l Raw Data.Sendsall the transaction data back to theController in raw form. Sending raw data saves

time because the data doesnot need to be processed.
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UI
Elements

Description

Note:WhenRawData is selected, the volume of data being transferred to theController maycause
more network traffic. If the transfer speed is significant to you, selectSummary.

Server
Resource
Monitors

Configures the behavior of the Server Resourcemonitors.

l Data Sampling Rate. The period of time (in seconds) between consecutive data sampling. By
default, the onlinemonitor samples the data at intervals of three seconds. If you increase the sampling
rate, the data ismonitored less frequently. This setting applies to all graphs.

Note:
l The sampling rate configured here is applied to all server monitors that you subsequently activate.

It is not applied to server monitors that have alreadybeen activated. To apply the new sampling
rate to activated server monitors, save your performance test and reopen it.

l Each type ofmonitor hasa different minimum sampling rate. If the default sampling rate, or the rate
set here is less than amonitor'sminimum sampling rate, themonitor samplesdata at itsminimum
sampling rate. For example, theminimum sampling rate for theOracleMonitor is 10 seconds. If the
data sampling rate is set here at less than 10 seconds, theOracleMonitor continues tomonitor data
at 10 second intervals.

Debug l Display Debug Messages.The onlinemonitor providesdebugging capabilities. Select this option to
display the debugmessages in theOutput window.

l Debug level.For the Networkmonitor, you can indicate the debug (detail) level of messagessent to
the log, ranging from 1-9.

Run Options > Run-Time Settings
Enables you to specify runtime settings for your test relating to Vuser quotas, stopping Vusers, and
random sequence seed, to prevent system overload, and to control the way in which Vusers stop
running.

User interface elements are described below:

UI Elements Description

Vusers Quota Vuser quotasprevent your system from overloading. The Vuser quotasapply to Vuserson all load
generators.

Number of Vusers that may be initialized simultaneously on all load generators.
Limits the number of Vusers initialized at one time (when you send an Initialize command).

Default value: 999

When Stopping
Vusers

Controls the wayVusers stop runningwhen youmanually stop a test run:

l Wait for the current iteration to end before stopping. (Default option) The Vuser
completes the iteration it is running before stopping. The Vusersmove to theGradual Exiting
statusand exit the test run gradually.

l Wait for the current action to end before stopping. TheVuser completes the action it is
running before stopping. The Vusersmove to theGradual Exiting statusand exit the test run
gradually.

l Stop immediately. TheVusers stop running immediately, moving to theExiting statusand exit
the test run immediately.
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UI Elements Description

Random
advance mode
of file type
parameter

l Use random sequence with seed.Enablesyou to set a seed number for random
sequencing. Select this option if you discover a problem during the test run andwant to repeat the
test using the same sequence of random values.

l Use seed <#>.Each seed value representsone sequence of random valuesused for test
execution.Whenever you use this seed value, the same sequence of values is assigned to the
Vusers in the test.

This setting applies to parameterized Vuser scripts using theRandommethod for assigning values from
a data file. It also affects the randompercentage of recorded think time (see information about the Run-
TimeSettingsdialog box in theHP Virtual User Generator User Guide).

Run Options >Timeout
Enables you to set timeouts for various Performance Center commands. When a command is issued
by the Controller, you can set amaximum time for the load generator or Vuser to execute the
command. If the command is not completed within the time limit, the Controller issues an error
message.

User interface elements are described below:

UI
Elements

Description

Command
Timeout
(seconds)

Enable timeout checks.Enables load generator and Vuser timeout checksdescribed below.

Note: If this option is not selected, ALMwaits an unlimited time for the load generators to connect and
disconnect, and for the Initialize, Start Vusers, Duration, and Stop Vusersactions to be executed.

Load
Generator

Load generator timeout limits:

l Connect operation (sec).The amount of time (in seconds) that elapsesbefore connecting to any
load generator. If a connection is not successfulwithin this time, the statusof the load generator changes
toFailed.
Default connection timeout: 30 seconds

l Disconnect operation (sec). The amount of time that elapsesbefore disconnecting from any load
generator. If the load generator doesnot disconnect within this time, the statusof the load generator
changes toFailed.
Default disconnection timeout: 120 seconds

Vusers Vuser timeout limits:

l Init stage (sec). The timeout value for the Initialize action.
Default time limit: 180 seconds

l Run stage (sec).The timeout value for the Start Vusersaction.
Default time limit: 120 seconds

l Pause stage (sec).The timeout value for the Duration action.
Default time limit: 120 seconds

l Stop stage (sec).The timeout value for the Stop Vusersaction.
Default time limit: 120 seconds

Note: Calculationsconsider the number of active Vusersand their influence on the timeout values. For
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UI
Elements

Description

example, 1000 Vusers trying to initialize takemuch longer than 10 Vusers. An internal value isadded to
the specified timeout value based on the number of active Vusers.

Run Options > Debug Information
Enables you to select the type of information to trace during a test run. According to the selection here,
trace files are created and are used to gather information for debugging purposes.

User interface elements are described below:

UI
Elements

Description

Enable
the
following
traces

The trace flags related to performance testing problems that you are encountering:

l General.Performsa general trace during the test run.
l File Transfer.Tracesproblemswith the transfer of filesduring the test run.
l Incoming communication.Traces incoming communication during the test run.
l Outgoing communication.Tracesoutgoing communication during the test run.

Note: ThePerformanceCenter agent and theController create some temporary files that collect
information such as the parameter file sent to the Vuser, the output compilation file, and the configuration
file. The PerformanceCenter agent filesare saved inbrr folders in theTMP or TEMP directoryof the
agentmachine. TheController filesare saved in lrr folders in theTMP or TEMP directoryof the
Controller machine. At the end of the test run, all of these filesare automatically deleted.

Run Options > General
Enables you to select amode for allocatingmultiple IP addresses when IP spoofing is enabled. It also
enabled you to display advance warning in the Performance Test DesignerWindow.

User interface elements are described below:

UI Elements Description

Multiple IP
Address Mode

TheController can allocate an IP addressone of the followingways:

l IP address allocation per process.Allocates IP addressesper process.
l IP address allocation per thread.Allocates IP addressesper thread, resulting in amore

varied range of IP addresses in a test run.

Examples:
l WebVusers require IP addressallocation per process.

l WinSockVuser IP addressescan be allocated per thread or per process.

Advanced
Warnings

Displaysadvancedwarnings in theMessagespane of the Performance Test Designer window.
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Run Results > Collate Settings
Enables you to specify behavior related to collation of the run results.

User interface elements are described below:

UI
Elements

Description

Output
Message
Database

l Add output.mdb to RawResults.zip if it is smaller than RawResults.zip size (MB).
Collator processaddsoutput.mdb to RawResults.ziponly if it is smaller in size than the
RawResults.zip file size specified.

l Always exclude output.mdb from RawResults.zip.Collator processalwaysexcludes
output.mdb fromRawResults.zip.

Timeout l Collate timeout in minutes.Themaximumamount of time the collate processshould continue
runningwithout progress.

l Diagnostics collate timeout in minutes. Themaximumamount of time the collate processshould
continue runningwithout progresswhen collating resultswith Diagnosticsdata.
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Chapter 4: Maintenance Tasks
This chapter includes:

• Maintenance Tasks Overview 40
• Maintenance Tasks User Interface 41
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Maintenance Tasks Overview
To run server-side tests in ALM, the lab systemmust be up and functioning correctly. Scheduled
automatedmaintenance tasks provide constant monitoring of the system's key components in order to
detect system failures. You use theMaintenance Tasks module to check the status of the system.

The following table describes themaintenance tasks:

UI Elements (A -
 Z)

Description

Check Host Task Verifies the host installation, and updates the host status to eitherOperationalorNon-
Operational.

Default frequency:Every24 hours

Data Processor
Task

Setsand updatesa data processing queue for anyof the following actions: Analyzing a test run,
recalculating the SLA, or adding test runs to a trend report.

Default frequency:Everyminute

Handle Non
Polling Functional
Hosts

Checks the Last Poll Time field of all registered Functional testing hosts. If a testing host hasnot been
active for a long time, this taskchanges the statusof the testing host to Idle orNon-Operational.

OFW Status
Update Task

Updates the real status (OperationalorNon-Operational) of a host that is located over a
firewall.

Default frequency:Every15minutes

Orphan Run Task Identifiesorphan test runsduring and outside of the active timeslot.

Default frequency:Every15minutes

Resource
Recovery Task

Performspredefined validation testsonControllersand load generators that are in theNon-
Operational state. If the host passes the test, its status changes toOperational.

l Controller validation tests.Tests theOTAconnection, ability to run, and available disk
space.

l Load Generator validation tests. Tests the connection to the agent.
The taskparameters should bewithin the following guidelines:

l MIN_APPLICATION_DIR_DISK_SPACE:Between 10 and 1000
l CHECK_LG_TIMEOUT:Between 1 and 15
l MAX_RETRIES:Between 1 and 1000
Default frequency:Every15minutes

Note: For load generatorsover a firewall, this is performed by theOFWStatusUpdate task
(see above).

Result Cleaning
Task

Cleans test run results fromControllersor load generators in the following instances:

l If the results have alreadybeen collated.

l There are old performance testswhose resultswere not collated.

l If the performance test wasdeleted.

TheRESULT_EXPIRY_DAYS taskparameter should be between 1 and 1000.

Default frequency:Every6 hours
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UI Elements (A -
 Z)

Description

Synchronize Lab
and SA times

Finds the time difference between LabManagement and Site Administrator and enters it into the
parameter SA_LAB_TIME_DIFF_MILLIS in theDATACONST table.

Maintenance Tasks User Interface
This section includes:

• Maintenance Tasks ModuleWindow 42
• Maintenance Task Fields 42
• Maintenance Task Menus and Buttons 43
• Maintenance Task Details Dialog Box 44
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Maintenance Tasks Module Window
This module displays information about maintenance tasks performed by the system.

To access On the sidebar, under Lab Settings, selectMaintenance Tasks.

See also "Maintenance Tasks Overview" on page 40

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Maintenance Task
tab UI elements>

l Maintenance Task fields. For field definitions, see "Maintenance Task Fields"
below.

l Maintenance Task menus and buttons.For command and button descriptions, see
"Maintenance Task Menus and Buttons" on the next page.

l ALM main menu and sidebar.For details on theToolsmenu,Helpmenu, and
sidebar, see theHP Application Lifecycle Management User Guide.

<Maintenance tasks
grid>

Displaysa list of maintenance tasks. For details, see "Maintenance Tasks Overview" on
page 40.

Parameters tab Displaysparameter information for the selectedmaintenance task.

Right-click the text box to displaya toolbar for formatting and spell-checking the text.

Description tab Displaysa description of the selectedmaintenance task.

Maintenance Task Fields
The following fields are available in theMaintenance Tasks tab:

Field (A - Z) Description

Description Adescription of themaintenance task.
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Field (A - Z) Description

ID Themaintenance task ID.

Last Execution
Time

The last time themaintenance taskwasexecuted.

Name Themaintenance taskname. For a list of themaintenance task types, see "Maintenance Tasks
Overview" on page 40.

Recurrence
(minutes)

The frequencyof themaintenance task.

Maintenance TaskMenus and Buttons
User interface elements are described below:

UI Elements
(A - Z)

Where Description

Copy URL Maintenance
Tasksand
<right-click
menu>

Copiesa selectedmaintenance taskand pastes itsURL asa link. The task itself is not
copied. Instead, you can paste the address into another location, such asan email or a
document. Clicking the linkopensup ALMand takesyou to the task file or folder. If you are
not already logged in, ALM first prompts for login details.

Export Maintenance
Tasksand
<right-click
menu>

Opens the Export Grid Data dialog box, enabling you to export the tasks in the grid asa text
file, Microsoft Excelworksheet, MicrosoftWord document, or HTML file.

Choose one of the following options:

l All.Exports all tasks in the grid.
l Selected.Exports the selected tasks in the grid.

Find
View Opens the Find dialog box, enabling you to search for tasks in themodule. For details about

search options, see theHP Application Lifecycle Management User Guide.

Go to
Maintenance

Task

Maintenance
Tasks

Opens theGo ToMaintenance Taskdialog box, enabling you to find a specific taskby its ID
number. You can onlygo to tasks that are available in the current filter.

Grid Filters View and
<right-click
menu>

Enables you filter the data according to an entry in the filter box. For details about filtering
options, see theHP Application Lifecycle Management User Guide.

Information
Panel

View and
<right-click
menu>

Shows/hides the Information Panel in the lower area of themodule.

Maintenance
Tasks

Details

Maintenance
Tasksand
<right-click
menu>

Opens theMaintenance TaskDetails dialog box, enabling you to view and edit details of the
task.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and In the grid, opens theReplace dialog box, enabling you to replace a field value in the grid.
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UI Elements
(A - Z)

Where Description

<right-click
menu>

For more details, see theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in
the grid and their order. For more details, see theHP Application Lifecycle
Management User Guide.

For details about the SystemHealth fields, see "Maintenance Task Fields" on
page 42.

Set
Filter/Sort

View Enables you to filter and sort the tasks in the grid. Anycurrently applied filtersor sorting
ordersare displayed below the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Update
Selected

Edit and
<right-click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for amultiple
selection in the grid. For more details, see theHP Application Lifecycle Management
User Guide.

Maintenance Task Details Dialog Box
This dialog box displays details about a selectedmaintenance task.

To access 1. On the sidebar, under Lab Settings, selectMaintenance Tasks.
2. Select amaintenance task from the grid and clickMaintenance Task Details

.

See also l "Maintenance Tasks Module Window" on page 42
l "Maintenance Task Fields" on page 42
l "Maintenance Tasks Overview" on page 40

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of hosts.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".
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UI Elements Description

For example: a*b returnsacb and adefb; a?b returnsacb

Details tab Lists the details of the currently selectedmaintenance task. For more information, see
"Maintenance Task Fields" on page 42.

Description tab Displays the description of the selectedmaintenance task.

Parameters tab Displaysparameters in a grid alongwith their valuesand descriptions. For more information, see
"Maintenance Tasks Overview" on page 40.
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Chapter 5: Cloud Settings
This chapter includes:

• Cloud Hosts Overview 47
• How to Set Up Cloud Hosts 48
• Initial Cloud Settings 49
• Cloud Accounts 59
• Host Templates 71
• Provisioning Hosts 81
• Cloud Resources Monitoring 89
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Cloud Hosts Overview
Testing your software application can be a very resource intensive process. Performance testing in
particular can require an extensive lab environment, usingmultiple load generating hosts and a
controller, and requiring collating capabilities for processing test results. Theremay be times where you
needmore hosts than are available in your testing lab, or youmay have decided that you do not want to
maintain your own lab environment at all. In either of these cases, youmay have turned to a cloud
provider such as Amazon EC2, Microsoft Azure, or HP Helion Public Cloud who can provide you with
on-demand testing hosts to meet your testing needs. ALM integrates with your cloud accounts in order
to help you get themost out of your cloud resources.

Note:

l HP ALM supports provisioning of Performance Center load generators only.
l HP ALM only integrates with HP Helion Public Cloud, Microsoft Azure, and Amazon EC2 cloud
accounts.

l HP ALM does not integrate with any other HP Helion cloud services (private, managed, and so
on).

l Cloud-based load generators are best suited for testing externally available AUT.

Benefits of Using Cloud Hosts
By using cloud hosts in ALM, you can:

l Provision testing hosts only when you need them.
l Manage cloud provisioning on a per-project basis, with each project having access only to the cloud
resources it needs.

l Allow QA testers to provision pre-approved testing hosts without the need for direct access to your
cloud accounts.

l Regulate cloud host usage by assigning credits to projects.
l View cloud host usage reports to manage cloud resource consumption.

Using Cloud Hosts in ALM
Using cloud hosts in ALM involves:
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Phase Description
For more
information:

Defining
Initial Cloud
Settings

Set up an account with a cloud provider and obtain the cloud provider credentials.
Afterwards, you set up communication fromALM to your cloud provider, and define
network settings for communicating with your cloud-based load generators.

"Initial Cloud
Settings
Overview" on
page 50

Adding Cloud
Accounts

After establishing an account with a cloud provider, youmust also establish a cloud
account in ALM.When defining a cloud account in ALM, you enter your cloud provider
credentials, associate projects to the account, and define the total number of cloud
credits allowed for consumption byyour provisioned hosts.

"Cloud
Accounts
Overview" on
page 60

Defining
Host
Templates

Host templatesare used for defining provisioning related details, such as instance
types, regions, hardware specifications, and software images. You can use default host
templatesor create your own templates. ALMuses the details of the selected template
to provision your host.

Note: You cannot use default templates for Microsoft Azure accounts. youmust
create your own templates.

"Host
Templates
Overview" on
page 72

Provisioning
Cloud Hosts

Provisioning is the processof requesting the cloud provider to create amachine on the
cloud. It uses the selected cloud account and host template to define themachine. You
can choose the number of machinesand their locations. You can also checkcredits
balance for the selected account.

"Provisioning
Hosts
Overview" on
page 82

Monitoring
Resource
Consumption

After provisioning your cloud hosts, you can analyze andmonitor your cloud resource
consumption bygenerating usage reports, and bysending alerts and notifications.

"Cloud
Resources
Monitoring
Overview" on
page 90

For details about how to set cloud hosts in ALM, see "How to Set Up Cloud Hosts" below.

How to Set Up Cloud Hosts
This task describes how to set up cloud hosts in ALM.

1. Perform initial steps for communicating with the cloud. For task details, see "How to Initially Set
Up Communication with the Cloud" on page 53.

2. Add cloud accounts to ALM. For task details, see "How toManage Cloud Accounts" on page 60.
3. Use default or create additional host templates. In Microsoft Azure, youmust create host

templates. For task details, see "How toManage Host Templates" on page 72.
4. Provision cloud hosts. For task details, see "How to Provision and Terminate Cloud Hosts" on

page 82.
5. Monitor cloud resources consumption by setting up cloud alerts and by generating usage reports.

For task details, see "How to Configure Cloud Alerts" on page 90 and "How to Generate Usage
Reports" on page 147.
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Initial Cloud Settings
This section includes:

• Initial Cloud Settings Overview 50
• How to Initially Set Up Communication with the Cloud 53
• How to Set Up Cloud Network Settings 55
• How to Create Digital Certificates 56
• Initial Cloud Settings User Interface 57
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Initial Cloud Settings Overview
To initially set up communication with a cloud provider, youmust establish an account with the cloud
provider and obtain the cloud provider credentials. Youmust then set up communication from ALM to
your cloud provider, and define network settings for communicating with your cloud-based load
generators.

Creation of Cloud Provider Account
Youmust first create a cloud provider account for using the cloud provider services.You need to provide
credentials for storing and accessing resources on the cloud, such as:

l HP Helion - Access Key, Secret Key, Project ID, and Project Name
l Amazon EC2 - Access Key, Secret Key, and Account Number
l Microsoft Azure - Subscription ID and Certificate File

Note: HP ALM only integrates with HP Helion, Microsoft Azure, and Amazon EC2 cloud
accounts.

For more information about creating cloud provider accounts, see the documentation provided by your
cloud provider.

Communication to Cloud Provider
When communicating with your cloud provider, you can choose to communicate directly or via a proxy.

The following diagram illustrates direct communication to a cloud provider:

The communication is initiated from the ALM server over the organization's firewall to the cloud
provider. The ports are opened for outgoing requests only.

The following diagram illustrates communication to a cloud provider through a proxy server:
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The communication is initiated from the ALM server to the defined proxy server using HTTP tunneling.
The proxy server then runs over the organization's firewall and transfers outgoing requests to the cloud
provider.

Communication to Cloud-based Load Generator
When communicating with your cloud-based hosts, you can choose to communicate directly or via a
proxy.

Note:

l When the communication is through a proxy, SSL (Secure Socket Layer) is required
l HP ALM supports provisioning of Performance Center load generators only.

The following diagram illustrates direct communication to a cloud-based load generator:

The communication is initiated from the Performance Center server and the Controller over a firewall to
the cloud-based load generator. Data is transmitted through TCP (Transmission Control Protocol) using
ports. The ports are opened for outgoing requests. The ports can be reconfigured.

The following diagram illustrates communication to a cloud-based load generator through a proxy
server:
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The communication is initiated from the Performance Center server and the Controller to the defined
proxy server. An HTTP Tunnel is used as ameans for communicating from the Performance Center
server and the Controller to the proxy server. The proxy server then runs over the firewall and transfers
the data to the cloud-based load generator, going through the TCP ports.

Note: SSL is supported between the controller and the cloud-based load generator.

Configuration of Security Settings
Additional security features related to your cloud provider.

Feature Description

Security
Groups

While access to hostson your local network is typically controlled bya firewall, access to your cloud hosts is
controlled using security groups. A security group specifieswhich protocolsare allowed andwhich ports are
open for incoming and outgoing traffic to a cloud host. For incoming traffic, you can restrict access to one or
more IP addresses.

Example: You need to connect to your cloud hosts via Remote Desktop. Therefore, you configure
your security group to allow incoming traffic over TCPport 3389 (RDP). However, you onlyallow
access for your company's IP addresses to prevent unauthorized access from the outside.

Security groupsare configured on thewebsite of your cloud provider, andmust be created separately for
each region. You can create asmanysecurity groupsasyou need, up to the limit imposed byyour cloud
provider. You select a security group at the time you provision cloud hosts, and that security group applies
until the hostsare terminated.

Note: Not applicable for Microsoft Azure cloud accounts.

Key Pairs Keypairs are necessary if you intend to connect remotely to a cloud host created from a public image.

A keypair consists of a public keyand a private key. The public key is saved to the cloud host and the private
key is saved locally on your computer or network.

Caution:When creating a new keypair, you are prompted to save the private key. Make sure to save
it in a secure location.Without the private key, you cannot log into your hosts!
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Feature Description

The private key isused differently for Windowsand Linuxhosts:

Window hosts.When connecting remotely to aWindowshost, you need the administrator password. The
administrator password isgenerated on thewebsite of your cloud provider byuploading the private key.

Linux hosts.The private key itself is usedwhen connecting to a Linuxhost.
Keypairs are created on thewebsite of your cloud provider, andmust be created separately for each region.
You can create asmanykeypairs asyou need for your different testing teams, up to the limit imposed byyour
cloud provider. You select a keypair at the time you provision cloud hosts, and that keypair appliesuntil the
hostsare terminated.

Note: If you provision hosts from a custom image, the administrator password (Windowsmachines) or
public key (Linuxmachines) is taken from the computer where the imagewascreated. If you need the
administrator password or private key, contact the personwhomanagesyour custom images.

Note: Not applicable for Microsoft Azure cloud accounts.

Elastic IP
Addresses

This cloud provider feature enables you to define static IP addresses for your provisioned hosts. You can use
elastic IP addresses for opening firewall settings to provision host machineswithout having the need to use
different IP addresseseach time. To do so, you can build and use a static pool of IP addresses for granting
firewall access that are reserved only for your account. Thispool of IP addresses remainsassociated with
your cloud account until you choose to explicitly release it.

Note: HPHelion only supports elastic IP addresses. You cannot provision hostsusing fixed IP
addresses. For additional information, see theHPHelion PublicCloudWeb site
(http://www.hpcloud.com/).

Note: Not applicable for Microsoft Azure cloud accounts.

Certificate
Files

Certificatesare a keycomponent ofWindowsAzure security.

There are two different kindsof certificates that playa role in securing your applicationsor services, service
certificatesandmanagement certificates.

Youmust provideWindowsAzure service certificates in the Personal Information Exchange (.pfx) format for
use in ALM.

Youmust provideWindowsAzuremanagement certificates in X.509 (.cer) format and upload them to Azure.

Note: Onlyapplicable for Microsoft Azure cloud accounts.

Formore information on security groups, key pairs, elastic IP addresses, and certificate files, see the
documentation provided by your cloud provider.

For task details on how to initially set up communication, see "How to Initially Set Up Communication
with the Cloud" below.

How to Initially Set Up Communication with the Cloud
This task describes the initial steps required for setting up communication with the cloud.

For an overview, see "Initial Cloud Settings Overview" on page 50.

Note: This task is part of a higher-level task. For details, see "How to Set Up Cloud Hosts" on
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page 48.

1. Create an account with a cloud provider
a. Sign up and create an account for using cloud provider services .
b. Obtain the following cloud credentials:

i. HP Helion - Access Key, Secret Key, Project ID, and Project Name
ii. Amazon EC2 - Access Key, Secret Key, and Account Number
iii. Microsoft Azure - Subscription ID and Certificate File

Note: HP ALM only integrates with HP Helion, Microsoft Azure, and Amazon EC2 cloud
accounts.

2. Define cloud communication from the ALM server to your cloud provider
If your organization uses a proxy server for communicating with an outside network, define the
proxy settings in the Cloud Network Settings dialog box. For task details, see "How to Set Up
Cloud Network Settings" on the next page.

Note:Whenworking with HP Helion, note that HP Helion Public Cloud Identity Service uses
port 35357 which is required for authentication with HPCS. This port should be opened for
outgoing requests only. Make sure your proxy can forward outgoing http requests to this port.

3. Define communication for a cloud-based load generator
For task details, see "How to Set Up Cloud Network Settings" on the next page.

4. Define security settings on the cloud provider side for HP Helion and
Amazon EC2 cloud accounts
a. From your cloud provider console, create a security group. The ports defined for

communicating with the cloud-based load generator must be opened. For more information on
the security group rules, see theHP ALM LabManagement Troubleshooting Guide.
For more information about security groups, see the documentation provided by your cloud
provider.

b. Create a key pair.
c. If you plan on working with elastic IP addresses, allocate elastic IP addresses andmake sure

they are opened on your organization's firewall for outgoing communication.

5. Define security settings on the cloud provider side for Microsoft Azure
cloud accounts
a. Youmust increase your JDK’s strength toUnlimited. Download the appropriate version of

the Java Cryptography Extension from java.sun.com. Replace the local_policy.jar, and US_
export_policy.jar files in the JRE. The jar files are located by default in C:\Program
Files\HP\ALM\java\jre\lib\security.

b. CreateWindows Azure service certificates in Personal Information Exchange (.pfx) format for
use in ALM.
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c. CreateWindows Azuremanagement certificates in X.509 (.cer) format and upload them to
Azure.

How to Set Up Cloud Network Settings
This section describes how to set cloud network settings for communicating from ALM to you cloud
provider and for communicating with your cloud-based load generators.

For an overview, see "Initial Cloud Settings Overview" on page 50.

Note: This task is part of a higher-level task. For details, see "How to Initially Set Up
Communication with the Cloud" on page 53.

1. Prerequisites for using SSL (Secure Socket Layer)
To enable SSL for your cloud-based load generator, youmust create a Certification Authority (CA)
and a Digital Certificate and store the files on ALM, the Performance Center server, and the
Controller. For more details on creating the certificates, see "How to Create Digital Certificates"
on the next page.

2. Open the Cloud Network Settings dialog box

In LabManagement, on themasthead, click and select Cloud Network Settings. For user
interface details, see "Cloud Network Settings Dialog Box" on page 58.

Note: The Cloud Network Settings option is not available if a Performance Center server has
not been created. For more details on creating Performance Center servers, see "How to
Manage Performance Center Servers" on page 236.

3. Enable communication from ALM to your cloud provider
a. UnderProxy Settings, enter theProxy ServerURL (format: http[s]://server[:8080]).
b. Enter theUser Name andPassword of a user with connection rights to the proxy server.

Note:Whenworking with HP Helion, note that HP Helion Public Cloud Identity Service uses
port 35357 which is required for authentication with HPCS. This port should be opened for
outgoing requests only. Make sure your proxy can forward outgoing http requests to this port.

4. To enable communication for a cloud-based load generator
a. UnderPerformance Center Communication Settings, define the communicationmode. By

default, Use Proxy Server for Load Generator Communication andUse SSL for Load
Generator Communication are selected. Note that if the communication is through a proxy,
SSL is required.

b. Enter thePerformance Center Agent Service Port number. This port is used for running
Vusers on the load generator. Make sure this port is opened for outgoing requests.

c. Enter theRemote Management Agent Service Port number. This port is used for Lab
Management operations. Make sure this port is opened for outgoing requests.
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How to Create Digital Certificates
This task describes how to create a Certification Authority and a Digital Certificate for working with
SSL (Secure Socket Layer) to secure communication to your cloud-based load generators.

For an overview, see "Initial Cloud Settings Overview" on page 50.

Note: This task is part of a higher-level task. For details, see "How to Set Up Cloud Network
Settings" on the previous page.

1. Create a Certification Authority (CA)

Note: This step describes how to create a CA using the gen_ca_cert.exe utility. If you are
working on a Linux platform, use the gen_ca_cert utility instead.

To create the CA, perform the following steps:
a. Run the gen_ca_cert utility from the <LoadRunner root folder>\bin

folder.
b. Run the gen_ca_cert commandwith at least one of the following options:

o -country_name
o -organization name
o -common_name
This process creates two files in the folder from which the utility was run: the CA Certificate
(cacert.cer), and the CA Private Key (capvk.cer).

Note: By default, the CA is valid for three years from when it is generated. To change
the validation dates, use the -nb_time (beginning of validity) and/or -na_time (end of
validity) options.

The following example creates two files: ca_igloo_cert.cer and ca_igloo_pk.cer in the
current folder:
gen_ca_cert - country_name "North Pole" -organization_name "Igloo Makers" -
common_name "ICL" -CA_cert_file_name "ca_igloo_cert.cer" - CA_pk_file_name
"ca_igloo_pk.cer" -nb_time 10/10/2013 -na_time 11/11/2013

c. Install the CA using one of the following options:
o -install <name of certificate file>. Replaces any previous CA list and creates a new one

that includes this CA only.
o -install_add <name of certificate file>. Adds the new CA to the existing CA list.

Note: The -install and -install_add options install the certificate file only. Keep the
private key file in a safe place and use it only for issuing certificates.

2. Create a Digital Certificate
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Note: This step describes how to create a digital certificate using the gen_cert.exe utility. If
you are working on a Linux platform, use the gen_cert utility instead.

To create a digital certificate, perform the following steps:
a. Run the gen_cert utility from the <LoadRunner root folder>\bin folder.
b. Run the gen_cert commandwith at least one of the following options:

o -country_name
o -organization_name
o -organization_unit_name
o -eMail
o -common_name
It is important to note the following:

o The CA Certificate and the CA Private Key files are necessary for the creation of the
certificate. By default, it is assumed that they are in the current folder, and are named
cacert.cer and capvk.cer respectively. In any other case, use the -CA_cert_file_name
and -CA_pk_file_name options to give the correct locations.

o The certificate file is created in the folder from which the utility was run. By default, the file
name is cert.cer.

3. Copy the certificates to ALM, Performance Center, and the Controller
a. ALM: Copy cert.cer and cacert.cer to <ALM deployment

directory>\repository\sa\DomsInfo\Certificates.

b. Performance Center server:Copy cert.cer to <Performance Center Server
directory>\dat\cert, and cacert.cer to <Performance Center Server
directory>\dat\cert\Verify.

c. Controller: Copy cert.cer to <Performance Center Host directory>\dat\cert, and
cacert.cer to <Performance Center Host directory>\dat\cert\Verify.

Initial Cloud Settings User Interface
This section includes:

• Cloud Network Settings Dialog Box 58
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Cloud Network Settings Dialog Box
This dialog box enables you to define settings for enabling communication with ALM and your cloud-
based load generators in order to run performance tests.

To Access Lab Management only:

In LabManagement, on themasthead, click and selectCloud Network Settings.

Relevant tasks l "How to Initially Set Up Communication with the Cloud" on page 53
l "How to Set Up Cloud Network Settings" on page 55
l "How to Create Digital Certificates" on page 56
l "How to Set Up Cloud Hosts" on page 48

See also l "Initial Cloud Settings Overview" on page 50
l "Cloud Accounts Overview" on page 60

Proxy Settings
User interface elements are described below:

UI Elements Description

Proxy Server TheURL of your proxyserver (format: http[s]://server[:8080]).

User Name The user name of a user with connection rights to the proxyserver (format:Domain\username).

Password The password of the user with connection rights to the proxyserver.

Performance Center Communication Settings
User interface elements are described below:

UI Elements Description

User Proxy Server
for Load Generator
Communication

Enablesyou to communicate with your load generator using the proxydetails defined in the Proxy
Settingssection above.

Note: Enabling this option also enables theUse SSL for Load Generator
Communicationoption.

Use SSL for Load
Generator
Communication

Enablesyou to communicate with your load generator using SSL.

Note:
l This is the default selection.

l To use SSL, youmust create digital certificates. The certificatesmust be stored on ALM,
the PerformanceCenter server, and theController. For more details on creating digital
certificates, see "How to Create Digital Certificates" on page 56.

Performance Center
Agent Service Port

ThePerformanceCenter Agent Service port number. Thisport is used for running Vuserson the
load generator.
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UI Elements Description

Note: Port must be opened for outgoing requests.

Default value: 54345

Remote
Management Agent
Service Port

TheRemoteManagement Agent port number. Thisport is used for LabManagement
operations.

Note: Port must be opened for outgoing requests.

Default value: 54245

Cloud Accounts
This section includes:

• Cloud Accounts Overview 60
• How toManage Cloud Accounts 60
• Cloud Accounts User Interface 63
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Cloud Accounts Overview
After establishing a cloud provider account, youmust also establish a cloud account in ALM. When
defining a cloud account in ALM, you enter your cloud provider credentials, associate projects to the
account, and define the total number of cloud credits allowed for consumption by your provisioned
hosts.

Cloud accounts can be added from LabManagement or from ALM projects. Accounts added from Lab
Management are public and can be accessed by any project they are linked to. Accounts added from
ALM projects are private and can be accessed only from the projects where they were created.

Note: Youmust have an existing HP Helion, Microsoft Azure, or Amazon EC2 account in order to
add an account in ALM.

Cloud Credits
When setting up cloud accounts in ALM, to ensure efficiency and reduce cost, you can regulate cloud
provisioning usage by assigning virtual cloud credits to your projects. For each project, you can define
the total number of cloud credits allowed for consumption by your provisioned hosts. Note that credits
used and consumed are not representative of the actual cost to your cloud provider.

You can set up to receive email alerts notifying you when your credits drop below a defined amount. For
more details, see "How to Configure Cloud Alerts" on page 90. You can alsomonitor your cloud credits
consumption by generating usage reports, For more details, see "How to Generate Usage Reports" on
page 147.

Note:

l After a host is provisioned, it consumes credits from the project that provisioned it.
l Credits are consumed for each host on an hourly basis, and the number of credits consumed per
hour is specified in the host template.

l Hosts can only be provisioned if sufficient credits are available. When the total amount of
credits drops to zero, you will not be able to provision new hosts. Already provisioned host will
continue to consume credits.

For details on creating andmanaging cloud accounts in ALM, see "How toManage Cloud Accounts"
below.

How to Manage Cloud Accounts
This section describes how tomanage your cloud accounts in ALM.

For an overview, see "Cloud Accounts Overview" above.

Note: This task is part of a higher-level task. For details, see "How to Set Up Cloud Hosts" on
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page 48.

Adding a Cloud Account
This task describes how to add a cloud account to ALM and how to link projects to that account.

1. Prerequisites
To add a cloud account to ALM, youmust have an existing cloud account with a supported cloud
provider.
After you have your cloud account ready, you need to record the following information from your
cloud provider's website:
l Account Access Key (for HP Helion and Amazon EC2 accounts only)
l Account Secret Key (for HP Helion and Amazon EC2 accounts only)
l Project ID (for HP Helion accounts only)
l Cloud Project Name (for HP Helion accounts only)
l Account Number (for Amazon EC2 accounts only)
l Subscription ID (for Microsoft Azure accounts only)
l Certificate File (for Microsoft Azure accounts only)

2. Add a cloud account to ALM
To add a cloud account to ALM:
a. In ALM or LabManagement, go toCloud Settings > Cloud Accounts.

b. Click theNew Cloud Account button . This opens the "New Cloud Account Dialog Box"
on page 67.

c. Enter your cloud account information. Click OK to add the cloud account to ALM.
d. If theProvider is Microsoft Azure, theMS Azure API Access Certificate dialog box opens.

i. Select theMicrosoft Azure service certificate in the Personal Information Exchange
(.pfx) format.

ii. Enter the password for the service certificate.
iii. Click OK.

Note: The account creation process may take several minutes to complete.

Note: Cloud accounts added from user projects are private and can be used only by the
projects that created them. However, if a project shares a pool with other projects, the
provisionedmachines will be seen from all projects that are sharing the same pool.

You can now create templates and provision hosts from this cloud account.

3. Link projects to your cloud account
Every project that needs to provision hosts from a cloud account created in LabManagement must
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be linked to that account.
To link projects to a cloud account created in LabManagement:
a. In LabManagement, go toCloud Settings > Cloud Accounts.
b. In the Accounts grid, select the cloud account you would like to link.

c. In the Linked Projects tab, click Assign Projects to Cloud Account . This opens the
"Assign Projects to Cloud Account Dialog Box" on page 69.

d. Select projects from the grid and click Assign. This links the selected projects to the cloud
account.

All linked projects may now provision cloud hosts from the selected cloud account.

Note: Only accounts added in LabManagement can be linked to projects. An account added
from a user projects is automatically linked to the project that added it, and it may not be
linked to any other project.

4. Define the total number of credits for your cloud account
When defining credits in LabManagement, you allocate credits for each project listed in your cloud
account. In ALM, you define credits for a single project.
l Lab Management: In the Linked Projects tab, underCredit Balance, define the number of
credits for each project listed in the account.

l ALM: Go toCloud Settings > Cloud Accounts. In the Accounts grid, select the cloud
account. In theCredits tab, define the number of credits for the account.

Note:

l After a host is provisioned, it consumes credits from the project and the account that
provisioned it.

l Credits are consumed for each host on an hourly basis, and the number of credits
consumed per hour is specified in the host template.

l Hosts can only be provisioned if sufficient credits are available. When the total amount of
credits drops to zero, you will not be able to provision new hosts. Already provisioned host
will continue to consume credits.

l You can set up to receive email alerts notifying you when your credits drop below a defined
amount. For more details, see "How to Configure Cloud Alerts" on page 90. You can also
monitor your cloud credit consumption by generating usage reports, For more details, see
"How to Generate Usage Reports" on page 147.

Modifying Cloud Account Details
Tomodify details for a cloud account:

1. Log into the project that created the cloud account.
2. InCloud Settings > Cloud Accounts, select a cloud account in the grid and click theCloud

Account Details button . This opens the "Cloud Account Details Dialog Box" on page 68.
3. Make any necessary changes and click OK.
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Deleting a Cloud Account
To delete a cloud account:

1. Terminate all cloud hosts provisioned from the cloud account you wish to delete. See "How to
Provision and Terminate Cloud Hosts" on page 82 for more information.

2. Log into the project that created the cloud account you wish to delete.
3. InCloud Settings > Cloud Accounts, select a cloud account in the grid and click theDelete

button . The cloud account and all host templates using the cloud account are deleted.

Caution:When deleting a cloud account, all host templates using that cloud account are deleted
as well.

Note: You cannot delete a cloud account if there are cloud hosts that are currently provisioned by
that account.

Cloud Accounts User Interface
This section includes:

• Cloud Accounts ModuleWindow 64
• Cloud Accounts ModuleMenus and Buttons 64
• Cloud Accounts Module Fields 66
• New Cloud Account Dialog Box 67
• Cloud Account Details Dialog Box 68
• Assign Projects to Cloud Account Dialog Box 69
• Cloud Account Linked Projects Page 70
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Cloud Accounts ModuleWindow
The Cloud Accounts module allows you to add your external cloud accounts to ALM.

To Access Lab Management andALM: On the sidebar, underCloud Settings, clickCloud Accounts.

Important
information

Lab Management: Accounts createdwithin user projectsare read-only. To edit these accounts,
access the owner project.

ALM: Onlyaccounts createdwithin the current project are visible.

Relevant tasks "How to Manage Cloud Accounts" on page 60

See also "Cloud Accounts Overview" on page 60, "Cloud Hosts Overview" on page 47

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Cloud
Accounts
module
common
UI elements>

Cloud Accounts module fields: For field definitions, see "Cloud Accounts Module Fields" on
page 66.

Cloud Accounts menus and buttons: For command and button descriptions, see "Cloud
Accounts Module Menus and Buttons" below.

<Accounts
grid>

Displaysa list of cloud accounts you've added to ALM.

Description
tab

Allowsyou to enter a description for the selected cloud account.

Linked
Projects tab

Displaysa list of projects linked to the selected cloud account and allowsyou to linkor unlinkadditional
projects. In order for a user project to provision hosts from a cloud account created in LabManagement,
youmust link the account to the project. In addition, this tab displays total credits available for the selected
account.For more information, see "Cloud Account Linked Projects Page" on page 70.

Available from: LabManagement

Credits Displays total credits available for the selected account.

Available from:ALM

Event Log TheEvent Log displays the events that occur in a creating the cloud account, reporting the source and
severity of each event. For more information, see "Event Log" on page 121.

History tab Lists changesmade to the selected cloud account. For more details, see theHP Application Lifecycle
Management User Guide.

Cloud Accounts Module Menus and Buttons
This section describes themenus and buttons available in the Cloud Accounts module.

Important
information

Lab Management: Accounts createdwithin user projectsare read-only. To edit these accounts,
access the owner project.

ALM: Onlyaccounts createdwithin the current project are visible.

Relevant tasks "How to Manage Cloud Accounts" on page 60
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See also "Cloud Accounts Overview" on page 60, "Cloud Hosts Overview" on page 47

User interface elements are described below:

UI Element
(A - Z) Menu Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User Guide.

Cloud
Account
Details

Cloud
Accounts
and
<right-
click
menu>

Opens theCloud Account Details dialog boxso that you can view details of a cloud account. See
"Cloud Account Details Dialog Box" on page 68 for more information.

Copy URL Cloud
Accounts
and
<right-
click
menu>

Copiesa link to the selected cloud account. The cloud account itself is not copied. Instead, you
can paste the address into another location, such asan email or a document. Clicking on the link
opensALMand takesyou directly to the cloud account. If you are not already logged in, ALM
first prompts for login details.

Delete Edit and
<right-
click
menu>

Deletes the selected cloud account. A cloud account can onlybe deleted if there are no cloud
hosts that are currently provisioned from that account.

Export Cloud
Accounts
and
<right-
click
menu>

Opens the Export AllGrid Data dialog box, enabling you to export the accounts in the grid asa
text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Select one of the following options:

l All.Exports all resources in the grid.
l Selected.Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for an account. For details about search
options, see theHP Application Lifecycle Management User Guide.

Go to
Cloud
Account

Cloud
Accounts

Opens theGo ToCloud Account dialog box, enabling you to find a specific cloud account by its
ID number.

Grid Filters View and
<right-
click
menu>

Displays the filter boxes for each column in the grid. For details about filtering options, see the
HP Application Lifecycle Management User Guide.

Information
Panel

View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

New Cloud
Account

Cloud
Accounts

Opens theNewCloud Account dialog boxso that you can add a new cloud account. See "New
Cloud Account Dialog Box" on page 67 for more information.
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UI Element
(A - Z) Menu Description

Organize
Favorites

Favorites Organizesyour favorite views. For details, see theHP Application Lifecycle Management
User Guide.

Private Favorites Lists favorite views that are accessible only to the user who created them.

Public Favorites Lists favorite views that are accessible to all users.

Refresh All View Refreshes the view to display themost up-to-date information.

Replace Edit and
<right-
click
menu>

Opens theReplace dialog box, enabling you to replace a field value in the grid. For more details,
see theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in the
grid and their order. For details, see theHP Application Lifecycle Management User
Guide.

Set
Filter/Sort

View Enables you to set filter and sort options for the Cloud Accountsgrid.

Includes the following options:

l Set Filter/Sort.Opens the Filter dialog box, enabling you to filter and sort cloud accounts.
l Clear Filter/Sort.Clearsany filtersor sorting that you have applied. For more details, see

theHP Application Lifecycle Management User Guide.

Update
Selected

Edit and
<right-
click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for multiple cloud
accounts in the grid. For more details, see theHP Application Lifecycle Management
User Guide.

Cloud Accounts Module Fields
This section describes cloud account fields. In LabManagement, all fields in private accounts are read-
only.

Field (A - Z) Description

Access Key AllowsALM to connect to your cloud account. Given to you byyour cloud account provider.

Note: Not applicable for Microsoft Azure cloud accounts.

Account ID The ID of the account. Generated automatically byALMat the time the account is added.

Account TheAmazon EC2 account number. Thisnumber is used to accesscustom images from the cloud account.
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Field (A - Z) Description

Number Note: Adding an incorrect account number will result in the inability to accesscustom images related
to this account.

Available for: Amazon EC2 accountsonly.

Active
Hosts

The number of currently provisioned hosts from thisaccount. Hosts can be viewed in LabManagement
fromLab Resources > Hosts and in ALM fromLab Resources > Testing Hosts.

Cloud
Project ID

TheHPHelion project ID number. Thisnumber is used to accesscustom images from the cloud account.

Note: Adding an incorrect ID number will result in the inability to accesscustom images related to this
account.

Available for: HP Helion accountsonly.

Created By The user who created the account.

Cloud
Project
Name

TheHPHelion project name.

Available for: HP Helion accountsonly.

Created in
Project

The project the cloud account wascreated in.

Description Adescription of the cloud account.

Name The name you choose for the cloud account.

Provider The cloud provider for a specific account.

Note: HPALMonly integrateswith HP Helion, Microsoft Azure, and Amazon EC2 cloud accounts.

Secret Key Servesas the password for theaccess key used to connect to your cloud account. Given to you byyour
cloud provider.

Note: Not applicable for Microsoft Azure cloud accounts.

Subscription
ID

The subscription ID for theMicrosoft Azure cloud account.

Available for: Microsoft Azure accountsonly.

New Cloud Account Dialog Box
This dialog box allows you to add new cloud accounts to ALM.

To Access Lab Management andALM:

1. On the sidebar, underCloud Settings, clickCloud Accounts.

2. Click theNew Cloud Account button or chooseNew Cloud Account from theCloud
Accountsmenu.

Important
information

l Youmust have an existing HPHelion, Microsoft Azure, or Amazon EC2 account to add an account in
ALM.

l The field Cloud Project ID isdisplayed only if Provider is set to HP Helion.
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l Cloud account added from LabManagement are public accountsand can be used byanyproject. Cloud
accountsadded in user projectsare private and can be used only in the project theyare added from.

Relevant
tasks

"How to Manage Cloud Accounts" on page 60

See also "Cloud Accounts Overview" on page 60

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Reset All Fields.Erasesall data entered into fields in the dialog box.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Name The name you choose for the cloud account.

Details Required fieldsare displayed in red. For more information about the available cloud account fields, see
"Cloud Accounts Module Fields" on page 66.

Description Allowsyou to enter a description of the cloud account.

Cloud Account Details Dialog Box
This dialog box displays details about the selected cloud account.

To Access Lab Management andALM:

1. On the sidebar, underCloud Settings, clickCloud Accounts.
2. Right-clickon a cloud account in the grid and selectCloud Account Details.

Important information l Thisdialog box isavailable both in LabManagement and in ALM.

l Lab Management: Cloud accountsadded in user projectsare read-only.
l ALM: Accounts created in LabManagement are read-only.

l The fieldTenant ID appearsonly if the account provider isHP Helion.

Relevant tasks "How to Manage Cloud Accounts" on page 60

See also "Cloud Accounts Overview" on page 60

User interface elements are described below:
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UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of cloud accounts.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Account ID The ID of the account. Generated automatically byALMat the time the account is added.

Name The name you chose for the cloud account.

Details Lists the details of the currently selected cloud account. For more information about the available
cloud account fields, see "Cloud Accounts Module Fields" on page 66.

Credit Define total credits for the selected account.

Available from:ALM

Linked Projects Allowsyou to linkuser projects to the account. In order for a cloud account created in Lab
Management to be accessible from a user project, youmust link the account to the project. For
more information, see "Cloud Account Linked Projects Page" on the next page.

Available from: LabManagement

Event Log TheEvent Log displays the events that occur in a creating the cloud account, reporting the source
and severity of each event. For more information, see "Event Log" on page 121.

History Lists changesmade to the currently selected cloud account. For more details, see theHP
Application Lifecycle Management User Guide.

Assign Projects to Cloud Account Dialog Box
This dialog box allows you to link projects to a cloud account.

To Access Lab Management only:

l From theCloud Accountsmodule: On the LabManagement sidebar, under Cloud Settings, selectCloud
Accounts. In the information panel, selectLinked Projects and click theAssign Projects to
Cloud Account button.

l From theCloud Account Details dialog box: On the LabManagement sidebar, under Cloud Settings,
select Cloud Accounts. Right-clicka cloud account and selectCloud Account Details. In the Cloud
Account Details dialog box, selectLinked Projects and click theAssign Projects to Cloud
Account button.
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Important
information

TheAssign Projects to Cloud Account dialog boxonlyappears in LabManagement.

Relevant
tasks

"How to Manage Cloud Accounts" on page 60

See also "Cloud Accounts Overview" on page 60

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh All.Refreshes the grid so it displays themost up-to-date information.

Assign Assign the selected project to the cloud account.

<Projects grid> Lists the projects that can be assigned to the cloud account.

Selected Displays the projects to be assigned to the cloud account.

Cloud Account Linked Projects Page
The Linked Projects page allows you to link a cloud account to one or more projects. Once an account
is linked to a project, the account can be used to provision hosts from within the project. In addition, this
page displays total credits available for the selected account.

To Access Lab Management only:

l From theCloud Accountsmodule: On the LabManagement sidebar, under Cloud Settings, selectCloud
Accounts. In the information panel, selectLinked Projects.

l From theCloud Account Details dialog box: On the LabManagement sidebar, under Cloud Settings,
selectCloud Accounts. Right-clicka cloud account and selectCloud Account Details. In the
Cloud Account Details dialog box, selectLinked Projects.

Important
information

To provision hosts from a LabManagement cloud account when you are within a user project, youmust link
the cloud account to the project from thispage.

TheCloud Account Linked Projectspage onlyappears in LabManagement.

Relevant
tasks

"How to Manage Cloud Accounts" on page 60

See also "Cloud Accounts Overview" on page 60

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements Description

Assign Projects to Cloud Account.Opens the Assign Projects to Cloud Account dialog box, enabling
you to select projects that can provision from this cloud account. For details, see "Assign Projects to Cloud
Account Dialog Box" on the previous page.

Unassign Project From Cloud Account.Prevents the selected projects from provisioning from this
cloud account.

Go to Project.Displays the selected project in the Project Settingsmodule.
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UI
Elements Description

Refresh All.Refreshes the grid so it displays themost up-to-date information.

Project Displaysprojects linked to the cloud account.

Credit
Balance

Displays the remaining credit balance.

Host Templates
This section includes:

• Host Templates Overview 72
• How toManage Host Templates 72
• Host Templates User Interface 75
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Host Templates Overview
A host template defines technical details related to the host that is going to be provisioned using that
template. The following details are specified in a host template:

l The cloud account that is used to provision the host.
l The cost per hour. It indicates the number of credits the host consumes per hour.

Note: Credits used and consumed are not representative of the actual cost to your cloud
provider.

l The host type and purpose.

Note: HP ALM supports only performance testing load generators.

l The cloud location where hosts are provisioned.
l The hardware specs of the host (Instance Type).
l The software image used for the host (Machine Image).

Note: HP provides a number of predefined images for you to use when creating host templates.
It is recommended that you use the predefined images. Instance types andmachine images are
managed on the website of your cloud provider, and are accessed automatically when creating
host templates. For Microsoft Azure cloud accounts, you cannot use predefined images. You
must create you own images.

All cloud hosts are provisioned from host templates. When you provision a host, ALM copies the details
of the template into the provisioned host.

By default, ALM creates host templates for each HP Helion and Amazon EC2 cloud account. The
templates use the predefined HP images and the recommended hardware settings (defined by instance
type) for the load generator machine. You can use the default host templates or create your own host
templates. For Microsoft Azure cloud accounts, youmust create you own host templates. When using
the template hosts, the administrator can control andmanage whichmachine's specifications are
allowed and recommended for use.

Host templates can bemanaged from LabManagement or from ALM projects. Host templates added
from LabManagement are public and can be used by any project that is linked to the template's cloud
account. Host templates added from user projects are private and can be used only by the projects that
created them.

For instructions for creating a host template, see "How toManage Host Templates" below.

How to Manage Host Templates
This section describes how to create andmanage host templates in ALM.

For an overview, see "Host Templates Overview" above.
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Note: This task is part of a higher-level task. For details, see "How to Set Up Cloud Hosts" on
page 48.

Creating a Host Template
This task describes how to create a host template in ALM.

1. Considerations when creating host templates
When creating host templates, make sure to:
l Create a template for each host configuration that your testers will need. Testers can only
provision cloud hosts from existing templates.

l Clearly describe the type of host that is provisioned by each template so that testers can
provision exactly the hosts they need.

l Ensure that the number of credits consumed by a host accurately reflects the cost of
provisioning that host.

2. Prerequisites
To add a host template to ALM, youmust have added at least one cloud account. See "How to
Manage Cloud Accounts" on page 60 for more information.
When creating host templates, you need to supply the following:
l Location. Specifies the cloud region from which the template provisions hosts. The instance
types andmachine images available for the template depend upon the chosen location.

l Instance Type. Specifies the hardware configuration of hosts created from the template.
Instance types are provided by your cloud provider. Familiarize yourself with each of the
instance types available from your cloud provider before you start creating host templates.

l Machine Image. Specifies the software image to use for hosts created from the template.
Machine images aremanaged on the website of your cloud provider. Make sure to upload all
required images to your cloud provider before you start creating host templates. HP also
provides a set of predefined images for you to use. Microsoft Azure cloud accounts cannot use
predefined images.

3. Create a host template
To create a host template:
a. Log into the project that created the cloud account for which you are creating host templates.
b. Go toCloud Settings > Host Templates.

c. Click theNew Host Template button . This opens the New Host Template Dialog Box.
For more information, see "New Host Template Dialog Box" on page 79.

d. Enter the details of the new host template and click OK. The host template is created. For
information about what to enter in each field, see "Host Templates Module Fields" on page 78.

Your new host template can now be used to provision cloud hosts.

Note:
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l Host templates added from user projects are private and can be used only by the projects
that created them. Host templates added from LabManagement are public and can be
used by any project that is linked to the template's cloud account.

l When creating a host template, you can only select cloud accounts that were added in the
same project.

Creating Images for Microsoft Azure Cloud Accounts
To create images for Microsoft Azure cloud accounts:

1. Create a new instance from the cloud console, using aWindows Server 2008 R2 Enterprise SP1
x64 Image. For details, see http://azure.microsoft.com/en-us/documentation/articles/virtual-
machines-create-custom/.

2. Connect to the instance that you just created. For details, see http://azure.microsoft.com/en-
us/documentation/articles/virtual-machines-log-on-windows-server/.

3. Install a standalone LoadGenerator in Performance Center.
4. Turn off firewalls using the following command:

netsh advfirewall set allprofiles state off

5. Register the LGCloudAgent service using the following command:

sc create LGCloudAgent binPath= "c:\Program Files (x86)\HP\Load
Generator\bin\LGCloudAgent.exe" start= auto

6. Disable autostart for the LoadRunnerAgent service:

l sc config LoadRunnerAgent start= demand

l sc config remotemanagementagent start= demand

7. Run the System Preparation Tool using the Generalize and Shutdown options, as described in
http://azure.microsoft.com/en-us/documentation/articles/virtual-machines-capture-image-
windows-server/. Wait until the instance stops.

l cd %windir%\system32\sysprep

l sysprep (generalize, shutdown)

8. Create an image from the instance. Value the following fields:
a. $new_image_name: The image name.
b. $new_image_label: The image label.
c. $service_name: The name of the service of the instance provisioned in Step 1.
d. $deployment_name: The deployment name.
e. $role_name: The name of the virtual machine.

Modifying Host Template Details
Tomodify details for a host template:
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1. Log into the project that created the host template.
2. InCloud Settings > Host Template, select a host template in the grid and click theHost

Template Details button . This opens the "Host Template Details Dialog Box" on page 80.
3. Make any necessary changes and click OK.

Deleting a Host Template
To delete a host template:

1. Log into the project that created the host template you wish to delete.
2. InCloud Settings > Host Templates, select a host template in the grid and click theDelete

button . The host template is deleted.

Note: Deleting a host template does not terminate cloud hosts provisioned from that template. See
"How to Provision and Terminate Cloud Hosts" on page 82 for more information about terminating
cloud hosts.

Host Templates User Interface
This section includes:

• Host Templates ModuleWindow 76
• Host Templates ModuleMenus and Buttons 76
• Host Templates Module Fields 78
• New Host Template Dialog Box 79
• Host Template Details Dialog Box 80
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Host Templates ModuleWindow
The Host Templates module allows you to create host templates for use in provisioning cloud hosts.

To Access Lab Management andALM: On the sidebar, under Cloud Settings, clickHost Templates.

Important
information

Lab Management: Host templates createdwithin user projectsare read-only. To edit these
accounts, access the owner project.

ALM: Onlyhost templates createdwithin the current project are visible.

Relevant tasks "How to Manage Host Templates" on page 72

See also "Host Templates Overview" on page 72, "Cloud Hosts Overview" on page 47

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Host Templates module
common UI elements>

Host Templates module fields: For field definitions, see "Host Templates
Module Fields" on page 78.

Host Templates menus and buttons: For command and button descriptions, see
"Host Templates Module Menus and Buttons" below.

<Templates grid> Displaysa list of host templates you've added to ALM.

Description tab Allowsyou to enter a description for the selected host template.

History tab Lists changesmade to the selected host template. For more details, see theHP
Application Lifecycle Management User Guide.

Host Templates Module Menus and Buttons
This section describes themenus and buttons available in the Host Templates module.

Important
information

Lab Management: Host templates createdwithin user projectsare read-only. To edit these
accounts, access the owner project.

ALM: Onlyhost templates createdwithin the current project are visible.

Relevant tasks "How to Manage Host Templates" on page 72

See also "Host Templates Overview" on page 72, "Cloud Hosts Overview" on page 47

User interface elements are described below:

UI Element
(A - Z) Menu Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User Guide.

Host
Template
Details

Host
Templates
and

Opens theHost Template Details dialog boxso that you can view details of a host template. See
"Host Template Details Dialog Box" on page 80 for more information.
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UI Element
(A - Z) Menu Description

<right-click
menu>

Copy URL Host
Templates
and
<right-click
menu>

Copiesa link to the selected host template. The host template itself is not copied. Instead, you
can paste the address into another location, such asan email or a document. Clicking on the link
opensALMand takesyou directly to the host template. If you are not already logged in, ALM
first prompts for login details.

Delete Edit and
<right-click
menu>

Deletes the selected host template.

Note: Deleting a host template doesnot terminate cloud hostsprovisioned from that
template.

Export Host
Templates
and
<right-click
menu>

Opens the Export AllGrid Data dialog box, enabling you to export the templates in the grid asa
text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Select one of the following options:

l All.Exports all resources in the grid.
l Selected.Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for a template. For details about search
options, see theHP Application Lifecycle Management User Guide.

Go to Host
Template

Host
Templates

Opens theGo ToHost Template dialog box, enabling you to find a specific host template by its
ID number.

Grid Filters View and
<right-click
menu>

Displays the filter boxes for each column in the grid. For details about filtering options, see the
HP Application Lifecycle Management User Guide.

Information
Panel

View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

New Host
Template

Host
Templates

Opens theNewHost Template dialog boxso that you can add a new host template. See "New
Host Template Dialog Box" on page 79 for more information.

Organize
Favorites

Favorites Organizesyour favorite views. For details, see theHP Application Lifecycle
Management User Guide.

Private Favorites Lists favorite views that are accessible only to the user who created them.

Public Favorites Lists favorite views that are accessible to all users.

Refresh All View Refreshes the view to display themost up-to-date information.
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UI Element
(A - Z) Menu Description

Replace Edit and
<right-click
menu>

Opens theReplace dialog box, enabling you to replace a field value in the grid. For more details,
see theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in the
grid and their order. For details, see theHP Application Lifecycle Management User
Guide.

Set
Filter/Sort

View Enables you to set filter and sort options for the Host Templatesgrid.

Includes the following options:

l Set Filter/Sort.Opens the Filter dialog box, enabling you to filter and sort host templates.
l Clear Filter/Sort.Clearsany filtersor sorting that you have applied. For more details,

see theHP Application Lifecycle Management User Guide.

Update
Selected

Edit and
<right-click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for multiple host
templates in the grid. For more details, see theHP Application Lifecycle Management
User Guide.

Host Templates Module Fields
This section describes host template fields. Host template fields can only be edited in the project from
which the template was created.

Field (A - Z) Description

Cloud
Account

The cloud account for which the template provisionsa host.

Description Adescription of the host template.

Tip: Clearly describe the type of host that is provisioned byeach template so that testers can choose
the appropriate templateswhen provisioning hosts.

Host
Attributes

Allowsyou to specify the system attributesof the host.

Example:Hostmemory: High; Host strength: Medium; Installed components: CitrixClient.

Tip: You can customize the host attributes in LabManagement. For details, refer to theHP
Application Lifecycle Management Administrator Guide.

Host Credit Number of credits per hour consumed byeach host provisioned from this template.

Host
Installation

The installation type of the host.

The following typesare available:

l Unix Load Generator. Indicates that thisUnixhost is used asa LoadGenerator for performance
tests.

l Windows Standalone LG. Indicates that thisWindowshost is used asa standalone LoadGenerator
for performance tests.

Note:
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Field (A - Z) Description

l Make sure you select the correct installation type for the image. Incorrect settingswill cause the
performance tests to run incorrectly.

l Unified Functional TestingandWindows Host optionsappear in the Host Installation list but
are not available for selection

Host
Purpose

The testing toolsavailable on the host. For example: Controller, Load generator, Data processor, QuickTest
Professional, Sprinter, and so on.

Note: HPALM supports onlyLoadGenerator.

Instance
Type

The hardware specsof cloud hostsprovisioned from the template. Instance typescan be viewed on the
website of your cloud provider, and are accessed automaticallywhen creating host templates.

Location In HPHelion, the availability zonewhere the hostsare provisioned. In Amazon EC2 andMicrosoft Azure, the
regionwhere the hostsare provisioned.

Machine
Image

The software image used for cloud hostsprovisioned from the template. Machine imagesaremanaged on
thewebsite of your cloud provider, and are accessed automaticallywhen creating host templates.

Note: If theMachine Image value cannot be displayed, verify that you used the correct cloud account
number.

Template
ID

The ID of the host template. Generated automatically byALMat the time the template is created.

Template
Name

The name you give to the template.

New Host Template Dialog Box
This dialog box allows you to add new host templates to ALM.

To Access Lab Management andALM:

1. On the sidebar, under Cloud Settings, clickHost Templates.

2. Click theNew Host Template button or chooseNew Host Template from the
Host Templatesmenu.

Important
information

Youmust have an existing HPHelion, Microsoft Azure, or Amazon EC2 account to add a host
template in ALM.

Relevant tasks "How to Manage Host Templates" on page 72

See also "Host Templates Overview" on page 72

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Reset All Fields.Erasesall data entered into fields in the dialog box.

Spell Check.Checks the spelling for the selectedword or text box.
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UI Element Description

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Name The name you choose for the host template. Choose a name that clearly describe the type of host that is
provisioned by the template so that testers can provision exactly the hosts theyneed

Details Required fieldsare displayed in red. For more information about the available host template fields, see
"Host Templates Module Fields" on page 78.

Description Allowsyou to enter a description of the host template.

Host Template Details Dialog Box
This dialog box displays details about the selected host template.

To Access Lab Management andALM:

1. On the sidebar, under Cloud Settings, clickHost Templates.
2. Right-clickon a host template in the grid and selectHost Template Details.

Important information l Thisdialog box isavailable both in LabManagement and in ALM.

l Host template fields can onlybe edited in the project fromwhich the template wascreated.

Relevant tasks "How to Manage Host Templates" on page 72

See also "Host Templates Overview" on page 72

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of host templates.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb
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UI Elements Description

Template ID The ID of the host template. Generated automatically byALMat the time the host template is
added.

Template Name The name you chose for the host template.

Details Lists the details of the currently selected host template. For more information about the available
host template fields, see "Host Templates Module Fields" on page 78.

Description Allowsyou to enter a description of the host template.

History Lists changesmade to the currently selected host template. For more details, see theHP
Application Lifecycle Management User Guide.

Provisioning Hosts
This section includes:

• Provisioning Hosts Overview 82
• How to Provision and Terminate Cloud Hosts 82
• Provisioning Hosts User Interface 84
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Provisioning Hosts Overview
As with all testing hosts, cloud hosts must be added to your lab resources before you can use them for
running tests. The process of adding cloud hosts is called provisioning. When you provision a host, you
are reserving amachine on the cloud with a specific configuration. The configuration includes the
hardware details of themachine and the software image applied to themachine. In ALM, all hosts are
provisioned from templates. For more information about host templates, see "Host Templates
Overview" on page 72.

For instructions on how to provision hosts, see "How to Provision and Terminate Cloud Hosts" below.

Notes:

l Hosts can be provisioned in LabManagement from Lab Resources > Hosts. Hosts can be
provisioned in user projects from Lab Resources > Testing Hosts.

l After a host is provisioned, it consumes credits from the project that provisioned it. Credits are
consumed for each host on an hourly basis, and the number of credits consumed per hour is
specified in the host template. Youmust have at least one credit to provision your requested
hosts.

How to Provision and Terminate Cloud Hosts
This section describes how to provision and terminate cloud hosts from ALM.

For an overview, see "Provisioning Hosts Overview" above.

Note: This task is part of a higher-level task. For details, see "How to Set Up Cloud Hosts" on
page 48.

Provisioning Cloud Hosts
This task describes how to provision cloud hosts in ALM.

1. Prerequisites
To provision hosts from ALM:
l Youmust have at least one cloud account and at least one host template linked to your project.
See "How toManage Cloud Accounts" on page 60 and "How toManage Host Templates" on
page 72 for more information.

l Your project must have enough cloud credits available to provision your desired hosts. See
"How toManage Cloud Accounts" on page 60 for more information. If you do not have
permission to add credits to a project, contact your lab administrator.

When provisioning hosts, you need to supply the following:
l Security Group. Specifies the incoming and outgoing network traffic allowed to your cloud
hosts. For example, if you need to connect to your cloud hosts via Remote Desktop, your
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security groupmust allow incoming traffic over TCP port 3389 (RDP). Security groups are
configured on the website of your cloud provider and are selected in ALM during provisioning.
For more information about security groups, see "Initial Cloud Settings Overview" on page 50.

l Key Pair. Allows you to connect remotely to your cloud hosts. ForWindows hosts, the key
pair is used to generate themain administrator password. For Linux hosts, the key pair is used
to log in to themachine. Key pairs are created on the website of your cloud provider and are
selected in ALM during provisioning. For more information about key pairs, see "Initial Cloud
Settings Overview" on page 50.

Note: Not applicable for Microsoft Azure cloud accounts.

Note: Security groups and key pairs are created separately for each cloud location. Make
sure that you have configured the necessary security groups and key pairs for the locations
you will provision from.

Note: HP Helion only supports elastic IP addresses. You cannot provision hosts using fixed
IP addresses. For additional information, see the HP Helion Public CloudWeb site
(http://www.hpcloud.com/).

2. Considerations when provisioning hosts
When provisioning hosts, keep inmind:
l The location where you provision hosts can impact the effectiveness of your testing. Make
sure to select a cloud location that matches your testing needs.

l Host templates are created separately for each location, so a template that exists in one
locationmay not exist in a different location. Make sure that you know which locations contain
the templates you need or that you add your desired templates to the locations you intend to
provision from.

l If you need to connect remotely to the provisioned hosts, make sure to select a key pair for
which you have the private key and to select a security group that allows remote connections.

Note: Not applicable for Microsoft Azure cloud accounts.

l Hosts are provisioned in batches. All hosts provisioned in a single batch use the same
account, location, and template, and have identical configurations. To provision different types
of hosts, youmust create different batches. A single provision request can includemultiple
batches of hosts.

3. Provision cloud hosts
To provision cloud hosts:
a. In LabManagement, go to Lab Resources > Hosts. In ALM, go to Lab Resources >

Testing Hosts.

b. Click theProvision... button . This opens the Provision Hosts Dialog Box. For more
information, see "Provision Cloud Hosts Dialog Box" on page 85.

c. Enter the details for each batch of hosts to be provisioned and click Add Batch.
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Note: Youmust have at least one credit to provision your requested hosts.

d. After adding all necessary batches, click Provision. The hosts are queued for provisioning
and the Cloud Provisioning Report opens.

4. Post provisioning
The Host Provisioning Report shows you provisioning progress, and automatically refreshes to
show updates. If there are any errors during provisioning, you will see them here. For more
information, see "Host Provisioning Report" on page 88.
Once your cloud hosts are provisioned, you can begin to use them for running tests.

Note: Theremay be a delay of a few minutes between the time that a cloud host's status
changes to Operational and the time that the host is ready for use.

After provisioning is complete, the hosts begin to consume credits from your project.

Terminating Cloud Hosts
To terminate a cloud host:

1. In LabManagement, go to Lab Resources > Hosts. In ALM, go to Lab Resources > Testing
Hosts.

2. Select a cloud host in the grid and click theDelete button . The cloud host is queued for
termination.

It may take a few moments to terminate the host. After the host is terminated, it is removed from the
Hosts grid.

Provisioning Hosts User Interface
This section includes:

• Provision Cloud Hosts Dialog Box 85
• Host Provisioning Report 88
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Provision Cloud Hosts Dialog Box
The Provision Cloud Hosts dialog box enables you to provision hosts. You can choose how many
hosts to provision and where the hosts are provisioned, and you can select all necessary host
configurations.

Here is the Provision Cloud Hosts dialog box for Microsoft Azure:

To Access Lab Management:

1. On the sidebar, under LabResources, clickHosts.

2. Click theProvision button or selectTesting Hosts > Provision.
ALM:

1. On the sidebar, under LabResources, clickTesting Hosts.

2. Click theProvision button or selectTesting Hosts > Provision.
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MyPerformance Center:

1. On theMyPerformanceCenter navigation bar, selectResources > Testing Hosts.
2. Click theProvisionHosts button.

Important
information

Youmust have at least one cloud account and at least one host template linked to your project in
order to provision hosts.

Relevant tasks "How to Provision and Terminate Cloud Hosts" on page 82

See also "Provisioning Hosts Overview" on page 82

User interface elements are described below:

UI Element Description

Batch # Shows the number of the batch for which you are entering details.

Hosts
Amount

Enter the number of hosts to provision in the batch. Remember that all hosts in the batch use the same
account, location, and template, and have identical configurations.

Account Select the cloud account to provision from.

Location Select a suitable geographic location in which to provision the hosts. Make sure to select a location for
which you have configured an appropriate host template.

Template Host template specifies the hosts' purpose, hardware, machine image, and credits consumed per hour.
Select a host template that willmatch your testing needs. The list of available templates is based on your
selected location.

Current
Account
Balance

Shows the number of credits available in your account.

Available from:ALMandPerformanceCenter

Template
Price

Shows the cost in credits per hour of the selected template.

Available from:ALMandPerformanceCenter

Daily Total Shows the total number of credits per day the batch will consume.

Available from:ALMandPerformanceCenter

Security
Group

Select a security group that allows the necessaryaccess to your testing hosts. Security group specifies
which inbound and outbound connectionsare permitted from the hosts, such asport 80 (HTTP) or port
3389 (RDP). Security groupsare configured on your cloud provider'swebsite, andmust be created
separately for each location. Only security groupsconfigured for your selected location are displayed. For
more details, see "Initial Cloud Settings Overview" on page 50.

Note: Not applicable for Microsoft Azure cloud accounts.

Pools Select the appropriate host pools to which the newlyprovisioned hostswill be added.

Key Pair Select a keypair for which you have the private key. Keypair is used to generate the administrator
password for Windowsmachinesand to log in to Linuxmachines. Keypair is only relevant if you plan to
remotely connect to your cloud hosts. Keypairs aremanaged on your cloud provider'swebsite, andmust
be created separately for each location. Only keypairs configured for your selected location are
displayed.

Note: Youmust have at least one keypair in order to provision a host.

For more details on keypairs, see "Initial Cloud Settings Overview" on page 50.
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UI Element Description

Note: Not applicable for Microsoft Azure cloud accounts.

Attributes Select host attributes that match the capabilitiesof the hosts. Host attributesare used to identify suitable
hostswhen running tests.

Note: The attribute list can bemodified fromALMProject Customization. For details, see theHP
Application Lifecycle Management Administrator Guide.

Notification
Date

Enter the date to be notified if the hostsare still provisioned in the cloud provider. Hostsprovisioned past
this date will be listed in the cloud hostsdaily digest report.

Note: This is an optional field, however, it is recommend that you enter a value for better tracking
of hosts that are past there due date. This value canmodified from the theHostmodule.

Elastic IPs If you defined a pool of predefined IP addresseswith your cloud provider, select this option to use those
predefined static IP addresses to provisioninig your host. For more details on elastic IP addresses, see
"Initial Cloud Settings Overview" on page 50.

Note: HPHelion only supports elastic IP addresses. You cannot provision hostsusing fixed IP
addresses. For additional information, see theHPHelion PublicCloudWeb site
(http://www.hpcloud.com/).

Note: Not applicable for Microsoft Azure cloud accounts.

Username The user name of the user who connects the RDP/SSH port to the provisionedmachine. The user name
mustmeet the user name complexity requirementsof the operating system that you are using for this
virtualmachine.

Note: Onlyapplicable for Microsoft Azure cloud accounts.

Password The password of the user who connects the RDP/SSH port to the provisionedmachine. The password
mustmeet the password complexity requirementsof the operating system that you are using for this
virtualmachine.

Note: Onlyapplicable for Microsoft Azure cloud accounts.

Confirm
Password

Re-enter the password of the user who connects the RDP/SSH port to the provisionedmachine.

Note: Onlyapplicable for Microsoft Azure cloud accounts.

RDP/SSH Port The port of the secure connection remote desktop.

Note: Onlyapplicable for Microsoft Azure cloud accounts.

Add Batch Adds the selected batch to the cart.When you clickProvision, all hosts in the cart are queued for
provisioning.

Added
Batches

Showsall batches that are to be provisioned . You can click theDelete Batch button to remove a

batch from the cart.

Delete Batch Deletes the selected batch and removes it from the cart.

Provision Queuesall batches in the cart for provisioning and opens theHost Provisioning report. For more details
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UI Element Description

on this report, see "Host Provisioning Report" below.

Host Provisioning Report
The Host Provisioning report enables you to view provisioning progress of your hosts by location. The
report guides you through the provisioning steps. Details of this process are displayed in a log file.
Once your cloud hosts are provisioned, you can begin to use them for running tests.

To Access Lab Management:

1. On the sidebar, under LabResources, clickHosts.
2. Click theHost Operations drop-down arrow and selectHost Provision Report.

Alternatively, click theProvision button. In the Provision CloudHostsdialog box, click the
Provisionbutton.

ALM:

1. On the sidebar, under LabResources, clickTesting Hosts.
2. Click theHost Operations drop-down arrow and selectHost Provision Report.

Alternatively, click theProvision button. In the Provision CloudHostsdialog box, click the
Provisionbutton.

MyPerformance Center:

1. On theMyPerformanceCenter navigation bar, selectResources > Testing Hosts.
2. Click theProvision Report button.

Alternatively, click theProvision Hosts button. In the Provision CloudHostsdialog box, click the
Provisionbutton.

Important
information

l Youmust have at least one cloud account and at least one host template linked to your project in
order to provision hosts.

l Theremaybe a delayof a fewminutesbetween the time that a cloud host's status changes to
Operational and the time that the host is ready for use.

l After provisioning is complete, the hostsbegin to consume credits from your project.

Relevant
tasks

"How to Provision and Terminate Cloud Hosts" on page 82

See also "Provisioning Hosts Overview" on page 82
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User interface elements are described below:

UI Elements Description

Started This section contains the following details:

l The date and time that the provisioning starts.

l The name of the user running the report.

l The processing statusof the report.

Number of hosts
provisioned and checked:

Indicates the number of hostsqueued for provisioning and their status.

Refresh The report automatically refreshes to show updates. Click the arrow to change the
automatic refresh rate in seconds. Possible values: 1, 10, or 30.

Indicates the number of hostsqueued for provisioning and their status in the specified
location.Click the indicator to open the report details pane.

The possible statesare:

Provisioning.The host is in the processof being provisioned.

Checking.The host is in the processof being verified.

Done.The host wasprovisioned and verified.

Done - Failed.The host failed to reach a provisioned state.

Opens the report details. The report displays the following elements:

l Show All Locations. If you havemore than one location running at the same time,
you can view details for all locations.

l IP/Name.The name or IP addressof the host.
l Instance Type.The hardware specsof the host.
l Image.The software image used for the host.
l Status. Indicates the provisioning statusof the host.

l Log .Displaysa log of events related to the host.

Cloud Resources Monitoring
This section includes:

• Cloud Resources Monitoring Overview 90
• How to Configure Cloud Alerts 90
• Cloud Resources Monitoring User Interface 91
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Cloud Resources Monitoring Overview
You can analyze andmonitor your cloud resource consumption of your provisioned hosts by generating
usage reports, and by sending alerts and notifications.

Cloud Usage Reports
The following cloud usage reports are available:

Report Description

Cloud High Level Showsa summaryof credits consumed and hostsprovisioned for each project.

Cloud Credits by
Type

Showscloud credits consumed per location, per template, per instance, and per image.

Cloud Utilization Showsa per-project summaryof total cloud host uptime or running time vs. idle time, aswell as
the credit value of total idle time.

Cloud Operations
and Host

Shows individual provisioning and terminating operationsaswell asdetailed provisioning data for
each host.

Formore information, see "Usage Reports Overview" on page 147.

Cloud Alerts and Notifications
The following alerts and notifications are available for provisioned hosts:

l Idle hosts (inactivity time)
l Account usage (credit balance)
l Host status details (operational, non-operational, unavailable hosts)
For more details on configuring alerts, see "How to Configure Cloud Alerts" below.

How to Configure Cloud Alerts
This section describes how to configure cloud alerts and notifications. To learnmore about cloud alerts,
see "Provisioning Hosts Overview" on page 82.

1. Prerequisites
l To enable you to sent alerts and notifications to users, make sure to set the ALMMail Protocol.
For more details, see theHP Application Lifecycle Management Administrator Guide.

l Youmust have the appropriate user permissions to set cloud alerts and notifications. For more
details on permissions, see theHP Application Lifecycle Management Administrator Guide.

l To receive emails, an administrator must configure themail to be used for sending emails.The
administrator must belong to a TDAdmin group and have a valid email address.

2. In ALM or LabManagement, on themasthead, click and select Cloud Alerts and
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Notifications. For more information, see "Cloud Alerts and Notifications Dialog Box" on the next
page.

3. Define alerts and rules for notifying users.

Cloud Resources Monitoring User Interface
This section includes:

• Cloud Alerts and Notifications Dialog Box 92
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Cloud Alerts and Notifications Dialog Box
This dialog box enables you to set alerts and notifications to routinely inform users about important
cloud activities.

To Access
In ALMor LabManagement, on themasthead, click and selectCloud Alerts and Notifications.

Important
information

l To enable you to sent alerts and notifications to users, make sure to set the ALMMailProtocol. For more
details, see theHP Application Lifecycle Management Administrator Guide.

l Youmust have the appropriate user permissions to set cloud alerts and notifications. For more details on
permissions, see theHP Application Lifecycle Management Administrator Guide.

Relevant
tasks

"How to Configure Cloud Alerts" on page 90

See also "Provisioning Hosts Overview" on page 82

Send Alerts To
This pane enables you to set the users who should receive the alerts and notifications.

User interface elements are described below:

UI Elements Description

The user who provisioned the hosts (if applicable) Notifies the user who provisioned the cloud hosts.

Project administrator Notifies the project administrator user.

The following users: Notifies the specified users.

Rules for Alerts and Notifications
This pane enables you to set rules for notifying users.

User interface elements are described below:

UI Elements Description

Send alerts for hosts that have been idle for
the last X hours

Sendsalerts for cloud hosts that have been in idle state for the last X
hours.

ALM only: The alertswill be sent to hostsprovisioned from the
currently logged in project.

Lab Management only: The alertswill be sent to hosts
provisioned from LabManagement.

Include hosts provisioned from public
accounts in other projects

Lab Management only: Includesprovisioned hosts for cloud
accountsadded from LabManagement.

Send daily digest of cloud hosts at Sendsa cloud host summaryat the specified time. The report
includes information on today's operations, account usage, and
host details.

Send alerts when the project has less than X Notified when the project has less than the specified number of
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UI Elements Description

credits remaining in the specific cloud
account

credits in the cloud account.

LabManagement Guide
Chapter 5: Cloud Settings

HP ALM LabManagement (12.50) Page 93



Chapter 6: Lab Resources
This chapter includes:

• Lab Resources Overview 95
• Managing Lab Resources 96
• Lab Resources Modules User Interface 108
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Lab Resources Overview
The Lab Resources modules enable you to define, manage, andmaintain the testing resources used for
ALM server-side testing.

When using ALM without LabManagement, users must control tests from their local computer. This
method of testing is called client-side execution. LabManagement enables users to run tests using
server-side execution. Once testing hosts are set up, users can use ALM to schedule and execute
tests on remote hosts without requiring user intervention. The LabManagement features enable you to
set up andmaintain the hosts and host pools used for test execution.

Testing Hosts/Hosts
Testing hosts are used to run tests and to process the data collected from those tests. You can define
hosts as Functional hosts or Performance hosts.

Functional and Performance hosts can have the following purposes:

Functional
hosts
(ALM Edition
only)

l Business Process Testing. A testing host on which business process tests are run.
l QuickTest Professional.A testing host onwhichQuickTest Professional is run.
l Service TestA testing host onwhich Service Test is run.
l System Test.A testing host onwhich SystemTest is run.

l Unified Functional Testing.A testing host onwhich Unified Functional Testing is run.
l VAPI-XP.A testing host onwhich VAPI-XP is run.

Note:

l Youmust register a testing host with ALM tomake it available for functional testing. See "Using
HP ALM Lab Service" on page 261.

l You can block functional testing hosts from being selected automatically.

l You can reserve hosts for a specific user, so that other users cannot select the reserved hosts.

Performance
hosts

l Controller.A testing host used tomanage a performance test. During a test run, the Controller issues
instructions to the load generators, including which scripts to run, howmanyVusers to run per script,
andwhen to start and stop running them. There is onlyoneController per test.

l Load generator.A testing host onwhich Vusers run during a test. There can bemany load
generators for a given test.

l Data processor. A testing host used for processing and publishing data gathered during a test run.

Note:
l To provide greater flexibility (especiallywhere resourcesare scarce), you can allocate a

Performance host with dual purposesasaController and load generator. In general, this is not a
recommended practice and isonlyappropriate for tests that have a very small number of Vusers.
When allocating hosts, the system tries to use single function hostsbefore dual-purpose
Controller and load generator hosts.

l Although it is possible to set a host asboth aController and a data processor, it is recommended
to set up a separate host for data processing.

l Ahost that is located over a firewall or is a UNIXhost can be used asa load generator only.

The Testing Hosts/Hosts module is available in both the LabManagement and ALM projects.
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For task details about managing testing hosts, see "How toManage Testing Hosts" on the next page.

Host pools
A host pool is a group of testing hosts. Each project has one host pool. Whenmanaging a host pool, it
is important to understand the total available resources.

If you are using the pool for a project which involves performance testing, the pool must contain at least
one Controller, one load generator, and one data processor. Because hosts can have dual functionality,
it is recommended that a pool contains, among the other hosts, at least one host that can be dedicated
fully for Controller functionality.

Available from: LabManagement only.

For task details about managing host pools, see "How toManage Host Pools" on page 103.

Cloud Accounts
A cloud account is a LabManagement version of an actual account with a cloud provider.

For more information, see "Cloud Accounts Overview" on page 60.

Cloud Templates
A cloud template is a set of details which represents a certain type of cloud host.

For more information, see "Host Templates Overview" on page 72.

Timeslots
When running tests, or performingmaintenance on host machines, the resources needed for these
tasks must be available, andmust fall within the project and license limits. The Timeslots module
enables you to reserve resources in advance to ensure that the required resources are available when
you are ready to perform these tasks.

There are two kinds of timeslots: testing timeslots andmaintenance timeslots.

l Reserving a testing timeslot ensures that the resources required for a functional or performance test
are available when you need to run the test. You reserve testing timeslots only in your ALM project.

l Reserving amaintenance timeslot ensures that the resources required for amaintenance task are
available when themaintenance task is performed. You reservemaintenance timeslots in the Lab
Management project.

For more information about reserving timeslots, see "How to Reserve Timeslots" on page 105.

Managing Lab Resources
The workflow for managing Lab Resources is represented below.

LabManagement Guide
Chapter 6: Lab Resources

HP ALM LabManagement (12.50) Page 96



How to Manage Testing Hosts

This section describes how to create, modify, andmonitor testing hosts needed for running server-side
functional and performance tests in ALM.

Note:

l TheHostsmodule appears in LabManagement and in ALM, except that in ALM it is labeled as
Testing Hosts. The below instructions refer to LabManagement's Hostsmodule but most
functionality applies to ALM's Testing Hostsmodule as well.

l If you are using the Testing Hosts module in ALM, only testing hosts attached to the host pool
of the project are visible.

l Product Feature Movie. To view amovie that demonstrates how to set up the lab resources
required for running a performance test, select Help > Movies in the ALMmain window.

l ALM Editions: Functional testing host management is available only for ALM Edition. For more
information about ALM editions and their functionality, see theHP Application Lifecycle
Management User Guide. To find out what edition of ALM you are using, ask your ALM site
administrator.

This task describes how to:

l "Add a testing host" on the next page
l "Import testing host data from Excel " on page 99
l "Modify/View lab resource details" on page 101
l "Check host connections to testing hosts" on page 101
l "Reboot hosts" on page 102
l "Install patches on hosts" on page 102
l "Reconfigure hosts" on page 102
l "End processes on a Performance host" on page 102
l "Link testing hosts to host pools" on page 103
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Add a testing host

To run server-side functional and performance tests, youmust add testing hosts to ALM. For an
overview of testing hosts, see "Lab Resources Overview" on page 95.

To add a host from your test lab to ALM:

1. Prerequisites.
Ensure the following:
l The required testing tools are installed on your testing hosts. Refer to the documentation for
your specific testing tools for installation instructions.

l If a performance testing host you are adding is in a remote location, the locationmust be added
in the Lab Resources > Locationsmodule. For task details, see "How toManage Host
Locations" on page 104.

l If a testing host you are adding is over a firewall, the host must communicate with a
Performance host through anMI Listener. Make sure that theMI Listener was added in the Lab
Resources > MI Listenersmodule. For task details, see "How toManageMI Listeners" on
page 189.

l For hosts with functional testing purposes, HP ALM Lab Servicemust be installed on testing
hosts you are adding. To download and install HP ALM Lab Service on your testing host, select
Help > ALM Tools to open the Tools add-in page. Click theHP ALM Lab Service link, and
download the appropriate package for your operating system. For details about installing
HP Lab Service, see "Installing HP ALM Lab Service" on page 255.

2. Create a new testing host.

Tip: You can use the Import Hosts feature to import a list of hosts from an Excel file into
ALM. For details, see "Import testing host data from Excel " on the next page.

In Lab Resources > Hosts, click theNew Testing Host button . For user interface details,
see "New Testing Host Dialog Box" on page 119.

Note: Hosts created from within an ALM project are private hosts and can only exist in one
host pool at a time.

3. Register the testing host.
For security reasons, a functional testing host must be registered using HP ALM Lab Service
before it can be used. After the testing host has been registered, the testing host registrationmust
be approved from within LabManagement.
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If you set the testing host Registration Auto Approve field toY then it will be automatically
approved when you register it. If you set Registration Auto Approve toN, then you complete the
registration by changing the Status field to Registered.
For more details about registering a testing host using Lab Service, see "Using HP ALM Lab
Service" on page 261.

Note: Lab Service and the ALM server to which you are connectingmust be of the same
version in order to be compatible. If your version of Lab Service is not the same as the
ALM server, the Hosts/Testing Host grid displays your testing host as Unavailable.

To provision hosts from the cloud for use in performance testing, see "How to Provision and Terminate
Cloud Hosts" on page 82.

Import testing host data from Excel
You can import a list of testing hosts from an Excel file (.xls or .csv) using ALM or LabManagement.

1. Ensure that the Excel file is set up so that the columns can be recognized andmapped by the
Import feature.
l The first row of the Excel file must contain the field names, or corresponding logical names,
that appear in the table below. (Logical names are not case sensitive.)
Some fields aremandatory, others are required or optional.
o Mandatory indicates a field thatmust appear in the Excel file. If you omit this field, the

import fails. If you omit a value in one of the rows of this field's column, the import of that
specific row fails.

o Required indicates a field that should appear in the Excel file. If you omit this field, the
code adds the field with the default value for all rows. If you include the field, but omit a
value in one of the rows of this column, the code adds the default value for that row.

o Optional indicates a field does not have to appear in the Excel file. Omitting this field has
no effect on the import procedure.

l Fields representing virtual, reference, and invalid fields are ignored.
l Empty columns are allowed.
Set up the columns and values in the file as follows:

Field name
Logical
Name Value Field for

HOST_NAME
Mandatory

Name Anystring The valid name of the testing host machine.

HOST_
PURPOSE
Mandatory

Purpose Controller, Load
Generator, QTP,
Sprinter, and so on.

The purpose of the testing host.

Note: This can be anycombination of the
options. Optionsshould be separatedwith a
semicolon and bewithout spaces.

Example: Controller; Data Processor; QTP

HOST_STATE Status o Operational The testing host state.
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Field name
Logical
Name Value Field for

Required o Non-Operational
o Unavailable

Default:Operational

HOST_
INSTALLATION

Required

Installation o Unified Functional
Testing

o Unix  Load
Generator

o WindowsHost
o Windows

Standalone LG

Default:
Windows  Host

The type of testing host installation.

Note: There is a double space in:
o "Windows<space>

<space>Host"
o "Unix<space><space>LoadGenerator"

HOST_
PRIORITY
Required

Priority o 1-Lowest Priority
o 2, 3 ... 8
o 9-Highest Priority

Default: 5

The priority of the testing host.

HOST_SSL_
ENABLED
Required

Enable SSL o Y
o N

Default:N

SSL-enabled

HOST_
USERNAME
Optional

Username Anystring The user name for logging in to the testing host.

HOST_
PASSWORD
Optional

Password Anystring The user password for logging in to the testing host.

HOST_
DOMAIN
Optional

Domain Anystring The testing host domain.

HOST_
DESCRIPTION
Optional

Description Anystring The testing host description.

The fields specified in the table below must not be included in the Excel file. During the import of
each host, these fields are assigned default values.

Field name Default value assigned

Belongs to pools General (If adding fromwithin an ALMproject, the default is the project's pool.)

Location Default

MI Listener None

Note: If data for these fields is included in the Excel file, the data is ignored. Default values
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that are not relevant for a particular host must bemodifiedmanually in the Hosts module.

Example:

The following image illustrates an Excel file set up with the following AUT hosts: testabc,
testhost, and a third host whose namewas not provided.

2. Import the testing hosts.
a. In Lab Resources > Hosts, select Testing Hosts > Import.
b. Browse to the Excel file containing the hosts, and click Open.
At the end of the import process, a report displays the import results, and the imported hosts are
listed in the Hosts module. Hosts that are not imported successfully must be addedmanually.

Modify/View lab resource details
In Lab Resources > Hosts, select a testing host in the grid and click the Testing Host Details button

.

For user interface details, see "Testing Host Details Dialog Box" on page 120.

Check host connections to testing hosts
In Lab Resources > Hosts, right-click a testing host in the grid, and select Check Host.

The Task Manager opens, and the overall result of each check performed on the host, Passed or
Failed, is displayed.

You can view the progress of the host check in the Hosts module's Check Host Status tab.

Note: The only test which can be run on a Functional host is Ping to Host.

Based on the purpose and location of the testing host, the following checks are performed:

Check
Performed

Load Generator Host
Controller
Host

Data Processor
Host

Functional
HostRegular UNIX Standalone OFW

Ping to Host Yes Yes Yes N/A Yes Yes Yes

Installed Patches Yes N/A N/A N/A Yes Yes N/A

Services Yes N/A N/A N/A Yes Yes N/A
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Check
Performed

Load Generator Host
Controller
Host

Data Processor
Host

Functional
HostRegular UNIX Standalone OFW

Performance Yes N/A N/A N/A Yes Yes N/A

Over Firewall
Status

N/A N/A N/A Yes N/A N/A N/A

Alternatively, you can perform the above checks, together with an additional connectivity check from
the host to a particular URL. Right-click a host in the grid, select Check Connectivity to URL, and
enter the URL.

Examples:

l Regular URL: http://www.website.com
l Machine name: machine22 or http://machine22

Reboot hosts
In Lab Resources > Hosts, right-click the host in the grid that you want to reboot, and select Reboot
Host.

Install patches on hosts

Notes:

l To install patches on a host, you first need to have uploaded the patches to ALM. For details,
see "How to Upload Patches to ALM" on page 212.

l Patches can be installed on a host only when the host state is idle.
l You can only install patches on Performance hosts.

In Lab Resources > Hosts, right-click the host in the grid on which to install the patch and select
Install Patch.

For user interface details, see "Select Patch to Install Dialog Box" on page 127.

Reconfigure hosts

Note: You can only reconfigure Performance hosts.

Reconfiguring a host resets the host license, the Performance Center system user (IUSR_METRO),
and the Communication Security passphrase on the host machine.

To reconfigure a host, go to Lab Resources > Hosts. Right-click the host in the grid that you want to
reconfigure, and select Reconfigure Host.

End processes on a Performance host
To end a process on a Performance host, go to Lab Resources > Hosts. Select a host, and in the

Processes tab, select the process and click .
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Link testing hosts to host pools

Note: Host pool management is only available in LabManagement.

You can populate host pools in LabManagement in one of the following ways:

l From the Hosts module. You can link a testing host to one or more host pools.
l From the Pools module. You can link one or more testing hosts to a particular host pool. For
details, see "How toManage Host Pools" below.

To link a testing host to one or more host pools from theHostsmodule:

1. Go to Lab Resources > Hosts.
2. Right-click a host in the grid, and select Testing Host Details.
3. Click the down arrow adjacent toBelongs to Pools, and select pools in which to include the host.

Click OK.

How to Manage Host Pools

This section describes how tomanage pools of testing hosts used for running server-side functional
and performance tests in ALM.

Note: Product Feature Movie. To view amovie that demonstrates how to set up the lab
resources required for running a performance test, select Help > Movies in the ALMmain window.

This task describes how to:

l "Add a host pool" below
l "Modify/View host pool details" on the next page
l "Link hosts to host pools" on the next page

Add a host pool
Before you design and run server-side tests in ALM, youmust add your testing hosts to a host pool and
assign the host pool to your project. For an overview of host pools, see "Lab Resources Overview" on
page 95. For more information about creating testing hosts, see "How toManage Testing Hosts" on
page 97.

To add a host pool:

1. Go to Lab Resources > Pools.

2. Click theNew Host Pool button . For user interface information, see " New Host Pool Dialog
Box" on page 130.
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Modify/View host pool details

In Lab Resources > Pools, select a host pool in the grid and click theHost Pool details button .

For user interface details, see "Host Pool Details Dialog Box" on page 131.

Link hosts to host pools
To link one or more hosts to a host pool from thePoolsmodule:

1. Go to Lab Resources > Pools.
2. Select a host pool in the grid.

3. In the Linked Hosts tab, click Add Hosts to Pool . Select hosts from the grid and click
Add.
For user interface information, see "Linked Hosts Page" on page 132.

How to Manage Host Locations

This section describes how tomanage the locations of testing hosts used for running server-side
functional and performance tests in ALM.

Note:

l Cloud locations are created automatically when a new cloud account is added to ALM. Cloud
locations are read-only.

l Product Feature Movie. To view amovie that demonstrates how to set up the lab resources
required for running a performance test, select Help > Movies in the ALMmain window.

This task describes how to:

l "Add a host location" below
l "Modify/View host location details" on the next page
l "Assign a host location to a host" on the next page

Add a host location
You can organize your testing hosts according to location by creating a host location entity in the
Locations module. For an overview of host locations, see "Lab Resources Overview" on page 95. For
more information about creating testing hosts, see "How toManage Testing Hosts" on page 97.

To add a host location:
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1. Go to Lab Resources > Locations.

2. Click theNew Host Location button . For user interface information, see "New Host
Location Dialog Box" on page 135.

Modify/View host location details
In Lab Resources > Locations, select a host location in the grid and click theHost Pool details

button .

For user interface details, see "Host Location Details Dialog Box" on page 135.

Assign a host location to a host
To assign a location to a host:

1. Go to Lab Resources > Hosts.

2. Select a testing host in the grid, and click the Testing Host Details button .
3. In the Testing Host Dialog Box, select your location in the Location field.

For user interface information, see "Testing Host Details Dialog Box" on page 120.

How to Reserve Timeslots

This task describes how to reserve hosts for performingmaintenance tasks.

Note:

l This task is part of a higher-level task. For more details, see the "How toWork with Lab
Management Administration" on page 14.

l For details about reserving testing timeslots, see theHP Application Lifecycle Management
User Guide.

1. Create a maintenance timeslot
a. On the LabManagement sidebar, underHosts, select Timeslots.

b. In the Timeslots toolbar, click theNew Maintenance Timeslot button.
c. Enter the details of the timeslot and select hosts. For user interface details, see "Timeslot

Reservation: Maintenance Dialog Box" on page 136.

2. Verify the availability of the requested hosts
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Do one of the following:
l (Recommended) Click Calculate Availability. The system checks the availability of the
requested hosts for the selected timeslot. The results of this calculation are displayed in the
Timeslot Status tab and graphically on the resource availability timeline. The availability
timeline displays all timeslots when the requested hosts can be reserved. Even if the requested
hosts cannot be reserved for the selected timeslot, they may be available at other times.
If the timeslot cannot be reserved, consider the reasons displayed in the Timeslot Status tab
when reselecting your hosts. If the timeslot can be reserved, you can click Submit to save the
timeslot.
For example, you request a specific host for one hour beginning at 15:00 and click Calculate
Availability. The availability timeline indicates that this host is already reserved from 17:00 to
21:00. Therefore, you can select any timeslot between 15:00 and 16:00, or any time after
21:00, to reserve the host. The Timeslot Status tab indicates that the timeslot can be
reserved.

l Click Submit. The system calculates the availability of the requested hosts during the
selected timeslot. If all of the hosts are available, the Timeslot Reservation dialog box closes
and the timeslot is reserved and displayed in the Timeslots module. If the timeslot cannot be
reserved, the reasons are displayed in the Timeslot Status tab.

Note: If a host that you are trying to reserve for maintenance is reserved for another timeslot
that has not yet started, and you cannot delay themaintenance task, first consult with the
user who reserved the other timeslot. If he/she agrees, move the start time of the other
timeslot, or delete it accordingly.

Schedule a Maintenance Timeslot - Administrator Use Case
Paul is the system administrator at the datacenter of Mercury Tours. He has been working there for
three years, and one of his tasks is to administer the server lab. Mercury Tours uses ALM tomanage
their projects and decided last year to start using LabManagement to manage the testing hosts in their
server lab.

Paul has been given the task of making sure that the testing hosts remain healthy. He uses Lab
Management to maintain his servers. One of his typical tasks is to schedule amaintenance timeslot for
one of the testing hosts so he can work on them. Paul uses the following checklist to arrange for the
timeslot.

l Prerequisites for scheduling amaintenance timeslot
l Createmy new maintenance timeslot
l Domy maintenance work during the timeslot
Paul decides to schedule amaintenance timeslot for today so he can safely shut down and install new
hardware on some of his hosts. He consults his checklist and gets to work:

Prerequisites for scheduling a maintenance timeslot
Paul makes sure that LabManagement is up and running properly and that his testing hosts are all
registered and available.
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Create my newmaintenance timeslot
Paul navigates to Testing > Timeslots in LabManagement. The Timeslot Reservation dialog box
opens.

Reference: "Timeslot Reservation: Maintenance Dialog Box" on page 136

Paul enters the following details into the Timeslot Reservation fields:

l Name: Mercury Tours host reboot
l Duration: 1 hour, 30minutes
l Start time: 10/12/2012, 14:00
l End time: 10/12/2012, 15:30
Paul then clicks theAdd Specific Host(s) button and selects the hosts he wants to reboot.

Paul checks his timeslot details oncemore and then clicks Submit. Suddenly, an error pops up!

Confused, Paul checks the Timeslot Status tab on the bottom of the Timeslot Reservation dialog box:
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Themessage indicates that the hostmercurytours_lab2, one of the testing hosts he was reserving for
reboot, was already reserved during the scheduled timeslot. He cannot reserve the host for
maintenance until he resolves this conflict.

Paul now has to decide what to do. He can either do his maintenance work at a different time, or he can
contact the owner of the testing timeslot and find out if it's okay tomove the testing timeslot.

Paul looks up the name of the tester and finds that the reserved testing timeslot belongs to John, a
close friend of his. He calls John on the phone and asks if the testing timeslot can be postponed to
16:00. John is happy to accommodate Paul, and agrees.

Paul selects and opens the testing timeslot and changes the Start time of the testing timeslot. He then
is able to successfully reserve his maintenance timeslot for 14:00.

Do my maintenance work during the timeslot
At 14:00, Paul shuts down the testing hosts in his server lab and installs the new hardware. Once done,
he restarts the servers and tests them. It takes him only 1 hour to finish, so he is well within the limits of
his timeslot.

Lab Resources Modules User Interface
This section includes:

• Lab Resources ModuleMenus and Buttons 109
• Hosts Module 112
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• Pools Module 128
• Locations Module 133
• Timeslots Module 136

Lab Resources Module Menus and Buttons
The Lab Resources modules enable you tomanage the lab resources used for test execution.

Important
information

l Some resourcesare available only in LabManagement. Onlya user with administrator privilegescan
manage those resources.

l Non-administrator users in LabManagement can view host details and host pool details belonging to
their projects, and can reconfigure, reboot, and checkhost connectivity on hosts.

l This topic relates to all of the LabResourcesmodules:

l Hosts

l Pools

l Locations

l MI Listeners (available in thePerformance Center group)
All lab resourcesare generically referred to as<Resource>.

Relevant
tasks

"Managing Lab Resources" on page 96

Commonmenus and toolbars of the Lab Resources modules are described below:

UI Elements (A - Z) Where Description

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add a
favorite view to your private or the public folder. For details,
see theHP Application Lifecycle Management User
Guide.

Hosts/Testing
Hostsmodule

Enables you to approve the registration of a testing host,
making it available for test execution.

Note:
l If the Registration Auto Approve field for the

selected host is set toY, this button is disabled.
l Thisbutton is enabled only in LabManagement,

regardlessof which project added the host.

Auto Refresh Hosts/Testing
Hostsmodule

Refreshes the grid automatically every30 seconds.

Hosts/Testing
Hostsmodule

Performs the same checksas theCheck Host button, as
well as connectivity to anygivenURL.

Hosts/Testing
Hostsmodule

For Functional hosts, checks that the purposesassociated
with the selected testing host are valid. Results are displayed
in the TaskManager dialog box, alongwith a list of validation
results.

For Performance hosts, checksconnectivity between the
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UI Elements (A - Z) Where Description

selected host and other machines in the system.

Hosts/Testing
Hostsmodule

Opens theData Processor Queuewindow, enabling you to
view the pending data processing requests.

Note: Available only for hostswith Performance
purposes.

Delete Edit and
<right-click
menu>

Deletes the resource selected in the grid.

Note: You cannot delete anMI Listener that is being
used bya host.

<Resource> Details Toolbar and
right-click
menu

Opens the <Resource>Details dialog box, enabling you to
view and edit details of the selected resource.

Export Toolbar and
<right-click
menu>

Opens the Export AllGrid Data dialog box, enabling you to
export the resources in the grid asa text file, Microsoft Excel
worksheet, MicrosoftWord document, or HTML document.

Select one of the following options:

l All.Exports all resources in the grid.
l Selected.Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for a
resource in themodule. For details about search options,
see theHP Application Lifecycle Management User
Guide.

Go to <Resource> Toolbar Opens theGo To <Resource>dialog box, enabling you to
find a specific resource by its ID number. You can onlygo to
resources that are in the current filter.

Grid Filters View and
<right-click
menu>

Enables you to filter the data according to an entry in the filter
box. For details about filtering options, see theHP
Application Lifecycle Management User Guide.

Host Provisioning Report Hosts/Testing
Hostsmodule

Opens the provisioning report for the selected cloud host.
For more information, see "Host Provisioning Report"
on page 88. This option is disabled if more than one host is
selected or if the selected host is not a cloud host.

Import Hosts/Testing
Hostsmodule

Enables you to import a list of lab hosts from anExcel file (.xls
or .csv) into ALM (.xls or .csv format).

Information Panel View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of the
module.

Hostsmodule Opens the Install Patch dialog box, enabling you to select
patches to install on the selected hosts. For details, see
"Select Patch to Install Dialog Box" on page 127.

Note:
l You cannot use the Install Patch feature on

Controller and Load generator hosts if theyare in
theRunning state. You can only install patches
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UI Elements (A - Z) Where Description

when these hostsare idle.

l You should use this feature to install ALM certified
patchesonly.

l Available only for hostswith Performance
purposes.

Available from: LabManagement only.

Last Provision Report Hosts/Testing
Hostsmodule

Opens the provisioning report for themost recently
provisioned cloud hosts. For more information, see "Host
Provisioning Report" on page 88.

New <Resource> Toolbar Enables you to add a resource.

Organize Favorites Favorites Organizesyour favorite views. For details, see theHP
Application Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user
who created them.

Provision Hosts/Testing
Hostsmodule

Allowsyou to provision cloud hosts. For more information,
see "How to Provision and Terminate Cloud Hosts"
on page 82.

Public Favorites Lists the favorite views that are accessible to all users.

Hosts/Testing
Hostsmodule

Quick viewsare predefined filters for the Hostsgrid. The
following quick viewsare available:

l All Hosts. Showsall hosts. Includescloud, local,
performance, and functional hosts.

l Functional Testing Hosts.Showsall hostswith
UFT, Service Test Professional, BusinessProcess
Testing, SystemTest, or VAPI-XPpurposes.

l All Performance Testing Hosts.Showsall hosts
with Controller, Data Processor, or LoadGenerator
purposes. Includesboth cloud and local hosts.

l Local Performance Testing Hosts.Showsall local
performance testing hosts.

l Cloud Load Generators.Showsall cloud load
generators.

Hosts/Testing
Hostsmodule

Enables you to remotely reboot host machines.

Note:
l You cannot reboot Controller and Load generator

hostswhile theyare in theRunning state. You can
only reboot these hostswhen theyare idle.

l You cannot reboot a UNIX load generator host.

l Available only for hostswith Performance
purposes.
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UI Elements (A - Z) Where Description

Hosts/Testing
Hostsmodule

Resets the following on the selected host machine:

l Host license

l System user (IUSR_METRO)

l Communication Security passphrase

Note:
l You can reconfigure onlyone host at a time.

l Available only for hostswith Performance
purposes.

Refresh All View Refreshes the grid so that it displays themost up-to-date
information.

Replace Edit and
<right-click
menu>

In the <Resource>grid, opens theReplace dialog box,
enabling you to replace a field value in the grid. For more
details, see theHP Application Lifecycle Management
User Guide.

Select Columns View Opens the Select Columnsdialog box, enabling you to
determinewhich fields to display in the grid and their order.
For details, see theHP Application Lifecycle
Management User Guide.

Set Filter/Sort View Enables you to filter and sort the resources in the grid. Any
currently applied filtersor sorting ordersare displayed below
the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Show Cloud Summary Panel Hosts/Testing
Hostsmodule

Displays theCloud SummaryPanel, located above the
Hostsgrid.

Hosts/Testing
Hostsmodule

Enables you to unregister a testing host, making it
unavailable for test execution.

Update Selected Edit and
<right-click
menu>

Opens theUpdate Selected dialog box, enabling you to
update a field value for amultiple selection in the grid. For
more details, see theHP Application Lifecycle
Management User Guide.

Hosts Module
• Hosts/Testing Hosts ModuleWindow 113
• Hosts Fields 115
• New Testing Host Dialog Box 119
• Testing Host Details Dialog Box 120
• Event Log 121
• Processes Page 123
• Services Page 124

LabManagement Guide
Chapter 6: Lab Resources

HP ALM LabManagement (12.50) Page 112



• Check Host Status Page 124
• Over Firewall Page 126
• Select Patch to Install Dialog Box 127

Hosts/Testing Hosts ModuleWindow
This module enables you to view andmanage the hosts used for test execution.

To access Lab Management: On the sidebar, under Lab Resources, selectHosts.

ALM: On the sidebar, under Lab Resources, selectTesting Hosts.

Important
information

Some elementsare visible only for Performance hosts.

Lab Management: TheHostsmodule displaysa list of all of the hostsavailable.

ALM: The Testing Hostsmodule displaysa list of all of the hosts in the host pool of the project.

ALM Editions:Some functionality related to Functional testing host management is available only for
ALMEdition. For more information about ALMeditionsand their functionality, see theHP Application
Lifecycle Management User Guide. To find out what edition of ALM you are using, askyour
ALM site administrator.

Relevant
tasks

"How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Hosts module
common UI
elements>

l Host module fields. For field definitions, see "Hosts Fields" on page 115.
l Host module menus and buttons.For command and button descriptions, see "Lab
Resources Module Menus and Buttons" on page 109.

<Cloud
Summary
Panel>

Displaysa summaryof cloud hostsbystatus/host state. Clickon the number next to a status/host state
to filter the Hostsgrid by that status/host state.

To display the Cloud Summary Panel: From theCloudmenu, selectShow Cloud
Summary Panel.

To close the Cloud Summary Panel:Click the Xbutton at the right end of the panel.
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UI Elements Description

<Hosts grid> Displaysa list of the hosts in ALM.

Description tab Describes the currently selected host.

Tip: Right-click in this area to displaya toolbar for formatting and spell-checking the text.

Event Log tab Displaysdetailed information about the tasksperformed on the selected host, the action status, and a
description of anyerrors. For details, see the "Event Log" on page 121.

Installed PC
Components
tab

Displaysa list of the PC components installed on the host machine, including versionsand patches.

Note: Available only for hostswith Performance purposes.

To refresh the grid, click .

Installed
Programs tab

Displaysa list of all of the programs installed on the host machine. Details include the version, the
publisher of the software, and the date it was installed in the host machine.

Note: Available only for hostswith Performance purposes.

To refresh the grid, click .

Processes tab Displaysdetailed information about the processesand resource usage of the selected host.

Note: Available only for hostswith Performance purposes.

For details, see "Processes Page" on page 123.

Services tab Displays the services running on the host machine.

Note: Available only for hostswith Performance purposes.

For details, see " Services Page" on page 124.

Check Host
Status tab

Displays the statusof each step of the host checks. To see host checkstatusdetails, right clicka line in
the CheckHost Status tab, and selectCheck Hosts Status Details. For details, see "Check
Host Status Fields" on page 125.

PC Runs tab Displaysdetailed information about test runsperformed on the selected host. For details, see
"PC Test Runs Module Window" on page 141.

Over Firewall
tab

For hostsover a firewall, enables you to configure advanced over-firewall settings. For details, see "
Over Firewall Page" on page 126.

Note: Available only for hostswith Performance purposes.

History tab Lists changesmade to the currently selected host. For more details, see theHP Application
Lifecycle Management User Guide.
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Hosts Fields
This section describes the host fields. In LabManagement, you canmodify the fields of private and
public hosts. In ALM, only the fields of private hosts can bemodified.

Field (A - Z) Description

Active
Timeslot ID

The ID of the timeslot for which this host is reserved, andwhich isnow open.

Belongs to
Pools

The host pools to which the host is assigned.

Host poolsenable you to controlwhich hostsare allocated to which projects.When allocating hosts for a
test, the system allocateshosts from the host pool of the project. Hostsmust be assigned to at least one
pool.

Note: Private hosts can be assigned to onlyone pool.

Available from: LabManagement only.

Cloud
Account

The name of the cloud account fromwhich the host wasprovisioned.

Cloud Host
Identifier

Aunique ID for the host assigned by the cloud provider.

Cloud Image Themachine image applied to the cloud host.

Cloud
Instance
Type

The instance type of the cloud host.

Cloud
Request ID

The cloud provider's ID for a single provision request. A provision request includesall requested batches
of hosts. Each batch has its ownCloudRequest Item ID.

Tip: You can filter byCloudRequest ID to see all hosts that were provisioned in a single provision
request.

Cloud
Request Item
ID

The cloud provider's ID for a batch of hostswithin a provision request. All hosts in a batch have identical
specsand configurations.

Tip: You can filter byCloudRequest Item ID to see all hosts that were provisioned in a single host
batch.

Cloud
Template

The host template used to provision the host. Changing a host template doesnot affect existing hosts that
were provisioned from the template.

Created in
Project

The project the host wascreated in. You canmodify all hosts in LabManagement, including private hosts.
In ALM, you can only create andmodify private hostswithin the project's pool.

Note: Available only in LabManagement.

Description Adescription of the host.

Enable SSL Indicateswhether the LoadGenerator host will communicate with the Controller via SSL (Secure Socket
Layer) or not.

Note: The load generator usesSSL to communicate with the Controller during runtime only. For
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Field (A - Z) Description

non runtime functionality, such as including collating results, the load generator doesnot use SSL as
the communication protocol.

Relevant only for load generator hosts located over a firewall.

Exclude from
Automatch

If this field is valuedwith 'Y', the host cannot be selected via automatch. The host can onlybe selected by
name.

This is onlyapplicable for functional hosts.

Host
Attributes

The system attributesof the host.

Example:Memory, strength, installed components

Tip: You can customize the host attributes in LabManagement. For details, refer to theHP
Application Lifecycle Management Administrator Guide.

Host ID The ID of the host.

Host State The current activity on the host.

l Idle. Indicates that the host is not being used.
l Installing. Indicates that a patch isbeing installed on the host.
l Rebooting. Indicates that the host is rebooting.
l <Run states>. Indicates the host state during a performance test run.
l <Data processing states>. Indicates the state of the host during a data processing task.
l <Provisioning states>. Indicates the provisioning statusof a cloud host. Host State changes to idle

once the host is provisioned.

Host Version The version of the Lab Service agent installed on the testing host.

Caution: If the Lab Service agent installed on the testing host is not the same version as the
ALM server, the testing host status is set toUnavailable and you are unable to execute server-side
tests. To reactivate the testing host, upgrade the Lab Service agent to the current version and reset
the status in the Testing Host grid toOperational.

Installation The installation type of the host.

The following typesare available:

l Windows UFT. Indicates that this host hasUnified Functional Testing installed.
HP Unified Functional Testing (UFT) comprises the product formerly known asHPQuickTest
Professional and the product known asHPService Test.

l Functionality provided byQuickTest is now known asGUI testing in UFT.

l Functionality provided byService Test is also known asAPI testing in UFT.

Note: If you selectWindowsUFT, Service Test andQTP are selected asdefault purposes.
WindowsUFT installationsmust include at least one of these default purposes.

l Unix Load Generator. Indicates that thisUnixhost is used asa LoadGenerator for performance
tests.

l Windows Host. Indicates that thisWindowshost can be used for performance purposes (Controller,
LoadGenerator, or Data Processor), or for general functional testing (SystemTest, Vapi-XP, etc.).

l Windows Standalone LG. Indicates that thisWindowshost is used asa standalone Load
Generator for performance tests.

LabManagement Guide
Chapter 6: Lab Resources

HP ALM LabManagement (12.50) Page 116



Field (A - Z) Description

Note: You cannotmodify this field for an existing host.

Last
Configuration
Check

The last configuration checkperformed.

Last
Connectivity
Check

The last connectivity checkperformed.

Last
Installation
Check

The last installation checkperformed.

Last
Performance
Check

The last performance checkperformed.

Last Poll
Time

The last poll performed.

Last Recover
Time

The last time the host was restored toOperational status. If a host becomesnon-operational, ALM
changes the host status to Non-Operational. If the host later becomesoperational again, ALM changes
the statusback toOperational and addsa timestamp to the Last Recover Time field.

Last Run
Timeslot ID

The ID of the timeslot during which a performance test ran or data processing occurred on the host.

Location The location of the host. For example, locationscan be defined according to physical areas.

The location also determineswhether the host is located over a firewall. If so, you need to select anMI
Listener that will enable data collection.

Logical
Name

The hostname or IP addressof the host.

Name/IP The name or IP addressof the host.

Note: The name should be enteredwithout the hostname suffix.

Password The password of the PerformanceCenter system user on the host machine.

Default:P3rfoRm@1nce

Note:
l ThePerformanceCenter system user name and password are displayed only for UNIXhosts

and for anyhosts that weremigrated from earlier versionsof PerformanceCenter.

l The system user name and password of newlyaddedWindowshosts (details are not displayed
here) are the same as the system user name and password of the rest of the Performance
Center system.

PC MI
Listener

The IP addressor name of theMI Listener that enablesdata collection.

Relevant only for hosts located over a firewall.

Priority A rankassigned to the host. The higher the priority you give the host, themore likely the host will be
allocated to a test. There are a number of criteria to consider when assigning priority. Themain
considerationsare whether the host is a dedicatedmachine or a shared resource, and the type of
hardware installed on themachine.
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Field (A - Z) Description

Provider
Location ID

The region fromwhich a cloud host wasprovisioned.

Purpose The testing toolsavailable on the host. For example: Controller, Load generator, Data processor,
QuickTest Professional, Sprinter, and so on.

Note:
l If the host machine is located over a firewall, or is a UNIXmachine, it cannot function asa

Controller or Data processor.

l If you selectedWindows Standalone LGorUnix Load Generator as the installation
option,Load Generator is automatically selected as the purpose for the host and the other
optionsare disabled.

Registration
Auto
Approve

Indicateswhether the testing host will be automatically approved after it is registered byHP ALMLab
Service.

For more details, see "Using HP ALM Lab Service" on page 261.

Registration
Request
Date

The time and date that ALM received a host registration request from a newlyadded testing host.

Registration
Request
Details

Details about the host that submitted a registration request.

Registration
Status

The statusof the host's registration. To be able to use the host for testing, youmust first register the host
using HP ALMLabService and the host must be approved bya Lab Administrator in LabManagement.

For more details, see "Using HP ALM Lab Service" on page 261.

Note: You cannot change theStatus of the host to "Operational" if theRegistration Status is
"Not registered".

Reserved for
User

The user who isallowed to access this host.

This is onlyapplicable for functional hosts.

Source The testing host's source:

Local.The host exists in your testing lab.

Cloud.The host wasprovisioned from a cloud provider.

Status The statusof the host. An indicator is displayed next to the host name, indicating its current status.

The possible statusesare:

l Operational. The host machine isup and running.
l Non-operational. The host machine isdown.
l Unavailable. There is no information available about the statusof the host.

Username The name of the system user on the host machine.

Default: IUSR_METRO

Note:
l The system user name and password are displayed only for UNIXhostsand for anyhosts that

weremigrated from earlier versionsof LabManagement.

l The system user name and password for newlyaddedWindowshosts (details are not displayed
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Field (A - Z) Description

here) are the same as the system user name and password of the rest of the LabManagement
system.

New Testing Host Dialog Box
This dialog box enables you to create a testing host.

To access
l Lab Management: Under LabResources, selectHosts. Then click theNew Testing Host

button.

l ALM:Under LabResources, selectTesting Hosts. Then click theNew Testing Host button

Important
information

l You can create new public hosts in LabManagement only. Hosts created in ALMare considered private
hostsand are added directly to the host pool of the project. You canmodify private hosts in ALM.

l You can only create a host over a firewall if it is given theLoad generator purpose.

Relevant
tasks

"How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95

User interface elements are described below:

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Name The name of the new host.

Tip: Give the host ameaningful name. This can be derived from the location, purpose, type, identity, or
operating system of the host. Themore information providedwith the name, the easier it is to use and
maintain the system.Make sure that the name iseasy to remember and not too long.

Caution: For remote hostsbeing used for functional tests,thismust be the name of the computer
without the domain name. If the name entered doesnotmatch the name of the host you are trying to
register, registration will fail.
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UI
Elements

Description

Details Required fieldsaremarkedwith an asterisk (*) and are displayed in red. For details on the available host fields,
see "Hosts Fields" on page 115.

Testing Host Details Dialog Box
This dialog box displays details about a selected host.

To access l Lab Management: Under LabResources, selectHosts. Right-clickon a host in the grid and
selectTesting Host Details.

l ALM:Under LabResources, selectTesting Hosts. Right-clickon a host in the grid and select
Testing Host Details.

Important
information

l Thisdialog box isavailable both in LabManagement and in ALM.

l SomeUI elementsare available only for Performance hosts.

Relevant tasks "How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of hosts.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Host ID The ID of the host.

Name The name of the host.

Details Lists the details of the currently selected host. For more information about the available host fields,
see "Hosts Fields" on page 115.

Installed PC
Components

Displaysa list of the PerformanceCenter components installed on the host, including version and
patches.

Note:
l Use the navigation bar at the bottom of the page to view all the entries.
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UI Elements Description

l Available only for hostswith Performance purposes.

Event Log Displaysdetailed information about the tasksperformed on the selected host, the event status, and
a description of anyerrors. For details, see "Event Log" below.

Installed Programs Displaysa list of all of the programs installed on the host machine. Details include the version, the
publisher of the software, and the date it was installed in the host machine.

Note:
l Use the navigation bar at the bottom of the page to view all the entries.

l Available only for hostswith Performance purposes.

Processes Displaysdetailed information about the processesand resource usage of the selected host. For
details, see "Processes Page" on page 123.

Note:
l Use the navigation bar at the bottom of the page to view all the entries.

l Available only for hostswith Performance purposes.

Services Displays the services running on the host machine. For details, see " Services Page" on
page 124.

Note:
l Use the navigation bar at the bottom of the page to view all the entries.

l Available only for hostswith Performance purposes.

Check Hosts
Status

Displays the statusof each step of the host checks. To see host checkstatusdetails, right clicka line
in the CheckHost Status tab, and selectCheck Host Status Details. For details, see "Check
Host Status Fields" on page 125.

PC Runs Displaysdetailed information about test runsperformed on the selected host. For details, see
"PC Test Runs Module Window" on page 141.

Note: Use the navigation bar at the bottom of the page to view all the entries.

Over Firewall For hostsover a firewall, enables you configure advanced over-firewall settings. For details, see "
Over Firewall Page" on page 126.

Note: Available only for hostswith Performance purposes.

History Lists changesmade to the currently selected host. For more details, see theHP Application
Lifecycle Management User Guide.

Event Log
The Event Log displays the events that occur in a project, reporting the source and severity of each
event.

To access Use one of the following:

l Click and select Event Log.
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l Select theEvent Log tab.
Available from the followingmodules:

l In Lab Management.Hosts, PC Test Runs, Timeslots, PC Servers.

l In the ALM project.Timeslots (Grid view only), Hosts, Test Runs.

Important
information

l TheEvent Log isonlyavailable in theGrid view.

l TheEvent Log displays information for the relevant selection. That is, it displaysevents for an entire
project, timeslot, host, server, and so on.

l The time interval in days that deletable events remain in the EVENT_LOGdatabase table is determined
by theEVENT_LOG_PURGE_PERIOD_DAYS site parameter. For details, see theHP
Application Lifecycle Management Administrator Guide.

User interface elements are described below:

UI Elements
(A - Z)

Description

Set Filter.Enablesyou to filter and sort the resources in the event log. Anycurrently applied filtersor
sorting ordersare displayed below the toolbar. For more details, see theHP Application Lifecycle
Management User Guide.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display
in the event log, and their order. For more details, see theHP Application Lifecycle Management
User Guide.

Refresh.Refreshes the event log so it displays themost up-to-date information.

Export All.Opens the Export AllGrid Data dialog box, enabling you to export the resources in the grid asa
text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Action The categoryof action where the event occurred.

Example:Create Server

Context The specific entitywhere the event occurred.

Example:PCServer: VM05

Creation
Date

The date and time the event was logged.

Description Adescription of the event.

Event Log
ID

The event ID.

Event Name The name of the event.

Event Type An indication of the event's severity. Frommost to least severe: error, warning, or info.

Flow
Context ID

AGUID that indicatesa unique action which relates to several events. For example, running a test.

Module TheALMmodule where the event originated.

Example: Testing

Project
Name

The project in which the event occurred.
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UI Elements
(A - Z)

Description

Responsible The user, or automated system process responsible for the event.

Source The system element where the event originated.

Sub Module TheALM submodule where the event occurred.

Example: Test Lab

Processes Page
This page displays detailed information about the processes and resource usage of the selected host.

To access l From the Hosts module: On the sidebar, under Lab Resources, select Hosts. In the
information panel, select Processes.

l From the Host Details dialog box: On the sidebar, under Lab Resources, selectHosts.
Right-clicka host and select Host Details. In the Host Details dialog box, selectProcesses.

Important
information

l ALM isunable to displayprocessesand resource usage information for UNIXmachinesor Windows
Standalone LoadGenerators.

l TheProcessespage isavailable only for Performance hosts.

Relevant
tasks

"How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh.Refreshes the grid so it displays themost up-to-date information.

Kill Process.Ends the processselected in the grid.

l Hosts module.Kill Processpermissionsare required to end the selected process.
l Lab Management Servers module.Auser with Viewer permissionshas the ability to end the

selected process.

Auto
Refresh

Refreshes the grid automatically after the selected time interval haspassed.

<Processes
grid>

Displays the following details about the processes:

l Name.The name of the process.
l PID.The process ID.
l Processor Time (%).The percentage of processor time used by the process.
l Memory Usage (KBytes).The amount of memory (in kilobytes) used by the process.
l Elapsed Time (d.hh:mm:ss).The amount of elapsed time since the start of the process, whered is

the number of daysandhh:mm:ss is the number of hours, minutes, and seconds that have elapsed.

<Navigation
area>

Enablesyou to navigate through the pagesof entries in the grid. The total number of entries is displayed on
the right of the navigation area.

Located at the bottom of the page.
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Services Page
This page displays the services on the selected host.

To access l Hosts module: On the sidebar, under Lab Resources, selectHosts. In the Information Panel,
selectServices.

l Host Details dialog box:On the sidebar, under Lab Resources, selectHosts. Right-clicka host
and selectHost Details. In the Host Details dialog box, selectServices.

Important
information

TheServicespage isavailable only for Performance hosts.

Relevant
tasks

"How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Refresh.Refreshes the grid so it displays themost up-to-date information.

Name The name of the service.

Display
Name

The full name of the service.

Status The statusof the service:Runningor Stopped.

Startup
Type

Theway the service is set to start up:

l Auto.Service starts up automatically.
l Disabled.Service is disabled.
l Manual.Servicemust be startedmanually.

<Navigation
area>

Located at the bottom of the page, enables you to navigate through the pagesof entries in the grid. The total
number of entries is displayed on the right of the navigation area.

Check Host Status Page
This page displays the status of checks on the selected host.

To
access

l From theHostsmodule: On the sidebar, under Lab Resources, selectHosts. Select a host, and in the
information panel, selectCheck Host Status.

l From the Host Details dialog box:On the sidebar, under Lab Resources, selectHosts. Right-
clicka host and selectHost Details. In the Host Details dialog box, selectCheck Host Status.

Relevant
tasks

"How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Check Host Status Details. Opens theCheckHost StatusDetails dialog box, enabling you to view
each check's details. For field details, see "Check Host Status Fields" below.

Refresh.Refreshes the grid so it displays themost up-to-date information.

Set Filter/Sort. Enablesyou to filter and sort the grid. Anycurrently applied filtersor sorting ordersare
displayed below the toolbar. For details, see theHP Application Lifecycle Management User
Guide.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display
in the grid and their order. For details, see theHP Application Lifecycle Management User Guide.

Find.Opens the Find dialog box, enabling you to search for a check. For details, see theHP Application
Lifecycle Management User Guide.

<Check
Host Status
grid>

Displays the statusof the host checks. Click to select columns to display in the grid. For details about
the fields, see "Check Host Status Fields" below.

Check Host Status Fields

The following fields are displayed in the Check Host Status page:

Field (A -
 Z)

Description

Actual
Value

Actual value resulting from the host connectivity check.

Category The areas in which theCheckHost feature checks the host:

l Configuration

l Connectivity

l Installation

l Performance

Check The sub-areas in which theCheckHost feature checks the hosts. For example, sub-areas in the
Performance checkareProcessor,Memory,System.

Check
Date

The date the host waschecked.

Check
Result ID

The ID of each step of the host check.

Error If an error occurred during the check, displays the error.

Expected
Value

Value expected to result from the host check.

Status Indicateswhether the host checkpassed or failed.
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Over Firewall Page
This page displays communication settings between the Performance Center load generator host and
theMI Listener, and enables you to configure advanced over-firewall settings for the selected load
generator host.

To access l From the Hosts module:On the sidebar, under LabResources, selectHosts. In the information
panel, selectOver Firewall.

l From the Host Details dialog box:On the sidebar, under LabResources, selectHosts. Right-
clicka host and selectHost Details. In the Host Details dialog box, selectOver Firewall.

Important
information

l Thispage displays information if the location of the host is defined to be over a firewall.

l Ahost over a firewall can be used onlyasa load generator host.

l TheOver Firewall page isavailable only for Performance hosts.

Relevant
tasks

l "How to Manage Testing Hosts" on page 97
l "How to Manage MI Listeners" on page 189

See also l "Lab Resources Overview" on page 95
l "MI Listeners Overview" on page 189

User interface elements are described below:

UI
Elements
(A - Z)

Description

Connection
Timeout
(seconds)

The length of time that the agent waits before retrying to connect to theMI Listener machine. If zero, the
connection is kept open from the time the agent is run.

Default: 20 seconds.

Note:  This is a required field.

Connection
Type -
TCP/HTTP

Select either TCP orHTTP, depending on the configuration you are using.

Default: TCP

HTTP HTTPsettings for the HTTPconnection type:

l Proxy Name.The name of the proxyserver. This field ismandatory if theConnection Type option is
set toHTTP.

l Proxy Port.The proxyserver connection port. This field ismandatory if theConnection Type option
is set toHTTP.

l Proxy Username.The user name of a user with connection rights to the proxyserver.
l Proxy password.The password of the user with connection rights to the proxyserver.
l Proxy domain.The user's domain, if defined in the proxyserver configuration. Thisoption is required

only if NTLM isused.

MI Listener
Password

The password required to connect to theMI Listener machine.

MI Listener
User Name

The user name required to connect to theMI Listener machine.
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UI
Elements
(A - Z)

Description

Polling
Timeout
(seconds)

To verify the state of the load generator located over a firewall, ALM checkswhen last the load generator
connected to theMI Listener.

If the load generator hasnot connected to theMI Listener machine for a period of time longer than the
amount of time set in thePollingTimeout, LabManagement changes the state of the load generator to
Resource Failure.

Default: 60 seconds

Note:
l This is a required field.

l Polling Timeout is an ALM setting. It is not set in the PerformanceCenter agent.

l Polling Timeout needs to be longer than theConnection Timeout, described below.

Use
secure
connection

Enablesconnection using the Secure SocketsLayer (SSL) protocol.

Default: Disabled

l Check server certificates. Authenticates the SSL certificates that are sent by the server. Select
Medium to verify that the server certificate is signed bya trustedCertification Authority. SelectHigh to
verify that the sender IPmatches the certificate information. This setting is available only ifUse Secure
Connection is set toTrue.

l Private Key password. The password that maybe required during the SSL certificate authentication
process. Thisoption is relevant only if theClient Certificate Owner option is enabled.

l Use client certificate.Enable to load the SSL certificate (if required by the server to allow the
connection to bemade). Thisoption is relevant only if the Use Secure Connection option is enabled.

Default:Disabled

Select Patch to Install Dialog Box
This dialog box enables you to install patches on Performance hosts.

To access 1. On the LabManagement sidebar, under Lab Resources, selectHosts.
2. Click theHost Operations drop-down arrow and select Install Patch.

Tip: You can install a patch onmultiple hosts simultaneously. To select multiple hosts, hold down
theCTRL keyon your keyboard while selecting the hosts.

Important
information

l You can install patches in LabManagement only.

l To install patcheson a host, the patches first need to have been uploaded to ALM. For details, see
"How to Upload Patches to ALM" on page 212.

Relevant
tasks

"How to Manage Testing Hosts" on page 97

See also "Lab Resources Overview" on page 95

User interface elements are described below:

UI Elements Description

<Patches grid> Displays the patchesavailable in ALM to install on the selected host.
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Pools Module
• Pools ModuleWindow 129
• Pools Fields 129
• New Host Pool Dialog Box 130
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Pools ModuleWindow
This module enables you to view andmanage host pools.

To access On the LabManagement sidebar, under LabResources, selectPools.

Important
information

Ahost pool is a groupsof hosts. Each project hasone host pool.

HP ALMPerformance Center Edition:Whenmanaging a host poolwith performance hosts, it is
important to understand the total available resources. The host poolmust contain at least oneController,
one load generator, and one data processor. Because hosts can have dual functionality, it is recommended
that a pool contains, among the other hosts, at least one host that can be dedicated fully for Controller
functionality.

A private host can onlyexist in one pool at a time.

You can add hosts to a host pool in a few different ways. See "How to Manage Testing Hosts" on
page 97.

Relevant
tasks

"How to Manage Host Pools" on page 103

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Host Pools module
common UI elements>

l Pools module fields. For field definitions, see "Pools Fields" below.
l Pools module menus and buttons.For command and button descriptions, see
"Lab Resources Module Menus and Buttons" on page 109.

<Host Pools grid> Displaysa list of the host poolsdefined in ALM.

Description tab Describes the currently selected host pool.

Tip: Right-clicking in this area displaysa toolbar for formatting and spell checking the
text.

Linked Hosts tab Enablesyou to add hosts to the selected pool and remove hosts from the pool. For details,
see "Linked Hosts Page" on page 132.

History tab Lists changesmade to the currently selected host pool. For more details, see theHP
Application Lifecycle Management User Guide.

Pools Fields
This section describes the host pool fields:

Field (A - Z) Description

C+LG Hosts The number of hostswith both Controller and Load generator purposes in the host pool.

Controller
Hosts

The number of Controller hosts in the host pool.

Description Adescription of the host pool.
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Field (A - Z) Description

DP Hosts The number of Data processor hosts in the host pool.

LG Hosts The number of Load generator hosts in the host pool.

Pool ID The ID of the host pool.

Pool Name The name of the host pool.

Note: The namemaycontain up to 255 characters, excluding spaces, periods, and anyof the
following characters:

: ; * \ / " ~&? { } $ % | <>+= ^ [ ] ( )

Total Hosts The total number of hosts in the host pool.

New Host Pool Dialog Box
This dialog box enables you to add a host pool to ALM.

To access 1. On the LabManagement sidebar, under LabResources, selectPools.

2. In the Poolsmodule, click theNew Host Pool button.

Important
information

Each project hasone host pool, whichmust contain at least oneController, one load generator, and
one data processor host.

Relevant tasks "How to Manage Host Pools" on page 103

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Pool
Name

The name for the new host pool.

Details Required fieldsaremarkedwith an asterisk (*) and are displayed in red. For details on the available host pool
fields, see "Pools Fields" on the previous page.
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Host Pool Details Dialog Box
This dialog box displays details about a selected host pool.

To access 1. On the LabManagement sidebar, under Lab Resources, selectPools.
2. Right-clicka host pool in the grid and selectHost Pool Details.

Important
information

l Ahost pool is a groupsof hosts. Each project hasone host pool.

l Whenmanaging a host pool, it is important to understand the total available resources. The poolmust
contain at least oneController, one load generator, and one data processor. Because hosts can have
dual functionality, it is recommended that a pool contain, among the other hosts, at least one host that can
be dedicated fully for Controller functionality.

l Aprivate host can onlyexist in one pool at a time.

Relevant
tasks

"How to Manage Host Pools" on page 103

See also "Lab Resources Overview" on page 95

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of host pools.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Pool Name The name of the host pool.

Details Lists the details of the selected host pool. For details on the available fields, see "Pools Fields" on
page 129.

Linked Hosts Enablesyou to add hosts to the selected pool and remove hosts from the pool. For details, see
"Linked Hosts Page" on the next page.

History Lists changesmade to the currently selected host pool. For more details, see theHP Application
Lifecycle Management User Guide.
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Add Hosts to Pool Dialog Box
This page enables you to select hosts to add to a host pool.

To access l From the Pools module:
On the LabManagement sidebar, under Lab Resources, selectPools. In the information panel,

select LinkedHostsand click theAdd Hosts to Pool button.

l From the Host Pool Details dialog box:
On the LabManagement sidebar, under Lab Resources, selectPools. Right-clicka host pool and
selectHost Pool Details. In the Host PoolDetails dialog box, selectLinked Hosts and click theAdd

Hosts to Pool button.

Important
information

Alternatively, you can linka single host tomultiple host pools from theBelongs To Pools field in the host's
details. For details, see "Hosts Fields" on page 115.

Relevant
tasks

"How to Manage Host Pools" on page 103

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh All.Refreshes the grid so it displays themost up-to-date information.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display
in the grid and their order. For details, see theHP Application Lifecycle Management User Guide.

Set Filter/Sort. Enablesyou to filter and sort the grid. Anycurrently applied filtersor sorting ordersare
displayed below the toolbar. For details, see theHP Application Lifecycle Management User
Guide.

Adds the selected hosts to the host pool.

<Hosts
grid>

Lists the hostsavailable to add to the host pool.

Selected Displays the hosts selected to add to the pool.

Linked Hosts Page
This page enables you to add hosts to a host pool, and remove hosts from a pool.

To access l From the Pools module:On the LabManagement sidebar, under Lab Resources, selectPools.
In the information panel, selectLinked Hosts.

l From the Host Pool Details dialog box:On the LabManagement sidebar, under Lab
Resources, selectPools. Right-clicka host pool and selectHost Pool Details. In the Host Pool
Details dialog box, selectLinked Hosts.
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Important
information

The LinkedHostspage enables you to linkmultiple hosts to a host pool.

Alternatively, you can linka single host tomultiple host pools from theBelongs To Pools field in the host's
details. For details, see "Hosts Fields" on page 115.

Relevant
tasks

"How to Manage Host Pools" on page 103

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Testing Host Details.Opens theHost Details dialog box, enabling you to view details about the selected
linked host. For details, see "Testing Host Details Dialog Box" on page 120.

Add Hosts to Pool.Opens the AddHosts to Pool dialog box, enabling you to select hosts to add to the host
pool. For details, see " Add Hosts to Pool Dialog Box" on the previous page.

Remove Host.Removes the selected hosts from the host pool.

Go to Host.Displays the selected linked host in the Hostsmodule.

Refresh All.Refreshes the grid so it displays themost up-to-date information.

Set Filter/Sort. Enablesyou to filter and sort the grid. Anycurrently applied filtersor sorting ordersare
displayed below the toolbar. For details, see theHP Application Lifecycle Management User Guide.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in
the grid and their order. For details, see theHP Application Lifecycle Management User Guide.

Find.Opens the Find dialog box, enabling you to search for a host. For details, see theHP Application
Lifecycle Management User Guide.

<Linked
Hosts
grid>

Lists the hosts that belong to the host pool.

Locations Module
• Locations ModuleWindow 134
• Locations Fields 134
• New Host Location Dialog Box 135
• Host Location Details Dialog Box 135
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Locations ModuleWindow
This module enables you to view andmanage host locations.

To access On the LabManagement sidebar, under Lab Resources, select Locations.

Note: The Locationsmodule is onlyavailable from LabManagement.

Relevant tasks "How to Manage Host Locations" on page 104

See also "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Locations module
common UI elements>

l Locations module fields. For field definitions, see "Locations Fields" below.
l Locations module menus and buttons.For command and button descriptions,

see "Lab Resources Module Menus and Buttons" on page 109.

<Host Locations grid> Displaysa list of the host locationsdefined in ALM.

Description tab Describes the currently selected host location.

Tip: Right-clicking in this area displaysa toolbar for formatting and spell checking the
text.

History tab Lists changesmade to the currently selected host location. For more details, see theHP
Application Lifecycle Management User Guide.

Locations Fields
This section describes the host location fields:

Field (A - Z) Description

Cloud Provider Displays the cloud provider fromwhich the location wascreated.

For cloud locations only.

Description Adescription of the host location.

Location ID The ID of the host location.

Location Name The name of the host location. The name should have a logical connection to the host location.

Over Firewall Indicateswhether the host location is over a firewall.

Provider Location ID Displays the Location ID used by the cloud provider to identify the location.

For cloud locations only.
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New Host Location Dialog Box
This dialog box enables you to add a host location to ALM.

To access 1. On the LabManagement sidebar, under LabResources, select
Locations.

2. In the Locationsmodule, click theNew Host Location button.

Relevant tasks "How to Manage Host Locations" on page 104

See also "Lab Resources Overview" on page 95

User interface elements are described below:

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Location
Name

The name for the new host location.

Details Required fieldsaremarkedwith an asterisk (*) and are displayed in red. For details on the available host
location fields, see "Locations Fields" on the previous page.

Host Location Details Dialog Box
This dialog box displays details about a selected host location.

To access 1. On the LabManagement sidebar, under LabResources, select
Locations.

2. Right-clicka location in the grid and selectHost Location Details.

Important information Host locationsmust be defined before you can select them in a host's details.

Relevant tasks "How to Manage Host Locations" on page 104

See also "Lab Resources Overview" on page 95
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User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of host locations.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Location ID The ID of the host location.

Location Name The name of the host location.

Details Lists the details of the currently selected host location. For details on the available fields, see
"Locations Fields" on page 134.

History Lists changesmade to the currently selected host location. For more details, see theHP
Application Lifecycle Management User Guide.

Timeslots Module
Note: This section contains user interface information for Timeslot module screens which are
exclusive to the LabManagement project. For detailed user interface information about the
Timeslots module, refer to theHP Application Lifecycle Management User Guide.

Timeslot Reservation: Maintenance Dialog Box
This dialog box enables you to reserve amaintenance timeslot and view details of a reserved
maintenance timeslot.

To access l Newmaintenance timeslot reservation (Lab Management only):
On the Lab Management sidebar, under Lab Resources, selectTimeslots. Then use one of
the following:

l On the Timeslots toolbar, click theNew Timeslot button.
l Calendar view only: Double-clickanywhere on the calendar, or right-click the target time and

selectNew Timeslot.
l Existing maintenance timeslot reservation:
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From Lab Management:On the sidebar, under Lab Resources, selectTimeslots.
From ALM:On the sidebar, under Testing, selectTimeslots.
Then use one of the following:

l Grid View: Right-clicka timeslot of typeMaintenance and selectTimeslot Details.
l Calendar view only: Right-clickamaintenance (yellow) timeslot and selectTimeslot
Details.

Important
information

l Use this dialog box to reserve or view amaintenance timeslot.

l For testing timeslotsand data processing timeslots, see theHP Application Lifecycle
Management User Guide.

Relevant tasks "How to Reserve Timeslots" on page 105

See also HP Application Lifecycle Management User Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Run Indicates that the timeslot is amaintenance type.

Start Indicates that themaintenance task is performedmanually.

Note: This field is disabled and the selection cannot be changed.

Name Adescriptive name for the timeslot.

Duration The duration of themaintenance timeslot, in hoursandminutes.

Note: Amaintenance timeslot can be reserved for aminimumof between 15minutes
andmaximumof 480 hours (20 days).

Start Time The date and time (in hoursandminutes) that the timeslot starts.

Note: If you need to reserve a host for amaintenance task, and the host is already
reserved for running a test in the same timeslot, then you canmodify the start of the
testing timeslot, or delete the testing timeslot. Consult with the user who reserved the
testing timeslot beforemaking anychanges.

End Time The date and time (in hoursandminutes) that the timeslot ends.

Opens the Add SpecificHost dialog box, enabling you to select hosts for themaintenance
timeslot. For more details, seeHP Application Lifecycle Management User Guide.

Note: Youmust select at least one host for the timeslot.

Available: For new, open, or futuremaintenance timeslots.

Remove.Removes the selected host from the lists of requested hosts.

Set Start Time as Now.Selects the current time in the resource availability chart.

Note: A timeslot whose start time is set to the current time opens the immediately upon
submitting the reservation.

Calculates the availability of the requested resources for the selected timeslot. The results
are displayed graphically on the resource availability timeline, and amessage isdisplayed in
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UI Elements Description

theTimeslot Status tab.

The availability timeline displaysall timeslotswhen the requested hosts can be reserved.
Even if the requested hosts cannot be reserved for the selected timeslot, theymaybe
available at other times.

<Message bar> Located at the top of the dialog box. Displaysmessagesandwarningsabout the timeslot.

Available for:Existing timeslotsonly.

<Resource availability
timeline>

Displays the availability of requested resourceson a timeline:

l Availability not calculated.Displayed on the timeline before you calculate the
availability of the requested resources for a new timeslot, or whenmodifying a timeslot.

l Start Times. Indicates suggested start times for the timeslots, when the requested
resourcesare available.

l Insufficient Resources. Indicates that not all the requested resourcesare
available at the start times indicated on the timeline.

l License/Project Limit. Indicates license or project limit issuesat the start times
indicated on the timeline. For example, more hosts requested than available in the license
limit.

l Unknown.Displayed before calculating the availability of the requested resources
for the timeslot.

l Unavailable Resource. Indicates that a requested resource isnot available at the
start times indicated on the timeline.

Requested Hosts grid Displays the hosts requested for the timeslot.

Note: Youmust select at least one host for the timeslot.

Timeslot Status tab Displays the statusof the timeslot reservation.

For details about timeslot failure, seeHP Application Lifecycle Management User
Guide.

Description tab Describes the currently selected timeslot.

Tip: Right-clicking in this area displaysa toolbar for formatting and spell checking the
text.

Additional Details tab Displaysadditional details related to the timeslot.

Available for:Existing timeslotsonly.

Event Log tab Displaysa log of events related to the timeslot. For details, refer to the "Event Log" on
page 121.

Available:Existing timeslot details.
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Chapter 7: PC Test Runs
This chapter includes:

• PC Test Runs Module Overview 140
• PC Test Runs User Interface 140
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PC Test Runs Module Overview
The PC Test Runs module displays information for all test runs across all projects in the system. It
enables you to view detailed information relating to the run state of the test, the Vusers involved, as
well as host and timeslot information. You can use the Event Log to drill down and view details of
specific events for each test.

PC Test Runs User Interface
This section includes:

• PC Test Runs ModuleWindow 141
• PC Test Runs Module Fields 142
• PC Test Runs ModuleMenus and Buttons 143
• RunDetails Dialog Box 145
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PC Test Runs Module Window
This module displays information for individual test runs across all projects in the system.

To access On the LabManagement sidebar, under Performance Center, selectPC Test Runs.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<PC Test Runs module
common UI elements>

l PC Test Runs module fields. For field definitions, see "PC Test Runs Module
Fields" on the next page.

l PC Test Runs module menus and buttons.For command and button
descriptions, see "PC Test Runs Module Menus and Buttons" on page 143.

l ALMmain menu and sidebar.For details on theToolsmenu,Helpmenu and
sidebar, see theHP Application Lifecycle Management User Guide.

<PC Test Runs grid> Displaysa list of test runsacrossall projects, displaying detailed information for each test
run.

Event Log Tab
User interface elements are described below:

UI Elements Description

Set Filter.Enablesyou to filter and sort the resources in the event log. Anycurrently applied filtersor
sorting ordersare displayed below the toolbar. For more details, see theHP Application Lifecycle
Management User Guide.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display
in the event log, and their order. For more details, see theHP Application Lifecycle Management
User Guide.

Refresh.Refreshes the event log so it displays themost up-to-date information.

Export All.Opens the Export AllGrid Data dialog box, enabling you to export the resources in the grid asa
text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Event Details.Opens the Event Details dialog box, enabling you to view details of the selected event log.

Action The categoryof action where the event occurred.

Example. Create Server

Creation
Date

The date and time the event was logged.

Context The specific entitywhere the event occurred.

Example. PC Server: VM05

Description Adescription of the event.
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UI Elements Description

Event Log
ID

The event ID.

Event Name The name of the event.

Event Type An indication of the event's severity. Frommost to least severe: error, warning, or info.

Flow
Context ID

AGUID that indicatesa unique action which relates to several events. For example, running a test.

Module TheALMmodule where the event originated.

Example. Testing

Project
Name

The project in which the event occurred.

Responsible The user, or automated system process responsible for the event.

Sub Module TheALM submodule where the event occurred.

Example. Test Lab

PC Test Runs Module Fields
The following fields are available in the PC Test Runs module:

Field Description

Average Vusers The average number of concurrently running Vusersduring the run.

Controller TheController involved in the test run.

Domain/Project The test's domain and project.

Duration The time, inminutes, that the test took to run.

Note: You should not manually edit this field.

End Date The end date of the run.

Note: You should not manually edit this field.

Involved Vusers The number of Vusers that were initialized at least once during the run.

Load Generators The load generators involved in the test run.

Max Vusers Themaximumnumber of concurrently running Vusersduring the run.

Project ID The test's project ID.

Run ID The identification number of the test run. Thisnumber is automatically generated by the system
when the load test starts running.

Run Name The test run name.

State The state of the test run. If a test is stuck in a particular state, you can change it.

Start date The start date of the run.
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Field Description

Note: You should not manually edit this field.

Start time The start time of the run.

Note: You should not manually edit this field.

Temp Results
Directory Path

The path of the directorywhere the test results are temporarily stored.

Test Name The name given to the test when it wascreated.

Tester The name of the user running the test.

Consume VUDs The number of VUDsused in the test run.

Timeslot ID The ID of the test run timeslot.

PC Test Runs Module Menus and Buttons
This section describes themenus and buttons available in the PC Test Runs module.

To access On the LabManagement sidebar, under Performance Center, selectPC Test Runs.

Commonmenus and toolbars of the PC Test Runs module are described below:

UI Elements Where Description

Stop Run

<right-
click
menu>

Stopsa currently running test.

Note: Onlyenabledwhen the selected test run is in the Initializing,
Runningor Stopping states.

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your
private or the public folder. For details, see theHP Application Lifecycle
Management User Guide.

Copy URL

Runs
and
<right-
click
menu>

Copiesa selected test run and pastes itsURL asa link. The test run itself is not
copied. Instead, you can paste the address into another location, such asan
email or a document. Clicking the linkopensup ALMand takesyou to the test
run file or folder. If you are not already logged in, ALM first prompts for login
details.

Delete

Edit and
<right-
click
menu>

Deletes the selected test run.

Note: Onlyenabledwhen the selected test run isnot in one of the active
states.

<right-
click
menu>

If you analyze a test run after it has run, or recalculate the SLA, or add the test
run to a trend report, then the action is added to a data processing queue,
enabling you to seewhen the action is performed.

Export Runs
and
<right-
click

Opens the Export AllGrid Data dialog box, enabling you to export the test runs
in the grid asa text file, Microsoft Excelworksheet, MicrosoftWord document,
or HTML document.
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UI Elements Where Description

menu> Choose one of the following options:

l All.Exports all test runs in the grid.
l Selected.Exports selected test runs in the grid.

Find

View Opens the Find dialog box, enabling you to search for test runs in themodule.
For details about search options, see theHP Application Lifecycle
Management User Guide.

Go to Run

Runs Opens theGo ToRun dialog box, enabling you to find a specific test run by its
ID number. You can onlygo to test runs that are in the current filter.

Go to Timeslot

<right-
click
menu>

Opens the Timeslotsmodule, displaying the timeslot for the selected test run.

Grid Filters View and
<right-
click
menu>

Enables you to filter the data according to an entry in the filter box. For details
about filtering options, see theHP Application Lifecycle Management
User Guide.

Information Panel View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

Organize Favorites Favorites Opens theOrganize Favoritesdialog box, enabling you to organize the list of
favorite viewsbychanging propertiesor deleting views. For details, see theHP
Application Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All

View Refreshes the grid so that it displays themost up-to-date information.

Run Details

Runs
and
<right-
click
menu>

Opens theRunDetails dialog box, enabling you to view and edit details of the
selected test run.

Run Screen

<right-
click
menu>

Opens the Performance Test Run screen, enabling you to view andmanage
the test run. For more information, refer to theHP ALM Performance
Center Guide.

Note: Onlyenabledwhen test run is in theRunning state.

Select Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields
to display in the grid and their order. For more details, see theHP
Application Lifecycle Management User Guide.

For details about the test run fields, see "PC Test Runs Module Fields" on
page 142.

View Enables you to filter and sort the test runs in the grid. Anycurrently applied
filtersor sorting ordersare displayed below the toolbar. For more details, see
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UI Elements Where Description

Set Filter/Sort
theHP Application Lifecycle Management User Guide.

Run Details Dialog Box
This dialog box displays test run details.

To
access

1. On the LabManagement sidebar, under Performance Center, select PC Test Runs.
2. Right-clicka test run in the grid, and selectRun Details.

User interface elements are described below:

UI Elements (A - Z) Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of projects.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Details Displays the details of the selected test run. For more details, see "PC Test Runs Module
Fields" on page 142.

Event Log Lists the events that occurred during the selected test run. For more details, see "Event Log" on
page 121.

History Lists changesmade to the selected test run. For more details, see theHP Application Lifecycle
Management User Guide.
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Chapter 8: Usage Reports
This chapter includes:

• Usage Reports Overview 147
• How to Generate Usage Reports 147
• How to Export Reports to PDF or Excel Formats 148
• Usage Report Time Frames 149
• Usage Reports User Interface 149
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Usage Reports Overview
The ALM Performance Center Usage Reports module provides you with an overall analysis of
Performance Center. The analysis includes site users, resource usage, concurrent resource usage vs.
license limitations, timeslot usage, and resource usage by duration and runs. When working with cloud
-based hosts, you can also analyze andmonitor cloud resource consumption.

The following table provides a description of each report:

Report Description

Resource
Summary

Showsaggregate data regarding thewayprojectsused the various resourcesof the system.

Concurrencyvs.
License

Showsdetails of concurrent resource usage per project, aswell as information regarding how system
resourceswere usedwithin license limitations.

Timeslot Usage Shows information about the reservation and usage of resourcesassociated with timeslots.

Resource by
Duration

Showsgeneral information about the usage of your system resourcesover the selected time frame. You
can view statistics for total usage byproject, or per user within a project.

Resource byRuns Showsgeneral information about the test runs. You can view statistics for total usage byproject, or per
user within a project.

VUDsLicense
Usage per Project

Shows information about VUD usage per day for each selected project.

DailyVUDs
LicenseUsage

Shows information about VUD usage per day, aggregated acrossall projects.

Protocol
Granularity

Shows information about usage of protocolsassociated with Vuser scripts.

CloudHigh Level
Report

Showsa breakdown of credits consumed and hostsprovisioned per project.

CloudCredits by
Type

Showsconsumed credits per location, per template, per instance, and per image.

CloudUtilization Showsa per-project summaryof total cloud host uptime or running time vs. idle time, aswell as the credit
value of total idle time.

CloudOperations Shows individual provisioning and terminating operationsaswell asdetailed provisioning data for each
host.

For information about how to view the reports, see "How to Generate Usage Reports" below.

How to Generate Usage Reports
This task describes how to view the Usage Reports and how to set their filter criteria. The filter criteria
defines which projects are to be included in the reports and over which time frame to display results.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

To learnmore about ALM Performance Center reports, see "Usage Reports Overview" above.
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1. Select the desired report to view
From Lab Management: In LabManagement, underPerformance Center select Usage
Reports to view the ALM Performance Center reports tree. From the tree, select the desired report
to view.
From My Performance Center:On theMy Performance Center navigation bar, click Report.
For a description of each report's user interface elements, see "Usage Reports User Interface" on
the next page.

2. Select the desired projects to include in the report
Select the desired projects from theProjects drop-down list.

Note: Youmust select at least one project to generate a report.

3. Select the desired time range for the report
Select the desired time frame for the report from the Time Frame drop-down list. In addition to the
given options, you can set a custom time frame.
For an explanation of the given time frames, see "Usage Report Time Frames" on the next page.

4. Select the desired cloud accounts for the report
Select the desired cloud accounts for the report from theAccounts drop-down list.

Note: Available in:Cloud usage reports

5. Update the report to reflect the new filter settings
Click Generate. The report displays the information for the selected projects and time frame.

How to Export Reports to PDF or Excel Formats
The following task describes how to export a Performance Center report to either PDF or Excel format.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

Export a report to PDF

To export a report to a PDF file, click Export to PDF in the upper right corner of the report.

Not Available in: Cloud usage reports

Export a report to an editable Excel file

To export a report to an editable Excel file, click Export to Excel in the upper right corner of the
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report.

Usage Report Time Frames
The following table provides an explanation of the time frames available for report selection.

Time Frame Explanation

Today From 00.00 to 23.59 of the current day

Yesterday From 00.00 to 23.59 of the previousday

Thisweek FromMonday to Sundayof the current week

Previousweek FromMonday to Sundayof the previousweek

Thismonth From beginning to end of the current calendar month

Previousmonth From beginning to end of the previouscalendar month

Thisquarter The current quarter

Previousquarter The previousquarter

This year From January to December of the current year

Previousyear From January to December of the previousyear

Usage Reports User Interface
Caution:When viewing the Usage reports in a resolution of 1024x768, to see all user interface
controls, collapse the ALMmodules and/or the reports selection tree.

This section includes:

• Resource Summary Report 150
• Concurrency vs. License Report 152
• Timeslot Usage Report 157
• Resource by Duration Report 158
• Resource Usage by Runs Report 161
• VUDs License Usage per Project Report 162
• Daily VUDs License Usage Report 164
• Protocol Granularity Usage Report 166
• Cloud High Level Report 167
• Cloud Credits by Type Report 170
• Cloud Utilization Report 172
• CloudOperations Report 174
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Resource Summary Report
The Resource Summary Report provides aggregate data regarding the way projects used the various
resources of the system.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectResource

Summary.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectResource

Summary.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI
Elements
(A - Z)

Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Filter by:
Projects

Select which project to include in the report.

Available from: LabManagement only

Filter by:
Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on the previous page.

Resource
Usage by
Project tab

Containsa table that provides resource usage information for each selected project.

For more information, see "Resource Usage by Project Table" on the next page.

Top Containsa graphwhich displays the number of machinesused per project, aggregated over all the runs.
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UI
Elements
(A - Z)

Description

Projects by
Machines
tab

X-axis.The number of machinesused per project.

Y-axis.Projectsdisplayed in descending order according to the number of machinesused.

Note: Inmost circumstances, the graph displays information for up to ten selected projects. If there is
more than one selected project with the same number of maximum concurrent runs, all these projects
are displayed. In that case, more than ten projectsmight be displayed.

Top
Projects by
Runs tab

Containsa graph that displays the number of test runsper project.

X-axis.The number of test runsper project.

Y-axis.Projectsdisplayed in descending order according to the number of test runs.

Note: Inmost circumstances, the graph displays information for up to ten selected projects. If there is
more than one selected project with the same number of maximum concurrent runs, all these projects
are displayed. In that case, more than ten projectsmight be displayed.

Top
Projects by
Vusers tab

Containsa graph that displays the number of Vusersper project, aggregated over all the runs.

X-axis.The number of Vusersper project.

Y-axis.Projectsdisplayed in descending order according to the number of Vusers.

Resource Usage by Project Table

Important
information

You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether the
column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements (A - Z) Description

Duration The total time testswere run in the project.

Machines The total number of machines that were used in the project, aggregated over all the runs.

Project The project name. Deleted projectsare also included in the report and are indicated bya red x.

Runs The total number of test runs in the project, aggregated over all the tests.

Vusers The total number of Vusers in the project, aggregated over all the runs.
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Concurrency vs. License Report
The Concurrency vs. License Report provides details of concurrent resource usage per project, as well
as information regarding how system resources were used within license limitations.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, select

Concurrency vs. License.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, select

Concurrency vs. License.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI Elements
(A - Z) Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Filter by:
Projects

Select which project to include in the report.

Available from: LabManagement only

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

Concurrency
by Project
tab

Containsa table that displaysconcurrent resource usage information for each selected project.

For more information, see "Concurrency by Project Table" on the next page.

Overall
Concurrency
tab

Containsa table that displaysconcurrent resource usage information aggregated over all selected
projects, aswell asaggregated over all projects in the system.

For more information, see "Overall Concurrency Table" on page 154.

Overall
License

Containsa graph that displaysmaximumand averageRunsand Vuser usage asa percentage of the
PerformanceCenter license limitations, allowing the administrator to determine the percentage of the
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UI Elements
(A - Z) Description

Usage tab PerformanceCenter license that is actually used.

The usage isaggregated over all selected projects, aswell asaggregated over all projects in the system.

For more information, see "Overall License Usage Graph" on the next page.

Top Projects
by Runs tab

Containsa graph that displays themaximumand average number of concurrent runsper project asa
percentage of the project limit, which is defined in the project settings (Lab Settings >Project
Settings). Thishelps the administrator identify those projects that runmost efficientlywithin their given
limitations.

For more information, see "Top Projects by Runs Graph" on page 155.

Top Projects
by Vusers
tab

Containsa graph that displays themaximumand average number of concurrent running Vusersper
project asa percentage of the project limit, which is defined in the project settings (Lab Settings >
Project Settings). Thishelps the administrator identify those projects that runmost efficientlywithin
their given limitations.

For more information, see "Top Projects by Vusers Graph" on page 156.

Concurrency by Project Table

Important
Information

You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether the
column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements
(A - Z) Description

Concurrent
Machines
Avg

The average number of concurrent runningmachines (controllersand load generators) in all of the
project's concurrent test runs.

Concurrent
Machines
Limit

Themaximumnumber of concurrent runningmachinesallowed for this project asdefined in the project
settings (Lab Settings >Project Settings).

Concurrent
Machines
Max

Themaximumnumber of concurrent runningmachines (controllersand load generators) in all of the
project's concurrent test runs.

Concurrent
Runs Avg

The average number of concurrent test runs for the project. For the purposesof this report, a single test
run is considered a concurrent run.

Concurrent
Runs Limit

Themaximumnumber of concurrent runsallowed for this project asdefined in the project settings (Lab
Settings >Project Settings). For the purposesof this report, a single test run is considered a
concurrent run.

Concurrent
Runs Max

Themaximumnumber of concurrent test runs for the project. For the purposesof this report, a single test
run is considered a concurrent run.

Concurrent
Vusers Avg

The average number of concurrent running Vusers in all of the project's concurrent test runs.

Concurrent
Vusers

Themaximumnumber of concurrent running Vusersallowed for this project asdefined in the project
settings (Lab Settings >Project Settings).
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UI Elements
(A - Z) Description

Limit

Concurrent
Vusers Max

Themaximumnumber of concurrent running Vusers in all of the project's concurrent test runs.

Overall
Duration

The total time testswere run in the project. This value shows the actual amount of time the systemwasused
to run load tests, and not concurrent duration.

Project The project name. Deleted projectsare also included in the report and are indicatedwith a red x.

Overall Concurrency Table

Important
Information

You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether the
column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements(A - Z) Description

Concurrent
Machines Avg

The average number of concurrent runningmachines.

Concurrent
Machines Max

Themaximumnumber of concurrent runningmachines.

Concurrent Runs
Avg (License %)

The average number of concurrent runs. The value in brackets is the average number of
concurrent runsasa percentage of the PerformanceCenter license.

Concurrent Runs
Max (License %)

Themaximumnumber of concurrent runs. The value in brackets is themaximumnumber of
concurrent runsasa percentage of the PerformanceCenter license.

Concurrent Runs
PC License

Themaximumnumber of concurrent runsallowed by the PerformanceCenter license.

Concurrent
Vusers Avg
(License %)

The average number of concurrent running Vusers. The value in brackets is the average number of
concurrent running Vusersasa percentage of the project PerformanceCenter license.

Concurrent
Vusers Max
(License %)

Themaximumnumber of concurrent running Vusers. The value in brackets is themaximum
number of concurrent running Vusersasa percentage of the PerformanceCenter license.

Concurrent
Vusers PC
License

Themaximumnumber of concurrent running Vusersallowed by the PerformanceCenter license.

Overall Duration The total time testswere run aggregated over all the projects.

Project All Projects or Selected Projects.

Overall License Usage Graph

X-axis Maximumand average percentage of PerformanceCenter license being used.

Y-axis Vuser and runsusage aggregated over all projectsaswell asonly selected projects.
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Example

In the following example themaximum number of Vusers for all projects in the system used just
30.1% of the Performance Center license, while the average number of Vusers for all projects used
just 3.6% of the license. This tells the administrator that a significant portion of the Performance
Center license is not being used.

Top Projects by Runs Graph
Top Projects by Runs Graph

Important
Information

Inmost circumstances, the graph displays information for up to ten selected projects. If there ismore than
one selected project with the same number of maximum concurrent runs, all these projectsare displayed. In
that case, more than ten projectsmight be displayed.

X-axis Maximumand average percentage of allowed concurrent runsbeing used.

Y-axis Projectsdisplayed in descending order according to themaximumnumber of concurrent runs.

Example

In the following example theMax - Runs value for the project LR_pro is 30%. This means that the
maximum number of concurrent runs for this project reached 30% of its limit. The Avg - Runs value
for this project shows that the average number of concurrent runs reached 12.7% of its limit. These
values tell the administrator that a significant portion of the project's defined limit of concurrent runs
is not being utilized.
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Top Projects by Vusers Graph

Important
Information

Inmost circumstances, the graph displays information for up to ten selected projects. If there ismore than
one selected project with the same number of maximum concurrent runs, all these projectsare displayed. In
that case, more than ten projectsmight be displayed.

X-axis Maximumand average percentage of allowed concurrent running Vusersbeing used.

Y-axis Projectsdisplayed in descending order according to themaximumnumber of concurrent running Vusers.

Example

In the following example, theMax - Vusers value for the project proj1 is 10%. This means that the
maximum number of concurrent running Vusers for this project reached 10% of its limit. The Avg -
Vusers value for this project shows that the average number of concurrent running Vusers reached
8.4% of its limit. These values tell the administrator that a significant portion of the project's
defined limit of concurrent running Vusers is not being utilized.
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Timeslot Usage Report
The Timeslot Usage Report provides information about the reservation and usage of resources
associated with timeslots.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectTimeslot Usage.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectTimeslot Usage.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI Elements
(A - Z)

Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Filter by:
Projects

Select which project to include in the report.

Available from: LabManagement only

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

Timeslot
Usage by
Project tab

Containsa table that displays reservation and usage information for duration, machines, and Vusersper
project.

For more information, see the "Timeslot Usage by Project Table" on the next page.

Top Projects
by Duration
Usage tab

Containsa graph that displays reservation and usage information for timeslot duration per project. It allows
the administrator to seewhich projectsmost efficiently use their reserved duration.

X-axis.The total amount of reserved and used duration for each project.

Y-axis.Projectsdisplayed in descending order according to their duration usage.
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UI Elements
(A - Z)

Description

Note: Inmost circumstances, the graph displays information for up to ten selected projects. If there
ismore than one selected project with the same number of maximum concurrent runs, all these
projectsare displayed. In that case, more than ten projectsmight be displayed.

Top Projects
by Machines
Usage tab

Containsa graph that displays reservation and usage information for timeslot machinesper project. It
allows the administrator to seewhich projectsmost efficiently use their reserved number of machines.

X-axis.The total amount of reserved and usedmachines for each project.

Y-axis.Projectsdisplayed in descending order according to their Vusersusage.

Note: Inmost circumstances, the graph displays information for up to ten selected projects. If there
ismore than one selected project with the same number of maximum concurrent runs, all these
projectsare displayed. In that case, more than ten projectsmight be displayed.

Top Projects
by Vusers
Usage tab

Containsa graph that displays reservation and usage information for timeslot Vusersper project. It allows
the administrator to seewhich projectsmost efficiently use their reserved number of Vusers.

X-axis.The total amount of reserved and used Vusers for each project.

Y-axis.Projectsdisplayed in descending order according to their machinesusage.

Note: Inmost circumstances, the graph displays information for up to ten selected projects. If there
ismore than one selected project with the same number of maximum concurrent runs, all these
projectsare displayed. In that case, more than ten projectsmight be displayed.

Timeslot Usage by Project Table

Important
information

You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether the
column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Duration Reserved The amount of time reserved for the project.

Duration Used The amount of time usedwithin the project.

Machines Reserved The number of machines reserved for the project.

Machines Used The number of machinesused in the project.

Project The project name. Deleted projectsare also included in the report and are indicated bya red x.

Vusers Reserved The number of Vusers reserved for the project.

Vusers Used The number of Vusersused in the project.

Resource by Duration Report
The Resource by Duration Report provides general information about the usage of your system
resources over the selected time frame. You can view statistics for total usage by project, or per user
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within a project.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectResource Usage by

Duration.
My Performance Center:

1. On theMyPerformanceCenter navigation bar, clickReports.
2. In the list of UsageReports, selectResource Usage by

Duration.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI Elements (A - Z) Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Filter by: Projects Select which project to include in the report.

Available from: LabManagement only

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see
"Usage Report Time Frames" on page 149.

Resource Usage by
Project tab

Containsa table that displays resource usage per project over the selected time frame.

For more information, see "Resource Usage by Project Table" below.

Resource Usage by
User tab

Containsa table that displays resource usage per user.

For more information, see "Resource Usage by User Table" on the next page.

Resource Usage by Project Table

Important
information

You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether the
column is sorted in ascending or descending order. Click the column heading to reverse the order.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Avg Machines per Active
Hour

The average number of machinesused per active hour.

Note: An active hour refers to the actual running time of your testswithin the
selected time frame.

Avg Vusers per Active
Hour

The average number of running Vusersper active hour.

Note: An active hour refers to the actual running time of your testswithin the
selected time frame.

Project The project name. Deleted projectsare also included in the report and are indicated bya
red x.

Total Active Duration The total time testswere run during reserved timeslots.

Note: Active Duration refers to the actual running time of your testswithin the
selected time frame.

Total Reserved Duration The total time reserved in the Timeslotspage, by the project.

Resource Usage by User Table

Important
information

l Onlyuserswith privileges in the selected projectsare shown.

l You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether
the column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Avg Hosts per Active
Hour

The average number of hostsused per active hour.

Note: An active hour refers to the actual running time of your testswithin the
selected time frame.

Avg Vusers per Active
Hour

The average number of running Vusersper active hour.

Note: An active hour refers to the actual running time of your testswithin the
selected time frame.

Full Name The name of the user. Deleted usersare also included in the report.

Total Active Duration The total time testswere run during reserved timeslots.

Note: Active Duration refers to the actual running time of your testswithin the
selected time frame.

Total Reserved Duration The total time reserved in the Timeslotspage, by the user.
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Resource Usage by Runs Report
The Resource Usage by Runs Report provides general information about the test runs. You can view
statistics for total usage by project, or per user within a project.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectResource Usage by

Runs.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectResource Usage by

Runs.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI Elements (A - Z) Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Filter by: Projects Select which project to include in the report.

Available from: LabManagement only

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see
"Usage Report Time Frames" on page 149.

Resource Usage by
Project tab

Containsa table that displays test run statisticsper project over the selected time frame.

For more information, see "Resource Usage by Project Table" on the next page.

Resource Usage by
User tab

Containsa table that displays test run statisticsper user.

For more information, see "Resource Usage by User Table" on the next page.
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Resource Usage by Project Table

Important
information

l Details of all runswith anyamount of duration, even retriesof a single run, are included in the table.

l You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether
the column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements (A - Z) Description

Avg Duration per Run The average time used for the listed runs.

Avg Machines per Run The average number of machinesused per run.

Avg Vusers per Run The average number of Vusersused per run.

Project The project name. Deleted projectsare also included in the report and are indicated bya red x.

Total Duration The total time used by the listed runs.

Total Runs The total number of runs in the project.

Total Vusers Involved The total number of Vusers in the project.

Resource Usage by User Table

Important
information

l Runsof users that have been deleted from the system, or who no longer have anyprivileges, are also
included in the table.

l Details of all runswith anyamount of duration, even retriesof a single run, are included in the table.

l You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether
the column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements (A - Z) Description

Avg Duration per Run The average time used for the listed runs.

Avg Machines per Run The average number of machinesused per run.

Avg Vusers per Run The average number of Vusersused per run.

Full Name The name of the user. Deleted usersare also included in the report.

Total Duration The total time used by the listed runs.

Total Runs The total number of runsassociated with the user.

Total Vusers Involved The total number of Vusersassociated with the user.

VUDs License Usage per Project Report
The VUDs License Usage per Project Report provides information about VUD usage per day for each
selected project.

To access ALM / Lab Management:
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1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectVUDs License Project

Usage.
My Performance Center:

1. On theMyPerformanceCenter navigation bar, clickReports.
2. In the list of UsageReports, selectVUDs License Project

Usage.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI Elements
(A - Z)

Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Filter by:
Projects

Select which project to include in the report.

Available from: LabManagement only

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

VUDs per
Project tab

Containsa table that provides information about dailyVUD usage per selected project. For more
information see "VUDs per Project Table" below.

VUDs
Transactions
tab

Containsa table that provides information about VUDsper transactions. For more information, see
"VUDs Transactions Table" on the next page.

VUDs per Project Table

Important
information

l Details of all runswith anyamount of duration, even retriesof a single run, are included in the table.

l You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether
the column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Allocated The amount of VUDs that were allocated to the project at the start of the day.

Consumed The amount of VUDs that were consumed during the day.

Date The date for which VUD usage information is shown.

New Value The amount of VUDs that were remaining at the end of the day.

Project The name of the project.
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VUDs Transactions Table

Important
information

l Details of all runswith anyamount of duration, even retriesof a single run, are included in the table.

l You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether
the column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements (A - Z) Description

Action The current state of the VUDs.

Date The date for which VUD information is displayed.

In Use The number of VUDs that are currently running.

New Limit The number of VUDs that are currently available to the project.

Pending The number of VUDs that are available for running.

Project The project name. Deleted projectsare also included in the report and are indicated bya red x.

Run ID The run ID.

Test Name The performance test name.

Unique ID Aunique ID that identifiesVUDs from their issue to their expiration.

User The user that performed the transaction.

Value The amount of VUDs that are in the state indicated in theAction column.

Daily VUDs License Usage Report
The Daily VUDs License Usage Report provides overall VUD usage information aggregated for all
projects for a specific day.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectDaily VUDs License Site

Usage.
My Performance Center:

1. On theMyPerformanceCenter navigation bar, clickReports.
2. In the list of UsageReports, selectDaily VUDs License Site

Usage.

Relevant tasks "How to Generate Usage Reports" on page 147
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User interface elements are described below:

UI Elements
(A - Z)

Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Generate Generates the report.

Daily VUDs
Usage tab

Containsa table that displaysdailyVUD usage information. For more information, see "Daily VUDs
Usage Table" below.

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

Daily VUDs Usage Table

Important
information

l Details of all runswith anyamount of duration, even retriesof a single run, are included in the table.

l You can sort the table according to the valuesof anycolumn. The arrow in the heading displayswhether
the column is sorted in ascending or descending order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements (A - Z) Description

Added The amount of VUDs that were added on the day.

Consumed The amount of VUDs that were used on the day.

Date The date for which VUD usage information is shown.

New Value The amount of VUDs that were remaining at the end of the day.
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Protocol Granularity Usage Report
The Protocol Granularity Usage report shows the Vuser script's protocol usage.

To access ALM / Lab Management:

1. SelectPerformance Center>Usage Reports.
2. In the list of UsageReports, selectProtocol

Granularity.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectProtocol

Granularity.

Important Information The report refersonly to Vusers that have reached the run stage.

Relevant tasks "How to Generate Usage Reports" on page 147

User interface elements are described below:

UI Elements Description

Export to PDF/Excel.Click to export the report to PDF or Excel format.

Filter by: Time Frame Select the desired time frame for the report. For an explanation of the given time frames,
see "Usage Report Time Frames" on page 149.

Generate Generates the report.

Protocol Granularity
Usage Summary tab

Displays information about the script usage, Vuser usage, and duration.

Scripts Usage tab Containsa graph that displays the scripts usage byprotocol.
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UI Elements Description

Duration Usage tab Containsa graph that displays the duration usage byprotocol.

Protocol Granularity Usage Summary
User interface elements are described below:

UI
Elements

Description

Protocol
Type

TheVuser script's protocol.

Scripts l # Used (%). The total number of times the testsused scriptswith a certain protocol type. If the same script
is used several timesbya test, it will be aggregated. The% indicates the relative percentage of howmany
timesa protocol is used compared to the total number of scripts used. Calculated byusing the formula:

Used

Sum of Used

(# ) × 100

#

l Avg Per Run. Indicates the relative part of a protocol out of all the runs. Calculated byusing the formula:
Used

Total number of runs

#

Vusers l Max.Themaximumnumber of Vusers sampled during a single run. Note that when test scripts are running
at the same time and using the same protocol, for example, the first test script is running 10 Vusersand the
other script is running 100 Vusers, the report will display themaximum value as100. The report doesnot
aggregate all the Vusers that are running from different test scripts at the same time.

l Avg Per Run.The average number of Vusersused per run. Calculated byusing the formula:
Sum of the average number of Vusers

Total number of runs 

Duration Minutes (%).The total number of minutes the protocolwas in use. Calculated byusing the formula:
Sum of the Avg Vusers Per Run Duration×

The% indicates the duration percentage of a protocol that wasused out of the total duration. Calculated by

using the formula:
Total duration

Total

× 100

 duration of  all runs

Cloud High Level Report
The Cloud High Level Report shows provisioned hosts and consumed credits per project over time.

Grid view:
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Graph view:

To access ALM / Lab Management:

1. SelectPerformance Center > Usage Reports.
2. In the list of UsageReports, selectCloud High Level

Report.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectCloud High Level

Report.

Important Information l This report can be viewed asa grid or asa graph.

l Export optionsare available onlywhen viewing the report asa
grid.

Relevant tasks "How to Generate Usage Reports" on page 147

See Also l "Cloud Accounts Overview" on page 60
l "Cloud Resources Monitoring Overview" on page 90

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Elements Description

Available when viewing report output as a graph.
Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generate Generates the report. Make sure to generate the report after updating the report filters.

Filter by:
Accounts

Allowsyou to choosewhich cloud accountsare included in the report output. Hostsare shown in the
report output only if theywere provisioned from one of the selected cloud accounts.

Filter by:
Projects

Allowsyou to choosewhich projectsare included in the report output. Hostsare shown in the report
output only if theywere provisioned from one of the selected projects.

Available from: LabManagement only.

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

<Group by
Months/Weeks>

Determineshow the report results are grouped.

l If Months is selected, each column in the report output showsonemonth's data, and there is a
column for eachmonth.

l If Weeks is selected, each column in the report output showsoneweek'sdata, and there is a column
for eachweek.

Example:Select Monthsand each column of the report showsa summation of all consumed
credits and provisioned hosts for an entiremonth. There is one column for eachmonth in the
selected time frame.

<Report
output>

Displays the report output. Report output can be displayed asa grid or a graph, depending upon the
selectedView Mode.

<Show usage
by>

Available when viewing report output as a graph.

l Credits.Choose to displayaccount usage bycredits consumed.
l Hosts.Choose to displayaccount usage byhostsprovisioned.

View Mode Choose how to display the report output:

l Grid View .Display the report output in a grid.

l Graph View .Display the report output in a graph.

The following columns appear in the report output when displayed in a grid (unlabeled elements are
shown in angle brackets):

Field Description

Credits Displays the number of credits consumed by the project during the specified time frame.

<Date> Displays the start time of the time frame shown in the column.

Hosts Displays the number of hostsprovisioned by the project during the specified time frame.

Project Displays the project, including domain, which provisioned the hostsand consumed the credits.
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Cloud Credits by Type Report
The Cloud Credits by Type Report shows the number of consumed cloud credits by location, template,
instance, or machine image.

Grid view:

Graph view:

To access ALM / Lab Management:

1. SelectPerformance Center > Usage Reports.
2. In the list of UsageReports, selectCloud Credits By

Type.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectCloud Credits By

Type.

Important Information l This report can be viewed asa grid or asa graph.

l Export optionsare available onlywhen viewing the report asa
grid.

Relevant tasks "How to Generate Usage Reports" on page 147

See Also l "Cloud Accounts Overview" on page 60
l "Cloud Resources Monitoring Overview" on page 90
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Available from:Graph view only.

Generate Generates the report. Make sure to generate the report after updating the report filters.

Credits By
Image tab

Report output showscredit usage per machine image.

Credits By
Instance tab

Report output showscredit usage per instance type.

Credits By
Location tab

Report output showscredit usage per location.

Credits By
Template tab

Report output showscredit usage per host template.

Filter by:
Accounts

Allowsyou to choosewhich cloud accountsare included in the report output. Hostsare shown in the report
output only if theywere provisioned from one of the selected cloud accounts.

Filter by:
Projects

Allowsyou to choosewhich projectsare included in the report output. Hostsare shown in the report output
only if theywere provisioned from one of the selected projects.

Available from: LabManagement only.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

<Report
output>

Displays the report output. Report output can be displayed asa grid or a graph, depending upon the
selectedView Mode.

<Show usage
by>

l Credits.Choose to displayaccount usage bycredits consumed.
l Hosts.Choose to displayaccount usage byhostsprovisioned.
Available from:Graph view only.

View Mode Choose how to display the report output:

l Grid View .Display the report output in a grid.

l Graph View .Display the report output in a graph.

The following columns appear in the report output when displayed in a grid (unlabeled elements are
shown in angle brackets):

Field Description

Credits Displays the number of credits consumed bya project using the specified location, template, instance, or
image.

<Image> Displays the number of hostsprovisioned using amachine image and the number of credits consumed by
hostswith that machine image.

Available from:CreditsBy Image tab only.

<Instance> Displays the number of hostsprovisioned using an instance type and the number of credits consumed by
hostswith that instance type.
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Field Description

Available from:CreditsBy Instance tab only.

Hosts Displays the number of hostsprovisioned bya project using the specified location, template, instance, or
image.

<Location> Displays the number of hostsprovisioned from a location and the number of credits consumed by that
location.

Available from:CreditsByLocation tab only.

Project Displays the project, including domain, which provisioned the hostsand consumed the credits.

<Template> Displays the number of hostsprovisioned from a template and howmanycreditswere consumed byhosts
provisioned from that template.

Available from:CreditsByTemplate tab only.

Cloud Utilization Report
The Cloud Utilization Report shows in-use time versus idle time for cloud hosts. This allows you to see
if you are effectively using your cloud resources.

Grid view:

Graph view:

To access ALM / Lab Management:

1. SelectPerformance Center > Usage Reports.
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2. In the list of UsageReports, selectCloud Utilization.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectCloud Utilization.

Important Information l This report can be viewed asa grid or asa graph.

l Export optionsare available onlywhen viewing the report asa
grid.

Relevant tasks "How to Generate Usage Reports" on page 147

See Also l "Cloud Hosts Overview" on page 47
l "Cloud Resources Monitoring Overview" on page 90

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Available when viewing report output as a graph.
Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generate Generates the report. Make sure to generate the report after updating the report filters.

Filter by:
Accounts

Allowsyou to choosewhich cloud accountsare included in the report output. Hostsare included only if they
were provisioned from one of the selected cloud accounts.

Filter by:
Projects

Allowsyou to choosewhich projectsare included in the report output. Hostsare included only if theywere
provisioned from one of the selected projects.

Available from: LabManagement only.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time frames, see "Usage
Report Time Frames" on page 149.

<Report
output>

Displays the report output. Report output can be displayed asa grid or a graph, depending upon the
selectedView Mode.

View Mode Choose how to display the report output:

l Grid View .Display the report output in a grid.

l Graph View .Display the report output in a graph.

The following columns appear in the report output when displayed in a grid:

Field Description

Total In Use Time Total time in hours that hostsprovisioned bya project were running tests.

Total Idle Time Total time in hours that hostsprovisioned bya project were available for running
testsbut were not in use.

Total Idle Time Worth in Credits
(estimate)

Total number of credits consumed byhosts that were available for running tests
but were not in use.

Project Displays the project, including domain, for which the utilization summary is given.
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Cloud Operations Report
The CloudOperations Report shows individual provision and terminate operations for your cloud hosts.
You can also see test usage for each host.

To access ALM / Lab Management:

1. SelectPerformance Center > Usage Reports.
2. In the list of UsageReports, selectCloud Operations.
My Performance Center:
1. On theMyPerformanceCenter navigation bar, click

Reports.
2. In the list of UsageReports, selectCloud Operations.

Important Information l This report contains three elements: Operations, Hosts, and
Usage.

l Data for this report can onlybe exported to Excel.

Relevant tasks "How to Generate Usage Reports" on page 147

See Also l "Cloud Hosts Overview" on page 47
l "Cloud Resources Monitoring Overview" on page 90

See Also l "Cloud Hosts Overview" on page 47
l "Cloud Resources Monitoring Overview" on page 90

User interface elements
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Export to Excel. Click to export the report to Excel format.

The Excel export containsadditional columns in the report output.

Generate Generates the report. Make sure to generate the report after updating the report filters.

Back to Hosts Available when viewing an individual cloud operation or a host's usage. Returns to the list of cloud
hosts.

Back to
Operations

Available when viewing an individual cloud host. Returns to the list of cloud operations.

<Column
search>

Allowsyou to search the selected column. Numerical fields search for anexact matchof the
entered number. Text fields search for any records that contain the entered text.

Filter by:
Accounts

Allowsyou to choosewhich cloud accountsare included in the report output. Hostsand operations
are included only if theywere provisioned from one of the selected cloud accounts.

Filter by:
Projects

Allowsyou to choosewhich projectsare included in the report output. Hostsand operationsare
included only if theywere provisioned from one of the selected projects.

Available from:LabManagement only.
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UI Elements Description

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given time frames, see
"Usage Report Time Frames" on page 149.

Operations/Hosts
selector

Available when viewing all cloud hostsor all cloud operations. Changes the report output to display
either cloud operationsor cloud hosts.

<Report output> Displays the report output. Report output can be displayed asa grid or a graph, depending upon the
selectedView Mode.

Show all Hosts Available when viewing an individual cloud host. Returns to the list of all cloud hosts.

Show all
Operations

Available when viewing an individual cloud operation. Returns to the list of all cloud operations.

Operations view

The operations view shows you a list of each individual provision and terminate operation. You can see
which hosts are included in an operation by clicking on the number in theHosts column.

To access:Click the Operations radio button.

The following columns appear in the report output in the operations view:

Field Description

ID The ID of the cloud operation.

Request ID The cloud provider's ID for the cloud operation .

Operation The type of cloud operation: Provision or Terminate.

Start Time The date and time the cloud operation was initiated.

Duration The time inminutes that it took to provision or terminate the hosts.

Hosts
Requested

For provision operations: The number of hosts requested from the cloud provider.

For terminate operations: The number of hosts terminated.

Hosts For provision operations: The number of hostsactually provisioned. Blank if no hostswere
successfully provisioned.

For terminate operations: The number of hosts terminated.
Clickon the number of hosts to view a list of all hosts included in an operation.
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Field Description

Project The project that initiated the cloud operation.

Hosts view

The hosts view shows you the provision and terminate operations associated with each individual host.
You can see full details of a provision operation by clicking on the ID in theProvision Operation
column. You can see full details of a terminate operation by clicking on the ID in the Terminate
Operation column.

To access:Click the Hosts radio button.

The following columns appear in the report output in the hosts view:

Field Description

Host Name The IP addressof the cloud host.

Label The logical name of the cloud host asspecified during provisioning.

Provisioned The date and time that the host wasprovisioned.

Terminated The date and time that the host was terminated. Blank for hosts that have not yet been terminated.

Total Up Time The amount of time that the host wasprovisioned. Blank for hosts that have not yet been terminated.

Total Idle Time The amount of time that the host wasprovisioned but wasnot being used for testing. Blank for hosts that
have not yet been terminated.

Usage Click to open the usage view for the selected host.

Provision
Operation

Shows the ID of the operation in which the host wasprovisioned.

Terminate
Operation

Shows the ID of the operation in which the host was terminated. Displays "0" for hosts that have not yet
been terminated.

Usage view
The usage view shows you all tests run using the selected host.

To access: From the hosts view, in the Usage column, click theUsage button for the desired host.

The following columns appear in the report output in the usage view:
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Field Description

Timeslot ID ID of the timeslot in which the test was run.

Run ID ID of the test run.

Start The date and time that the test run began.

End The date and time that the test run ended.

Duration Duration of the test run inminutes.

Project The project that initiated the test run.

User The user who initiated the test run.
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Chapter 9: System Health
This chapter includes:

• System Health Overview 179
• System Health User Interface 179
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System Health Overview
To design and run performance tests in ALM, the Performance Center systemmust be running
properly. The System Health module enables you to run tasks that validate that the components of the
system are communicating with each other, allowing you tomaintain the system in a healthy state.

System Health User Interface
This section includes:

• System Health ModuleWindow 180
• Configure System Check Dialog Box 181
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SystemHealth Module Window
This module displays information about the ALM Performance Center system health maintenance
tasks and overall system checks, and enables you to run a full validation on your ALM Performance
Center system.

To access On the LabManagement sidebar, under Performance Center, selectSystem Health.

See also "System Health Overview" on the previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Opens the configure system checkdialog box, enabling you to select serversand hosts in the
ALM-PerformanceCenter system to include in the system check. For details, see
"Configure System Check Dialog Box" on the next page.

Refresh All. Refreshes the grid so that it displays themost up-to-date information.

IfAuto Refresh is enabled, this button is disabled.

Set Auto Refresh On/Off.When enabled, automatically refreshes the grid every5
secondsso that it displays themost up-to-date task information.

Displays the system check results that have a failed statusonly.

Opens the Export Grid Data dialog box, enabling you to export the results of the system check
asaMicrosoft Excelworksheet.

Choose one of the following options:

l All.Exports all tasks in the grid.
l Selected.Exports selected tasks in the grid.

<Results grid> Displays the progressand results of the system check. Includes the following fields:

l Status.The statusof the system check.

l Component.The server or host name.
l Description.The description of the task.
l Result.The task results.
l Start Time.The time that the taskcheckstarted.
l End Time.The time that the taskcheckended.
l Passed. Indicateswhether the taskcheckpassed or failed.

Task Result Displays the taskstatusand the results of the system check.

Task Log Displaysdetailed information about the tasksperformed on the operational server or host,

the action status, and a description of anyerrors.
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Configure SystemCheck Dialog Box
This dialog box enables you to select which ALM-Performance Center system components (servers
and hosts) to include when doing a system check.

To access On the LabManagement sidebar, under Performance Center, select System Health. Click

.

Important
information

l The system check isperformed on PerformanceCenter Serversand hosts that are in an
operational state only.

l The system check isperformed on hostswith the Controller purpose only.

See also "System Health Overview" on page 179

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Check ALM
Platform

Includes the ALM server in the system check.

Check
Performance Center
Servers

IncludesoperationalPerformanceCenter Servers in the system check.

l All. Includesall of the operationalPerformanceCenter Servers in the system check.

l Specific.Enablesyou to select operationalPerformanceCenter Servers to include in the
system check.

Check Hosts IncludesoperationalPerformanceCenter hostswith the Controller purpose in the system check.

l All. Includesall of the operationalPerformanceCenter hostswith the Controller purpose in
the system check.

l Specific. Enablesyou to select operationalPerformanceCenter hostswith the Controller
purpose to include in the system check.

<Performance
Center Server grid>

Lists the PerformanceCenter Servers that you selected to include in the system check, and
displays their details. For more details, see "PC Servers Module Fields" on page 240.

<Performance
Center host grid>

Lists the PerformanceCenter hosts that you selected to include in the system check, and displays
their details. For more details, see "Hosts Fields" on page 115.
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Chapter 10: PC Licenses
This chapter includes:

• HP ALM Performance Center Licenses Overview 183
• How to Set Performance Center License Keys 184
• PC Licenses User Interface 184
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HP ALM Performance Center Licenses Overview
Towork with HP ALM Performance Center, each of the following licenses must be defined:

License Description

ALM TheALM license is configured aspart of the ALM installation processand ismanaged in Site
Administration. For more information about the ALM license, see theHP Application Lifecycle
Management Administrator Guide.

Performance
Center

There are two typesof PerformanceCenter licenses:

l PC.ThePC license is limited by the total number of concurrent runsor Vusers, andmayhave an
expiration date.

Note: This license isalso available asa free permanent community license bundle. Thisbundle
includes1Controller allowing 1 concurrent run, and 50 PC Vusers.

l PC_VUDS. AVirtualUser Day (VUD) license providesyouwith a specified number of Vusers (VUDs)
that you can run an unlimited number of timeswithin a 24 hour period (the VirtualUser Day). At the end
of a VirtualUser Day, the remaining number of licensed VUDs is calculated bysubtracting the number
of used VUDs, or in the case of concurrent usage, themaximumnumber of concurrent running VUDs,
from the total number of licensed VUDs.

For example, a user hasa license that allowshim to run 1,000 VUDs. He createsa performance test
that requires200 Vusersand runs for 45minutes. He runs the test at 8:00 am, 10:00 am, 2:00 pm, and
at 4:00 pm. In each case, the test finishesbefore the next one begins. Because there is no concurrent
Vuser usage, he can re-use the same 200 VUDs for each test run, meaning that at the end of the 24-
hour period, only200 VUDsare deducted from the license, leaving 800 for future use.

However, if the user starts the second run at 8:30 am, the first test is still running before the second test
initializes. Thisoverlap requires400 Vusers to run concurrently (200 for each test). At the end of the
day, 400 VUDsare deducted from the license, because that is the highest number of concurrent
Vusers. The total left for future use is600 VUDs.

Note:
l ThePerformanceCenter andHost licensesare configured directly after installation of the

PerformanceCenter Server. You configure the licensesusing the PC LicensesModule
window. For more information, see "PC Licenses Module Window" on page 185.

l You can run VUDsonHPdeveloped protocols, with the exception of: COM/DCOM, VBCom,
VBVuser, VBScript Vuser, VB.NET Vuser, and VB.NET Template.

l You cannot run VUDson SDKprotocols.

l You cannot run VUDson aGUI Vuser script, such asUFT Professional scripts.

l When using a VUD based PerformanceCenter license, a Host license isnot relevant.

Host TheHost license defines the limits of Vuser use per protocol on the host. There are two host license Vuser
types:

l <bundle type> Bundle. Each bundle containsa collection of protocols.When you select a protocol
bundle, this section displaysa list of included protocols.

l Global.The global license lets you run all Vuser types, provided you staywithin the total limit. The
number following "Global" indicates the total number of Vuserspurchased.

Community
License
Bundle

PerformanceCenter is deliveredwith a free perpetual community license bundle. The bundle includes:

1 Controller allowing 1 concurrent run, 1 PC Lifecycle user, and 50 permanent Vusers. These Vusersare
valid for all protocolsexcept for GUI (UFT), COM/DCOM, and template protocols. The community license
bundle doesnot include support.
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License Description

Note: The bundle is located underCommunityLicense in the root directoryof the Performance
Center installation DVD.

Note: The Performance Center and Host licenses are configured directly after installation of the
Performance Center Server. You configure the licenses using the PC Licenses Module window.
For more information, see "How to Set Performance Center License Keys".

How to Set Performance Center License Keys
This section describes how to set Performance Center license keys.

1. Prerequisites
Make sure the ALM license is set in the ALM Site Administration. For more information about the
ALM license, see theHP Application Lifecycle Management Administrator Guide.

2. Activate your license keys
To activate your licenses, visit the HP Software Licensing Portal
(http://www.hp.com/software/licensing) and enter your Entitlement Order Number.
If you do not have a license, visit the HP Software Licensing Portal
(http://www.hp.com/software/licensing) and click theContact Licensing Support link.

3. Set your license keys
a. In LabManagement, underPerformance Center select PC Licenses. The PC Licenses

ModuleWindow opens. For user interface details, see "PC Licenses ModuleWindow" on the
next page.

b. Select one of the following options:
o Add License Key. Adds a single license key.
o Add License from File. Adds multiple license keys simultaneously. For user interface

details, see "Add Licenses from File Dialog Box" on page 187.

PC Licenses User Interface
This section includes:

• PC Licenses ModuleWindow 185
• Add Licenses from File Dialog Box 187
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PC Licenses Module Window
This page enables you to view summaries of your Performance Center and VUD-based licenses, as
well as host license information.

To access On the LabManagement sidebar, under Performance Center, selectPC Licenses.

Relevant tasks l "How to Set Performance Center License Keys" on the previous page

See also " HP ALM Performance Center Licenses Overview" on page 183

PC License Summary Area
Displays summary information for all valid Performance Center licenses.

User interface elements are described below:

UI Elements Description

Total Vusers TotalVusersof all licenses.

Total Concurrent Runs The total number of Vusers that can run simultaneously.

License Expires On Indicates the expiration date of the next license that is due to expire.

VUDs License Summary Area
Displays summary information for all VUD-based licenses.

User interface elements are described below:

UI Elements Description

Total Purchased VUDs Total number of purchased VUDs.

Total Remaining VUDs Total number of remaining VUDs.

Unassigned to Projects Total number of unassigned VUDs.

Host License Summary Area
Displays protocol bundles and capacity information for all host licenses.
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All Licenses Area
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Enablesyou to install a single license keyat a time.

Click to open the AddNew License dialog boxand type the new license key.

Note: You can onlyadd a license if you have the required permissions.

Opens the Add Licenses for File dialog boxenabling you to installmultiple license keys
simultaneously. For user interface details, see "Add Licenses from File Dialog Box"
on the next page.

Click to displayall licensesor to hide expired licenses.

Click to open the LicensesDetails dialog boxwhich displays the following information:

l Date Assigned.The date the licensewasadded to the system.
l License Key.The license key.
l Type.The license type.
To export details to an Excel file, clickExport to Excel.

Note: You can only view license details if you have the required permissions.

License Type The type of license available for the license keyyou selected. Values include:PC,PC_
VUDS, andHost. For more details, see " HP ALM Performance Center Licenses
Overview" on page 183.

Expiration Mode l Permanent
l Time Limited.The license is limited byan expiration date.
l Temporary.ATime Limited license that is granted for a predefined number of days

after product installation.

Expiration Date (GMT) The expiration date and time of the license.

Host l License Bundle. Indicates the name of the Vuser protocol bundle to
which the license applies. The license enables theController to run Vusersof any
protocol that is included in the protocol bundle.

l Capacity. Indicates themaximumnumber of Vusers that can be run simultaneously
from the LoadRunner Controller.

PC l Vusers.The number of Vusers.
l Concurrent Runs.Themaximumnumber of test runs that can run simultaneously.
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Add Licenses from File Dialog Box
This dialog box enables you to install multiple Performance Center license keys simultaneously.

To access On the LabManagement sidebar, under Performance Center, selectPC Licenses. Click

.

Important You can onlyadd a license if you have the required permissions.

Relevant
tasks

l "How to Set Performance Center License Keys" on page 184

See also " HP ALM Performance Center Licenses Overview" on page 183

User interface elements are described below:

UI Elements Description

License File ClickSelect and then select the license file.

Show/Hide
Expired or
Installed Licenses

Click to displayall licenses, or to hide expired licensesand installed licenses.

# Indicatesa sequential ID number.

License Type The type of license available for the license keyyou selected. Values include:PC,PC_VUDS, and
Host. For more details, see " HP ALM Performance Center Licenses Overview" on
page 183.

Expiration Mode l Permanent
l Time Limited.The license is limited byan expiration date.
l Temporary.ATime Limited license that is granted for a predefined number of daysafter

product installation.

Expiration Date Indicates the GMT date and time the license expires.

Host l License Bundle. Indicates the name of the Vuser protocol bundle to which the
license applies. The license enables theController to run Vusersof anyprotocol that is included in
the protocol bundle.

l Capacity. Indicates themaximumnumber of Vusers that can be run simultaneously from the
LoadRunner Controller.

PC l Vusers.The number of Vusers.
l Concurrent Runs. The maximum number of test runs that can run simultaneously.

Add Installs the selected licenses.
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Chapter 11: MI Listeners
This chapter includes:

• MI Listeners Overview 189
• How toManageMI Listeners 189
• MI Listeners Module 190
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MI Listeners Overview
MI Listeners serve as routers between the Controller and a Performance Agent. They enable you to run
Vusers over a firewall and to collect server monitor data and application diagnostics data over a
firewall.

TheMI Listener receives data from the Performance Agent at regular intervals. During the course of the
test run, the Controller takes the data from theMI Listener to process as runtime data.

TheMI Listeners are only available for load generators.

For detailed information about configuring LabManagement to work with firewalls, refer to the section
about working with firewalls in theHP ALM Performance Center Installation Guide.

For task information about managingMI Listeners, see "How toManageMI Listeners" below.

How to Manage MI Listeners
This section describes how tomanage theMI Listeners which enable you to run performance tests on
hosts over a firewall.

Note: Product Feature Movie. To view amovie that demonstrates how to set up the lab
resources required for running a performance test, select Help > Movies in the ALMmain window.

This task describes how to:

l "Add anMI Listener" below
l "Modify/View host location details" below
l "Assign anMI Listener to a host" below

Add an MI Listener
To add anMI Listener:

1. Go toPerformance Center > MI Listeners.

2. Click theNew MI Listener button . For user interface information, see " New MI Listener
Dialog Box" on page 193.

Modify/View host location details
InPerformance Center > MI Listeners, select anMI Listener in the grid and click theMI Listener

details button .

For user interface details, see "MI Listener Details Dialog Box" on page 194.

Assign an MI Listener to a host
To assign anMI Listener to a host:
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1. Go to Lab Resources > Hosts.
2. Select a host in the grid which is located over a firewall, and click the Testing Host Details button

.
3. In the Testing Host Dialog Box, select your MI Listener in thePC MI Listener field.

For user interface information, see "Testing Host Details Dialog Box" on page 120.

MI Listeners Module
• MI Listeners ModuleWindow 191
• MI Listener Fields 191
• MI Listeners ModuleMenus and Buttons 192
• New MI Listener Dialog Box 193
• MI Listener Details Dialog Box 194
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MI Listeners Module Window
This module enables you to view andmanageMI Listeners. MI Listeners enable running performance
tests on hosts over a firewall and collecting server monitor data and application diagnostics data over a
firewall.

To access On the LabManagement sidebar, under Performance Center, selectMI Listeners.

Important
information

l For detailed information about configuring ALM toworkwith firewalls, see the section about working
with firewalls in theHP ALM Performance Center Installation Guide.

l If anMI Listener is being used bya host, it cannot be deleted.

Relevant
tasks

"How to Manage MI Listeners" on page 189

See also l "MI Listeners Overview" on page 189
l "Lab Resources Overview" on page 95

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

<MI Listeners module
common UI elements>

l MI Listeners module fields. For field definitions, see "MI Listener Fields"
below.

l MI Listeners module menus and buttons.For command and button
descriptions, see "Lab Resources Module Menus and Buttons" on page 109.

<MI Listeners grid> Displaysa list of theMI Listeners in ALM.

Description tab Describes the currently selectedMI Listener.

Tip: Right-clicking in this area displaysa toolbar for formatting and spell checking the
text.

History tab Lists changesmade to the currently selectedMI Listener. For more details, see theHP
Application Lifecycle Management User Guide.

MI Listener Fields
This section describes theMI Listener fields:

Field Description

Description Adescription of theMI Listener.

MI Listener
ID

The ID of theMI Listener.

Public IP The public IP addressof theMI Listener.

Note: If you have two different IP addresses for the sameMI Listener—one for internal
communication with the Controller and a second for public communication with a Load generator
located over a firewall—enter thepublic IP address here. Enter the internal IP address in theMI
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Field Description

Listener Name field (see below).

MI Listener
Name

The name of theMI Listener.

Note: If you have two different IP addresses for the sameMI Listener—one for internal
communication with the Controller and a second for public communication with a Load generator
located over a firewall—enter the internal IP address here. Enter the public IP address in the
Public IP field (see above).

Purpose The role designated to theMI Listener:

l Diagnosticsdata collection over a firewall

l Monitoring over a firewall

l Running hostsover a firewall

MI Listeners Module Menus and Buttons
TheMI Listeners module enables you tomanage your MI Listeners.

Relevant tasks "How to Manage MI Listeners" on page 189

Commonmenus and toolbars of theMI Listeners module are described below:

UI Elements
(A - Z)

Where Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User Guide.

Delete Edit and
<right-click
menu>

Deletes theMI Listener selected in the grid.

Note: You cannot delete anMI Listener that is being used bya host.

MI Listener
Details

Toolbar
and right-
clickmenu

Opens theMI Listener Details dialog box, enabling you to view and edit details of the
selected resource.

Export Toolbar
and <right-
clickmenu>

Opens theExport All Grid Data or Export Selected Grid Data dialog boxes,
enabling you to export theMI Listeners in the grid asa text file, Microsoft Excelworksheet,
MicrosoftWord document, or HTML document.

Select one of the following options:

l All.Exports all resources in the grid.
l Selected.Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for a resource in themodule. For details
about search options, see theHP Application Lifecycle Management User Guide.

Go to
<Resource>

Toolbar Opens theGo To MI Listener dialog box, enabling you to find a specificMI Listener by its
ID number. You can onlygo toMI Listeners that are in the current filter.
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UI Elements
(A - Z)

Where Description

Grid Filters View and
<right-click
menu>

Enables you to filter the data according to an entry in the filter box. For details about filtering
options, see theHP Application Lifecycle Management User Guide.

Information
Panel

View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

NewMI
Listener

Toolbar Enables you to add anMI Listener .

Organize
Favorites

Favorites Organizesyour favorite views. For details, see theHP Application Lifecycle
Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-click
menu>

In the grid, opens theReplace dialog box, enabling you to replace a field value in the grid. For
more details, see theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in the
grid and their order. For details, see theHP Application Lifecycle Management User
Guide.

Set
Filter/Sort

View Enables you to filter and sort theMI Listeners in the grid. Anycurrently applied filtersor
sorting ordersare displayed below the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Update
Selected

Edit and
<right-click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for amultiple
selection in the grid. For more details, see theHP Application Lifecycle Management
User Guide.

NewMI Listener Dialog Box
This dialog box enables you to add anMI Listener to ALM.

To access 1. On the LabManagement sidebar, under Performance Center, selectMI Listeners.

2. In theMI Listenersmodule, click theNewMI Listener button.

Important
information

MI Listenersenable running Vusersover a firewall and collecting server monitor data and application
diagnosticsdata over a firewall.
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Relevant tasks "How to Manage MI Listeners" on page 189

See also l "MI Listeners Overview" on page 189
l "Lab Resources Overview" on page 95

User interface elements are described below:

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

MI Listener
Name

The name for the newMI Listener.

Details Required fieldsaremarkedwith an asterisk (*) and are displayed in red. For details on the available
MI Listener fields, see "MI Listener Fields" on page 191.

MI Listener Details Dialog Box
This dialog box displays details about the selectedMI Listener.

To access 1. On the LabManagement sidebar, under Performance Center, selectMI Listeners.
2. Right-clickanMI Listener in the grid and selectMI Listener Details.

Important
information

MI Listenersenable running testson hostsover a firewall and collecting server monitor data and
application diagnosticsdata over a firewall.

Relevant tasks "How to Manage Testing Hosts" on page 97

See also l "MI Listeners Overview" on page 189
l "Lab Resources Overview" on page 95

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of MI Listeners.
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UI Elements Description

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

MI Listener ID The ID of theMI Listener.

MI Listener Name The name of theMI Listener.

Details Details the currently selectedMI Listener. For details on the available fields, see "MI Listener
Fields" on page 191.

History Lists changesmade to the currently selectedMI Listener. For more details, see theHP
Application Lifecycle Management User Guide.
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J2EE/.NET Diagnostics Overview
The HP Diagnostics integration with HP Application Lifecycle Management (ALM) allows you to
monitor and analyze the performance of Java 2 Enterprise Edition (J2EE), .NET-connected, SAP,
Oracle, and other complex environments.

During a performance test, you can drill down into HP Diagnostics data for the whole test or for a
particular transaction. After the test, you can use HP LoadRunner Analysis to analyze offline
diagnostics data generated during the test.

Monitoring Server Requests
When configuring a performance test to use J2EE/.NET Diagnostics, you can instruct ALM to capture
a percentage of server requests which occur outside the context of any Vuser transaction.

The benefit of enabling this functionality is that calls into a back-end VM can be captured even in the
case where:

l The probe is not capturing RMI calls
l RMI calls cannot be captured (perhaps because an unsupported application container is being used)
l The application uses some other mechanism for communications betweenmultiple VMs

Formore information about working with diagnostics for J2EE and .NET, see theHP Diagnostics User
Guide.

ERP/CRM Diagnostics Overview
The following sections provide an overview of ERP/CRM diagnostics.

Understanding ERP/CRM Diagnostics
During a performance test, the ALM diagnostics modules trace, time, and troubleshoot individual
transactions across theWeb, application, and database servers. You can drill down from a slow end-
user transaction all the way to the bottleneckedmethod or SQL statement. The ALM Performance
Center diagnostics modules enable organizations to:

l Rapidly isolate application components that have a significant impact on end-user experience.
l Provide developers with precise data on how tomake performance improvements.

ERP/CRM Diagnostics Modules Architecture
ERP/CRMDiagnostics architecture, as shown in the diagram below, is comprised of the following
components:
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l Mediator. The ERP/CRMMediator ("Mediator") gathers and correlates offline transaction data from
theWeb, database, and application servers. For information on installing theMediator, see theHP
LoadRunner Installation Guide.

l Controller. Before test execution, the Controller transfers all server information to theMediator and
distributes the percentage of users that will participate in themonitoring. After test execution, the
Controller collects the aggregated transaction data files from theMediators and collates the results.
Results are transferred to the Siebel diagnostics, SAP diagnostics, or Oracle DB results directory.

l Load Generators.When you execute a load test, the Controller distributes each Vuser to a load
generator, and the load generator executes the Vuser script.

l Analysis. Displays detailed diagnostics graphs and reports. For more information about the
diagnostics graphs, see theHP LoadRunner Analysis User Guide.

Connecting the Mediator to a Remote Server
When you set up the ERP/CRMDiagnostics modules, you define a server to monitor by entering the
user name of the server where trace/log files are stored. This section explains how theMediator
connects to the server when it is a remoteWindows or UNIX server.

l Whenmonitoring a remoteWindows server, theMediator attempts to connect to the server using the
configuration details which you enter in the <diagnostics type> Server Configuration Dialog Box
during the diagnostics configuration process. This configuration should give administrator
permissions to the remotemachine.

l Whenmonitoring a remote Linux, theMediator supports the remote shell connection type. For more
information on remote shell connections, see the section that describes verifying the Linux load
generator installation in theHP LoadRunner Installation Guide.

Siebel and Siebel DB Diagnostics Overview
Siebel Diagnostics are split into the followingmodules:

l Siebel Diagnostics Module. Enables you to break down Siebel transactions into layers, areas,
sub-areas, servers, and scripts. You can also view the transaction chain of calls and call stack
statistics to track the percentage of time spent on each part of the transaction. Siebel-Web Vusers
support Siebel Diagnostics.
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l Siebel DB Diagnostics Module. Helps you rapidly identify and resolve database performance
problems. You can view the SQLs for each transaction, identify the problematic SQL queries of each
script, and identify at which point problems occurred. Siebel-Web Vusers support Siebel DB
Diagnostics.
For information on how to pre-configure the Siebel/Siebel DB Diagnostics modules, see "How to Pre-
Configure Siebel/Siebel DB Diagnostics" on the next page.

Oracle 11i Diagnostics Overview
Oracle 11i Diagnostics helps pinpoint performance problems onOracle NCA systems. The diagnostics
information drills down from the transaction to the SQL statements, and to the SQL stages of each
statement. Oracle NCA Vusers support Oracle 11i Diagnostics.

For information on how to pre-configure the Oracle 11i Diagnostics module, see "How to Pre-Configure
Oracle 11i Diagnostics" on page 203.

SAP Diagnostics Overview
SAP Diagnostics enables you to pinpoint the root cause of a certain problem (for example, DBA,
Network, WAS, Application, OS/HW) quickly and easily, and engage with the relevant expert only,
without having to present the problem to a whole team of people.

For information on how to configure the SAP Diagnostics module, see "How to Pre-Configure SAP
Diagnostics" on page 204.

Server-side Data Collection. SAP Diagnostics is based on SAP Distributed Statistical Records
(DSR). For each dialog step performed on application server, a statistical record is generated, which
includes information such as response time components, database statistics, RFC times, and so on.
The Diagnostics Mediator is responsible for collecting diagnostics data from the server during a
performance test.

Vuser Coloring. SAP Diagnostics allows replaying the SAPGUI protocol. You set the percentage of
colored Vusers in the Configuration dialog (up to 100% allowed). Coloring of SAPGUI users creates no
overhead on the Application server.

How to Add ERP/CRMMediators
This task describes how to add diagnostics servers andmediators in order to work with J2EE/.NET
and ERP/CRM diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

1. Prerequisite
Make sure that themediator is installed in the same LAN as themonitored server. For information
on installing the ERP/CRMMediator, see theHP LoadRunner Installation Guide.

2. Add and configure the mediator
a. On the LabManagement sidebar, underPerformance Center, select Diagnostics.
b. Select theERP/CRM Diagnostics tab.
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c. Click theNew Diagnostics Mediator button , and enter the required information. For
user interface details, see "Diagnostics Module Fields" on page 208.

How to Add HP Diagnostics Servers
This task describes how to add an HP Diagnostics server to allow you tomonitor and analyze
J2EE/.NET environments.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

1. On the LabManagement sidebar, underPerformance Center, select Diagnostics.
2. Select the J2EE/.NET Diagnostics tab.
3. Click theNew Diagnostics Server button, and enter the required information. For user interface

details, see "Diagnostics Module Fields" on page 208.
4. Under Lab Settings, select Project Settings. Right-click the relevant project and select Project

Settings Details. Add the relevant server information in theDiagnostics Server field.

Note: To ensure that diagnostics data is available online, make sure that the time on the
diagnostics server is synchronized with its probes.

How to Pre-Configure Siebel/Siebel DB
Diagnostics
This task describes the pre-configuration steps to be performed by the ALM administrator which allow
the performance tester to enable and run Siebel diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

This task includes the following steps:

l "Prerequisite" below
l "If connecting to a UNIX server with a remote shell (RSH/RCP) connection" below
l "Configure the server machine to enable diagnostics" on the next page
l "Copy files from the Siebel Application Server to theMediator" on page 202
l "Synchronize clocks" on page 202
l "(Siebel DB) Enable logging on the Siebel Server" on page 203

1. Prerequisite
Make sure that the ERP/CRMmediator is installed and configured. For more information, see
"How to Add ERP/CRMMediators" on the previous page.

2. If connecting to a UNIX server with a remote shell (RSH/RCP) connection
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l Verify that the RSH and RCP daemons are running on the UNIX server.
l Verify that the UNIX user has permission to run remote shell commands. To check this, type
the following at the DOS command prompt:

rsh <server machine name> -l <UNIX user login name> -n <command>

Example:

rsh my_unix -l my_name -n "cd ~;pwd"

Note: You can use only RSH commands that work from the DOS command prompt
window.

l Verify that no output is generated after executing the RSH command.

Note: You should not generate output from the .login, .profile, and .cshrc files (for
example, by echo, or in any other way, including commands that generate output
indirectly, such as biff). Where an existing user generates output in the RSH step that
cannot be deleted, you should create a new user that does not generate output, and who
has permissions to run RSH and RCP commands on the server machine.

3. Configure the server machine to enable diagnostics
To configure Siebel application andWeb servers for diagnostics data collection:
a. Enable Siebel Diagnostics on all Siebel application and Web servers involved in the

test.
Set the environment variable on the Siebel server to:

SIEBEL_SarmEnabled=true

Then restart the server.
b. Optimize the server performance settings.

You change themaximummemory caching and file size using the following variables:

SIEBEL_SarmMaxMemory= <bytes>SIEBEL_SarmMaxFileSize = <bytes>

TheSIEBEL_SarmMaxMemory value controls the size of the buffer that Siebel keeps in the
memory before writing the information to the Siebel log files. You can improve server
performance by increasing the parameter value. However, information from the end of the run
will bemissing from the Analysis graphs.
We recommend the following settings:
o SIEBEL_SarmMaxMemory

Value Number of Vusers

5000 Less than 20 (low loads)

1000000 More than 100 (high loads)

o SIEBEL_SarmMaxFileSize
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Value Number of Vusers

5000000 Less than 20 (low loads)

25000000 More than 100 (high loads)

If more than one Siebel log file is generated on the server every 10 seconds, you should
increase theSIEBEL_SarmMaxFileSize.

c. Generate a list of Siebel Server IDs.
On the Siebel server, open a commandwindow and run the following command:

<Siebel bin directory>\srvrmgr /u <username> /p <password> /g <gateway
server> /e <entrpr server> /c "list servers show SBLSRVR_NAME, SV_SRVRID"

where:
/u <username> is the server administrator username.
/p <password> is the server administrator password.
/g <gateway server> is the gateway server address.
/e <entrpr server> is the enterprise server name.
/c <command> is the execute a single command.
This command generates a list of all the Siebel application servers and their IDs. Keep a
record of the server IDs, since this information is required in the Siebel Server Configuration
dialog box.

4. Copy files from the Siebel Application Server to the Mediator
After configuring the application server, copy the files listed below from the Siebel Application
server \bin directory to either the <Mediator Root>\bin directory, <Windows>\System32
directory, or any other directory in PATH on theMediator machine:
For Siebel 7.53, copy the following files:

l sarmanalyzer.exe

l sslcver.dll

l sslcsym.dll

l sslcshar.dll

l sslcosa.dll

For Siebel 7.7, copy the following files:

l sarmanalyzer.exe

l libarm.dll

l msvcp70.dll

l msvcr70.dll

l sslcacln.dll

l sslccore.dll

l sslcevt.dll

l sslcos.dll

l sslcosa.dll

l sslcosd.dll

l sslcrsa.dll

l sslcscr.dll

l sslcshar.dll

l sslcsrd.dll

l sslcsym.dll

l sslcver.dll

5. Synchronize clocks
l On Windows Siebel Servers:Ensure that all themachines' clocks in the Siebel system are
synchronized. This ensures that the correlation of SQLs to transactions is correct.
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Synchronize the Siebel Gateway and load generators' clocks by running the following
command from the load generator:

net time \ <Gateway name> /set /y

Replace <Gateway name> with the name of the Siebel Gateway.
l On Unix Siebel Servers:Ensure that all themachines' clocks in the Siebel system are
synchronized. This ensures that the correlation of SQLs to transactions is correct.
You can synchronize the clocks on a UNIX system in one of the following ways:
o Use the date command on the UNIX Siebel Gateway server to change the timemanually,

so it will be synchronized with the LoadGenerator's clock.
o Change the time on the load generator so that it will be synchronized with the UNIX Siebel

Gateway server.
o Configure the time difference in Analysis. For more information, see the chapter about

Siebel DB Diagnostics Graphs in theHP LoadRunner Analysis User Guide.

6. (Siebel DB) Enable logging on the Siebel Server
For task details, see "How to Enable and Disable Logging on the Siebel Server" on the next page.

How to Pre-Configure Oracle 11i Diagnostics
This task describes the pre-configuration steps to be performed by the ALM administrator which allow
the performance tester to enable and runOracle 11i diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

This task includes the following steps:

l "Prerequisite" below
l "Consider this before connecting to a UNIX server with a remote shell (RSH/RCP) connection"
below

l "Enable logging on theOracle server" on the next page
l "Set or disable the Oracle server diagnostics password - optional" on the next page

1. Prerequisite
Make sure that the ERP/CRMmediator is installed and configured. For more information, see
"How to Add ERP/CRMMediators" on page 199.

2. Consider this before connecting to a UNIX server with a remote shell
(RSH/RCP) connection
l Verify that the RSH and RCP daemons are running on the UNIX server.
l Verify that the UNIX user has permission to run remote shell commands. To check this, type
the following at the DOS command prompt:

rsh <server machine name> -l <UNIX user login name> -n <command>
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Example:

rsh my_unix -l my_name -n "cd ~;pwd"

Note: You can only use RSH commands that work from the DOS command prompt
window.

l Verify that no output is generated after executing the RSH command.

Note: You should not generate output from the .login, .profile, and .cshrc files (for
example, by echo, or in any other way, including commands that generate output
indirectly, such as biff). Where an existing user generates output in the RSH step that
cannot be deleted, you should create a new user that does not generate output, and who
has permissions to run RSH and RCP commands on the server machine.

3. Enable logging on the Oracle server
For task details, see "How to Enable Logging on theOracle Server" on page 206.

4. Set or disable the Oracle server diagnostics password - optional
To help ALM deal with the Oracle server diagnostics password, you can either set the password in
the Vuser script, or you can disable the password request on the server itself. For task details, see
"How to Set and Disable the Oracle Server Diagnostics Password" on page 207.

How to Pre-Configure SAP Diagnostics
This task describes the pre-configuration steps to be performed by the ALM administrator that allows
the performance tester to enable and run SAP diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

Install the ERP/CRMMediator
Make sure that the ERP/CRMmediator is installed and configured. For more information, see "How to
Add ERP/CRMMediators" on page 199.

Note:When using SAP Diagnostics, ensure that a SAPGUI client is installed on the same
machine as the ERP/CRMMediator.

How to Enable and Disable Logging on the
Siebel Server
This task describes how to enable and disable logging on the Siebel server.

Note:
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l This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

l Enabling logging on the Siebel server can negatively impact server performance. We
recommend that you disable logging and restore the default logging settings at the conclusion of
the performance test.

To enable logging on the Siebel server
Perform the following steps:

1. Open a commandwindow and run the following command:

<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel server> /e
<enterprise server name> /u <username> /p <password>

where:
/u <username> is the server administrator username.
/p <password> is the server administrator password.
/g <gateway server> is the gateway server address.
/e <entrpr server> is the enterprise server name.
/s <siebel server > is the siebel server (the default server).

2. Enter the following commands:

change evtloglvl ObjMgrsqllog=4 for comp <component name>

evtloglvl EventContext=3 for comp <component name>

evtloglvl ObjMgrSessionInfo =3 for comp <component name>

Example:

For the Call Center component, enter sccobjmgr_enu as the component name, as follows:

change evtloglvl ObjMgrsqllog=4 for comp sccobjmgr_enu

To disable logging on the Siebel server
Perform the following steps:

1. Open a commandwindow and run the following command:

<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel server> /e
<enterprise server name> /u <username> /p <password>

where:
/u <username> is the server administrator username.
/p <password> is the server administrator password.
/g <gateway server> is the gateway server address.
/e <entrpr server> is the enterprise server name.
/s <siebel server> is the siebel server name (the default server).
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2. Enter the following commands:

change evtloglvl ObjMgrsqllog=0 for comp <component name>

change evtloglvl EventContext=0 for comp <component name>

change evtloglvl ObjMgrSessionInfo =0 for comp <component name>

How to Enable Logging on the Oracle Server
This task describes how to enable logging on theOracle server.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

This task includes the following steps:

l "Verify that the trace diagnostics are enabled" below
l "Set the trace file size to unlimited" below

1. Verify that the trace diagnostics are enabled
Perform the following steps:
a. Log on to the Oracle application server with administrator privileges, and select the desired

module in the Oracle application. The Responsibilities dialog box opens.
b. Select System Administrator and click OK.
c. In the Functions tab, select Profile > System and click Open. The System Profile Values

dialog box opens.
d. In theDisplay section, select Site andProfiles with No Values, enter %Diagnostics% in the

Profiles field, and then click Find.
e. If any diagnostics profiles are disabled (denoted by a "Yes" in theSite column), change the

setting to "No".
f. Save your settings.

2. Set the trace file size to unlimited
For Oracle 9i:
On theOracle server, run the following command in the SQL editor:

Alter system set max_dump_file_size=UNLIMITED scope=both;

For Oracle 8i:
a. On theOracle server, run the following command in the SQL editor:

Alter system set max_dump_file_size=2048000;

b. Edit the init*.ora file on $ORACLE_HOME\admin\<sid>\pfile\init<sid>.ora. Find the line of
the parameter, change its value, and then save the file.
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Note: Verify that you have enough disk space on the database server since these trace
files can be very large.

How to Set and Disable the Oracle Server
Diagnostics Password
To help ALM deal with the Oracle server diagnostics password, you can either set the password in the
Vuser script, or you can disable the password request on the server itself.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

l "Set the diagnostics password in the Vuser script" below
l "Disable the diagnostics password request on the Oracle server" below

Set the diagnostics password in the Vuser script
In VuGen, add the nca_set_diagnostics_password(<password>) function to your script and select a
password.

Note: The nca_set_diagnostics_password functionmust come after the nca_connect_server
function.

Disable the diagnostics password request on the Oracle server
Perform the following steps:

1. Log on to the Oracle server with administrator privileges, and select the desiredmodule in the
Oracle application. The Responsibilities dialog box opens.

2. Select System Administrator and click OK.
3. In the Functions tab, select Profile > System and click Open. The System Profile Values dialog

box opens.
4. In theDisplay section, select User, and enter the required user name. In theProfile field, enter

%Utilities:Diagnostics% and click Find. The Utilities:Diagnostics profile values are
displayed.

5. In theUser column of the Utilities:Diagnostics profile, set the value toYes.
6. Save your settings.

Diagnostics User Interface
This section includes:

• Diagnostics ModuleWindow 208
• Diagnostics Module Fields 208
• Diagnostics ModuleMenus and Buttons 209
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Diagnostics Module Window
The Diagnostics ModuleWindow enables you to add andmanage ERP/CRMmediators and
J2EE/.NET servers.

To access On the LabManagement sidebar, under Performance Center, selectDiagnostics.

Relevant tasks l "How to Add ERP/CRM Mediators" on page 199
l "How to Add HP Diagnostics Servers" on page 200

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<ALM common areas> For details on the ALM common areas, see theHP Application Lifecycle Management
User Guide.

<Diagnostics module
fields>

For details on the fields that are available in the Diagnosticsmodule, see "Diagnostics
Module Fields" below.

<Diagnostics module
menus and buttons>

For details on the icons that are available in the Diagnosticsmodule, see "Diagnostics
Module Menus and Buttons" on the next page.

ERP/CRM Diagnostics
tab

Enablesyou to add andmanage ERP/CRMDiagnosticsmediators.

J2EE/.NET Diagnostics
tab

Enablesyou to add andmanage J2EE/.NET Diagnostics servers.

History tab Displaysa historyof the changesmade to the selected server/mediator, including the date
and time of the change and the name of the user whomade the change.

For details, see theHP Application Lifecycle Management User Guide.

Diagnostics Module Fields
This section describes the Diagnostics module fields.

Field Description

Description Adescription of themediator/server.

Enable SSL SelectEnable if ALM is communicating with Diagnostics through SSL.

Logical
Name

The logical name given to themediator/server.

Machine
Name / IP

The name or IP addressof themediator/server.

Over
Firewall

Denotes if monitoring over a firewall is enabled or not. SelectY for enabled andN for not enabled.

Note: Available for ERP/CRMdiagnostice only.

Password Enter the password you use to log on to HPDiagnostics.
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Field Description

Default:Admin

Note: Available for J2EE/.NET diagnosticsonly.

Port Enter the port number used by the diagnostics server.

Default: 2006

Note: Available for J2EE/.NET diagnosticsonly.

Type TheERP/CRMmediator type.

Note: Available for ERP/CRMdiagnosticsonly.

Username Enter the user namewith which you log on to HPDiagnostics.

Note: The user name that you specify should haveview, change, andexecute privileges. For
more information about user privileges, see theHP Diagnostics Installation and Configuration
Guide.

Diagnostics Module Menus and Buttons
This section describes themenus and buttons in the Diagnostics module.

UI Elements (A -
 Z)

Menu Description

Edit and <right-
clickmenu>

Deletes the selected server/mediator from the grid.

Check
Server/Mediator

Diagnostics
Server/Mediator
and <right-click
menu>

Click to check if the server/mediator is up and running.

Copy URL
Diagnostics
Server/Mediator

Copiesa selected server/mediator and pastes itsURL asa link. The
server/mediator itself is not copied. Instead, you can paste the address into another
location, such asan email or a document. Clicking the linkopensup ALMand takes
you to the server/mediator. If you are not already logged in, ALM first prompts for
login details.

Diagnostics
Server/Mediator

Details

Diagnostics
Server/Mediator
and <right-click
menu>

Click to view server/mediator details.

Export Diagnostics
Server/Mediator
and <right-click
menu>

Opens the Export Grid Data dialog box, enabling you to export the
servers/mediators in the grid asa text file, Microsoft Excelworksheet, Microsoft
Word document, or HTML document.

Choose one of the following options:

l All.Exports all servers/mediators in the grid.
l Selected.Exports selected servers/mediators in the grid.
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UI Elements (A -
 Z)

Menu Description

Find
View Opens the Find dialog box, enabling you to search for field details in themodule. For

details, see theHP Application Lifecycle Management User Guide.

Go to
Diagnostics
Server/Mediator

Diagnostics
Server/Mediator

Opensa dialog boxwhich prompts you for the server/mediator ID. ClickOK to open
the server/mediator detailswindow.

Grid Filters View and <right-
clickmenu>

Enables you filter the data according to an entry in the filter box. For details about
filtering options, see theHP Application Lifecycle Management User
Guide.

Information
Panel

View and <right-
clickmenu>

Shows/Hides the Information Panel in the lower area of themodule.

New
Diagnostics
Server/Mediator

Diagnostics
Server/Mediator

Click to add a new ERP/CRMmediator or J2EE/.NET server. For information on
the relevant fields, see "Diagnostics Module Fields" on page 208.

Refresh All
View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and <right-
clickmenu>

In the grid, opens theReplace dialog box, enabling you to replace a field value in the
grid. For more details, see theHP Application Lifecycle Management User
Guide.

Select Columns View Opens the Select Columnsdialog box, enabling you to determinewhich fields to
display in the grid and their order. For more details, see theHP Application
Lifecycle Management User Guide.

For details about the Diagnostics fields, see "Diagnostics Module Fields" on
page 208.

Set Filter/Sort View Enables you to filter and sort the resources in the grid. Anycurrently applied filters
or sorting ordersare displayed below the toolbar. For more details, see theHP
Application Lifecycle Management User Guide.

Update
Selected

Edit and <right-
clickmenu>

Opens theUpdate Selected dialog box, enabling you to update a field value for a
multiple selection in the grid. For more details, see theHP Application Lifecycle
Management User Guide.
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Chapter 13: Patch Management
This chapter includes:

• Patches Overview 212
• How to Upload Patches to ALM 212
• PatchManagement User Interface 212
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Patches Overview
The Patches module enables you to upload a Performance Center patch to LabManagement and to
then install the patch on the appropriate host or server.

How to Upload Patches to ALM
This task describes how to upload patches to ALM.

Note: This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 14.

To upload a patch:

1. On the LabManagement sidebar, underPerformance Center, select Patches.

2. Click theNew Patch button . The Select Patch dialog box opens, enabling you to select a
patch (.msp/.msi) to upload.

3. Click Open. The New Patch dialog box opens.
4. Enter the details for the new patch and click OK. The patch is added to the system and appears in

the Patches grid.

Patch Management User Interface
This section includes:

• Patches ModuleWindow 213
• Patches Module Fields 213
• Patches ModuleMenus and Buttons 213
• Patch Details Dialog Box 215
• New Patch Dialog Box 216
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Patches Module Window
This module enables you to view and upload patches.

To access On the LabManagement sidebar, under Performance Center, selectPatches.

Relevant tasks "How to Upload Patches to ALM" on the previous page

See also l "How to Manage Testing Hosts" on page 97
l "How to Manage Performance Center Servers" on page 236

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

<Information panel> Located in the lower area of themodule. Displaysa description about the patch selected in the
grid.

<Patches grid> Displaysa list of the patches that have been uploaded to ALMPerformanceCenter.

<Patches module
common UI elements>

l Patches module fields. For field definitions, see "Patches Module Fields" below.
l Patches module menus and buttons.For command and button descriptions, see
"Patches Module Menus and Buttons" below.

l ALM main menu and sidebar.For details on theToolsmenu,Helpmenu and
sidebar, see theHP Application Lifecycle Management User Guide.

Patches Module Fields
This section describes the Patches module fields:

Field Description

Description Displaysa description of the selected patch.

ID The patch ID.

Name The patch name.

Path The patch path.

Patches Module Menus and Buttons
This section describes themenus and buttons available in the Patches module.

To access On the LabManagement sidebar, under Performance Center, selectPatches.
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User interface elements are described below:

UI
Elements
(A - Z)

Where Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User Guide.

Copy URL Patches
and
<right-
click
menu>

Copiesa selected patch and pastes itsURL asa link. The patch itself is not copied. Instead, you
can paste the address into another location, such asan email or a document. Clicking the link
opensup ALMand takesyou to the patch file or folder. If you are not already logged in, ALM first
prompts for login details.

Export Patches
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the patches in the grid asa text
file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Choose one of the following options:

l All.Exports all project settings in the grid.
l Selected.Exports selected project settings in the grid.

Find View Opens the Find dialog box, enabling you to search for patches in themodule. For details about
search options, see theHP Application Lifecycle Management User Guide.

Go to
Patch

Patches Opens theGo ToPatch dialog box, enabling you to find a specific patch by its ID number. You can
onlygo to patches that are in the current filter.

Grid Filters View and
<right-
click
menu>

Enables you filter the data according to an entry in the filter box. For details about filtering
options, see theHP Application Lifecycle Management User Guide.

Information
Panel

View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

New Patch Patches Opens the Select Patch dialog box, which enables you to select a patch to upload.

Organize
Favorites

Favorites Opens theOrganize Favoritesdialog box, enabling you to organize the list of favorite viewsby
changing propertiesor deleting views. For details, see theHP Application Lifecycle
Management User Guide.

Patch
Details

Patches
and
<right-
click
menu>

Opens the Patch Details dialog box, enabling you to view and edit details of the selected patch.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.
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UI
Elements
(A - Z)

Where Description

Replace Edit and
<right-
click
menu>

In the Project Details grid, opens theReplace dialog box, enabling you to replace a field value in
the grid. For more details, see theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in the
grid and their order. For more details, see theHP Application Lifecycle Management
User Guide.

For details about the patches fields, see "Patches Module Fields" on page 213.

Set
Filter/Sort

View Enables you to filter and sort the patches in the grid. Anycurrently applied filtersor sorting orders
are displayed below the toolbar. For more details, see theHP Application Lifecycle
Management User Guide.

Update
Selected

Edit and
<right-
click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for amultiple
selection in the grid. For more details, see theHP Application Lifecycle Management
User Guide.

Patch Details Dialog Box
This dialog box enables you to view details of a patch in LabManagement.

To access On the LabManagement sidebar, under Performance Center, selectPatches.

Relevant tasks "How to Upload Patches to ALM" on page 212

See also l "How to Manage Testing Hosts" on page 97
l "How to Manage Performance Center Servers" on page 236

User interface elements are described below:

UI Elements (A - Z) Description

First/Previous/Next/Last Entity. Enablesyou to browse through the list of projects.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Details For field definitions, see "Patches Module Fields" on page 213.
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NewPatch Dialog Box
This dialog box enables you to add new Performance Center patches.

To access 1. On the LabManagement sidebar, under Performance Center, select
Patches.

2. Click theNew Patchbutton . The Select Patch dialog boxopens.

3. Navigate to the location of the patch, and clickOpen.

Relevant tasks "How to Upload Patches to ALM" on page 212

User interface elements are described below:

UI Elements
(A - Z)

Description

Clear All Fields.Clearsall data in the dialog box.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk
"*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Details ListsPatches fields. Required fieldsare displayed in red. For details on the available fields, see "Patches
Module Fields" on page 213.

Tip: Clicking in theDescription field on this page displaysa toolbar for formatting and spell
checking the text.

Name Type a name for the new patch.

Syntax exceptions:Aserver name cannot include the following characters: \ / : " ? < > | * % '
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Chapter 14: AUT Host Management
This chapter includes:

• AUT Resources Overview 218
• How to Import AUT Host Data from Excel 218
• AUT ResourceModules User Interface 221
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AUT Resources Overview
Application Under Test (AUT) components, such as Web/application servers or database servers, are
hosted onmachines known as AUT hosts. The AUT hosts are grouped together intoAUT Pools.

The AUT hosts are a core element of the Topology and SiteScope integration features.

How to Import AUT Host Data from Excel
This task describes how to import a list of AUT hosts from an Excel file (.xls or .csv) into ALM.

This task includes the following steps:

l "Prerequisites" below
l "Import the AUT hosts (only for Performance Center users)" on page 220
l "Results" on page 220

1. Prerequisites
The Excel file must be set up so that the columns can be recognized andmapped by the Import
feature.
l The first row of the Excel file must contain the field names, or corresponding logical names,
that appear in the table below. (Logical names are not case sensitive.)
Some fields aremandatory, others are required or optional.
o Mandatory indicates a field thatmust appear in the Excel file. If you omit this field, the

import fails. If you omit a value in one of the rows of this field's column, the import of that
specific row fails.

o Required indicates a field that should appear in the Excel file. If you omit this field, the
code adds the field with the default value for all rows. If you include the field, but omit a
value in one of the rows of this column, the code adds the default value for that row.

o Optional indicates a field does not have to appear in the Excel file. Omitting this field has
no effect on the import procedure.

l Fields representing virtual, reference, and invalid fields are ignored.
l Empty columns are allowed.
Set up the columns and values in the file as follows:

Field name
Logical
name Value Field for

AUTHOST_
NAME
Required

Logical
Name

Anystring AUT host logical name

Note: If this value isempty, thiswill be given the same
value asAUTHOST_MACHINE_NAME

AUTHOST_
MACHINE_NAME
Mandatory

Machine
Name / IP

Themachine
name/IP

AUT host physicalmachine name

AUTHOST_ Username The user name of
themachine

User name for logging on to the AUT hostmachine
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Field name
Logical
name Value Field for

USERNAME
Mandatory

AUTHOST_
PASSWORD
Mandatory

Password The password of
the user name

Password for logging on to the AUT hostmachine

AUTHOST_OS
Required for UNIX
platformsonly

OSType l SUNOS
(default)

l SunSolaris

l MacOSX

l Linux

l RedHat
Enterprise
Linux

l AIX

l FreeBSD

l HP-UX

l HP/UX

l HP/UX64-bit

l NonStopOS

l OPENSERVE
R

l SCO

l SGI Irix

l Tru64 5.x

l Tru64 pre 4.x
(Digital)

AUT host machine operating system

(For UNIXplatform only)

AUTHOST_
PLATFORM
Required

Platform l Windows
(default)

l UNIX

AUT host platform

AUTHOST_
PROTOCOL
Required

Protocol Windows:

l NetBIOS
(default)

l SSH

l WMI

UNIX:

l rlogin

l Telnet (default)

l SSH

AUT host protocol

AUTHOST_
UNIX_PROMPT    
Required for UNIX

UNIX
Prompt

# (default) UNIX prompt on the AUT hostmachine
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Field name
Logical
name Value Field for

platformsonly

AUTHOST_
DESCRIPTION
Optional

Description Anystring AUT host description

Example:

The following image illustrates an Excel file set up with the following AUT hosts: 1.2.3.4,
5.6.7.8, and a third machine whose namewas not provided.

2. Import the AUT hosts (only for Performance Center users)
a. Open the AUT Hosts module:

o In ALM:On the ALM sidebar, underPerformance Center AUT, select AUT Hosts.
o In Lab Management:On the LabManagement sidebar, underPerformance Center,

select AUT Hosts.
b. Select AUT Hosts > Import.
c. Browse to the Excel file containing the AUT hosts, and click Open.

3. Results
The progress of the import process is displayed. At the end of the process, a report displays the
import results. The imported AUT hosts are listed in the AUT Hosts module. AUT hosts that are
not imported successfully, must be addedmanually.

Example:

The results from importing the Excel file in step 1 above are illustrated in the following image:
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Note:
l No logical namewas provided in the Excel file for machine 1.2.3.4. Therefore, the logical
name given is equivalent to themachine name/IP.

l Machine 1's operating system was specified as SUNOS, whereas the platform was
specified as Windows. These values are inconsistent as SUNOS is relevant only for a
UNIX platform. The value SUNOS was replaced with NT.

l Nomachine namewas specified for the third machine listed in the Excel file. This machine
was not imported. It should be addedmanually.

l Required but non-mandatory values were automatically provided by the system during the
import process.

l Columns representing virtual, reference, non-valid fields were ignored.

AUT Resource Modules User Interface
This section includes:

• AUT Hosts Module 222
• AUT Host Fields 222
• New AUT Host Dialog Box 223
• AUT Host Details Dialog Box 224
• AUT Pools Module 224
• Linked Hosts Page 225
• Add AUT Hosts to Pool Dialog Box 226
• AUT Pools Fields 227
• New AUT Host Pool Dialog Box 227
• AUT Host Pool Details Dialog Box 228
• AUT ResourceModuleMenus and Buttons 229
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AUT Hosts Module
This module enables you to view andmanage AUT hosts.

To access Use one of the following:

l On the LabManagement sidebar, under Performance Center, selectAUT
Hosts.

l On the ALM sidebar, under Performance Center AUT, selectAUT Hosts.

Important information TheAUT Hostmodule is available both in LabManagement and in ALM.

See also "AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<CommonMenus and
Toolbars>

For details on AUT Resourcemodulesmenusand toolbars, see "AUT Resource Module
Menus and Buttons" on page 229.

<AUT Hosts grid> Displaysa list of AUT hostsdefined in ALM.

Description tab Displays themain details and a description about the AUT host.

Tip: Right-click theDescriptionarea for edit and format options.

History tab Lists changesmade to the selected AUT host. For more details, see theHP Application
Lifecycle Management User Guide.

AUT Host Fields
The following table describes the AUT host fields:

Field (A - Z) Description

Belongs to
Pools

The host pools to which the AUT host belongs.

Available from: LabManagement only

Description Adescription of the AUT host.

Logical Name The logical name given to the AUT host.

Machine
Name/IP

The name or IP addressof the AUT hostmachine.

Modified The date onwhich the AUT host detailswere last modified.

OS Type The operating system of the AUT hostmachine.

Password The password for logging in to the AUT hostmachine.

Platform The base operating system of the AUT hostmachine:Window or UNIX.

Protocol The networkprotocol used for communication with the AUT host (for monitoring purposes).

LabManagement Guide
Chapter 14: AUT Host Management

HP ALM LabManagement (12.50) Page 222



Field (A - Z) Description

Default value:NetBIOS,WMI,SSH.

UNIX Prompt The prompt used by the operating system. Also used for communication with the AUT host (for
monitoring purposes).

Available for:UNIXAUT hostsonly.

Username The user name for logging in to the AUT hostmachine.

NewAUT Host Dialog Box
This dialog box enables you to create a new AUT host.

To access Use one of the following:

From Lab Management:

1. On the LabManagement sidebar, under Performance Center, selectAUT Hosts.

2. ClickNew AUT Host .

From ALM:

1. On the ALM sidebar, under Performance Center, selectAUT Hosts.

2. ClickNew AUT Host .

Important
information

When creating an AUT host in ALM, the AUT host is automatically added to the AUT Pool of the project.

Tip: You can import a list of AUT hosts from anExcel file. For details, see "How to Import AUT
Host Data from Excel" on page 218.

See also l "AUT Resources Overview" on page 218
l HP ALM Performance Center Guide

User interface elements are described below:

UI Elements Description

Clear All Fields. Clears the data.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk
"*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Machine The name or IP of the AUT hostmachine.
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UI Elements Description

Name/IP

Details Enablesyou to enter the details of the new AUT host. For more details, see "AUT Host Fields" on
page 222.

AUT Host Details Dialog Box
This dialog box enables you to view andmodify AUT host details.

To access Use one of the following:

l On the LabManagement sidebar, under Performance Center, selectAUT Hosts.
Right-clickan AUT host in the grid and selectAUT Host Details.

l On the ALM sidebar, under Performance Center AUT, selectAUT Hosts. Right-
clickan AUT host in the grid and selectAUT Host Details.

See also "AUT Resources Overview" on page 218

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of AUT hosts.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Machine Name/IP The name or IP of the AUT hostmachine.

Details Displays the details of the selected AUT host. For more details, see "AUT Host Fields" on
page 222.

History Lists changesmade to the selected AUT host. For more details, see theHP Application
Lifecycle Management User Guide.

AUT Pools Module
This module enables you to view andmanage AUT Pools.
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To
access

On the LabManagement sidebar, under Performance Center, selectAUT Pools.

Relevant
tasks

TheAUT Poolsmodule is available only in LabManagement.

See also "AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<CommonMenus and
Toolbars>

For details on AUT Poolsmodulemenusand toolbars, see "AUT Resource Module
Menus and Buttons" on page 229.

<AUT Pools grid> Displays the AUT Poolsdefined in the system.

Description tab Displays themain details and a description about the AUT Pool.

Tip: Right-click theDescriptionarea for edit and format options.

Linked Hosts tab Enablesyou to add AUT hosts to the selected pool and remove hosts from the pool. For
details, see "Linked Hosts Page" below.

History tab Lists changesmade to the selected AUT Pool. For more details, see theHP Application
Lifecycle Management User Guide.

Linked Hosts Page
This page enables you to add AUT hosts to an AUT Pool, and remove AUT hosts from an AUT Pool.

To access l From the AUT Pools module:
On the LabManagement sidebar, under Performance Center, selectAUT Pools. In the
information panel, selectLinked Hosts.

l From the AUT Pool Details dialog box:
On the LabManagement sidebar, under Performance Center, selectAUT Pools. Right-clickan
AUT Pool and selectAUT Pool Details. In the AUT PoolDetails dialog box, selectLinked Hosts.

Note: Available in LabManagement only.

Important
information

The LinkedHostspage enables you to linkmultiple AUT hosts to an AUT Pool.

Alternatively, you can linka single AUT host tomultiple AUT Pools from theBelongs To Pools field in the
AUT host's details. For details, see "AUT Host Fields" on page 222.

See also "AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

AUT Host Details.Opens the AUT Host Details dialog box, enabling you to view details about the selected
linked AUT host. For details, see "AUT Host Fields" on page 222.

LabManagement Guide
Chapter 14: AUT Host Management

HP ALM LabManagement (12.50) Page 225



UI
Elements

Description

Add Hosts to Pool.Opens the Add AUT Hosts to Pool dialog box, enabling you to select AUT hosts to add to
the AUT Pool.

Remove Host.Removes the selected AUT hosts from the AUT Pool.

Go to Host.Displays the selected linked AUT host in the AUT Hostsmodule.

Refresh All.Refreshes the grid so it displays themost up-to-date information.

Set Filter/Sort. Enablesyou to filter and sort the grid. Anycurrently applied filtersor sorting ordersare
displayed below the toolbar. For details, see theHP Application Lifecycle Management User Guide.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in
the grid and their order. For details, see theHP Application Lifecycle Management User Guide.

Find.Opens the Find dialog box, enabling you to search for an AUT host. For details, see theHP Application
Lifecycle Management User Guide.

<Linked
Hosts
grid>

Lists the AUT hosts that belong to the AUT Pool. For details about the host fields, see "AUT Host Fields" on
page 222.

Add AUT Hosts to Pool Dialog Box
This page enables you to select AUT hosts to add to an AUT Pool.

To access l From the AUT Pools module:
On the LabManagement sidebar, under Performance Center selectAUT Pools. In the

information panel, selectLinked Hosts and click theAdd Hosts to Pool button.

l From the AUT Pool Details dialog box:
On the LabManagement sidebar, under Performance Center, selectAUT Pools. Right-clickan
AUT Pool and selectAUT Pool Details. In the AUT PoolDetails dialog box, selectLinked Hosts and

click theAdd Hosts to Pool button.

Note: Available in LabManagement only.

Important
information

Alternatively, you can linka single AUT host tomultiple AUT Pools from theBelongs To Pools field in the
AUT host's details. For details, see "AUT Host Fields" on page 222.

See also "AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh All.Refreshes the grid so it displays themost up-to-date information.
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UI Elements Description

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to display
in the grid and their order. For details, see theHP Application Lifecycle Management User Guide.

Set Filter/Sort. Enablesyou to filter and sort the grid. Anycurrently applied filtersor sorting ordersare
displayed below the toolbar. For details, see theHP Application Lifecycle Management User
Guide.

Adds the selected AUT hosts to the AUT Pool.

<AUT Hosts
grid>

Lists the AUT hostsavailable to add to the AUT Pool.

Selected Displays the AUT hosts selected to add to the pool.

AUT Pools Fields
The following fields are available for AUT Pools:

Field Description

Description Adescription of the AUT Pool.

Modified The date onwhich the AUT Pool detailswere last modified.

Pool ID The ID of the AUT Pool.

Pool Name The name of the AUT Pool.

Note: The namemaycontain up to 128 characters, excluding spaces, periods, and anyof the
following characters:

: ; * \ / " ~ & ? { } $ % | < > + = ^ [ ] ( )

Total Hosts The total number of AUT hosts in the host pool.

NewAUT Host Pool Dialog Box
This dialog box enables you to create a new AUT Pool.

To
access

On the LabManagement sidebar, under Performance Center, selectAUT Pools. ClickNew AUT Host

Pool .

See also "AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Clear All Fields. Clears the data.
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UI
Elements

Description

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Pool
Name

The name of the AUT Pool.

Details Enablesyou to enter the details of the new AUT Pool. For more details, see "AUT Pools Fields" on the
previous page.

AUT Host Pool Details Dialog Box
This dialog box enables you to view andmodify AUT Pool details.

To
access

On the LabManagement sidebar, under Performance Center, selectAUT Hosts. Right-clickan AUT host
in the grid and selectAUT Host Details.

See
also

"AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of AUT Pools.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb
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UI Elements Description

Pool Name The name of the AUT Pool.

Details Displays the details of the selected AUT Pool. For more details, see "AUT Pools Fields" on
page 227.

Linked Hosts Enablesyou to add AUT hosts to the selected pool and remove hosts from the pool. For details,
see "Linked Hosts Page" on page 225.

History Lists changesmade to the selected AUT Pool. For more details, see theHP Application
Lifecycle Management User Guide.

AUT Resource Module Menus and Buttons
Thesemodules enable you tomanage the AUT resources which host applications under test.

To access Use one of the following:

l In Lab Management: On the LabManagement sidebar, under Performance Center,
select<AUT Resource>.

l In ALM: on the ALM sidebar, under Performance Center AUT, selectAUT Hosts.

Note: In LabManagement, you can define both AUT hostsand AUT pools. In ALM, you can
define onlyAUT hosts.

Important
Information

l AUT hosts can bemanaged both in LabManagement and in ALM.

l Onlya user with administrator privilegescanmanage AUT Pools (in LabManagement).

See also "AUT Resources Overview" on page 218

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements
(A - Z)

Where Description

<AUT
resource>
Details

<AUT
resource>
and right-
clickmenu

Opens the <AUT resource>Details dialog box, enabling you to view details of the selected
AUT resource.

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User Guide.

Copy URL <AUT
resource>
and <right-
clickmenu>

Copiesa selected AUT resourceURL and pastes it asa link. You can paste theURL into
another location, such asan email or a document. Clicking the linkopensup ALMand takes
you to the resource file or folder. If you are not already logged in, ALM first prompts for login
details.

Delete Edit and
<right-click
menu>

Deletes the AUT resource selected in the grid.

Export <AUT
Resource>

Opens the Export AllGrid Data dialog box, enabling you to export the AUT resources in the
grid asa text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.
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UI
Elements
(A - Z)

Where Description

and <right-
clickmenu>

Choose one of the following options:

l All.Exports all resources in the grid.
l Selected.Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for a resource in themodule. For details
about search options, see theHP Application Lifecycle Management User Guide.

Go to <AUT
Resource>

<AUT
Resource>

Opens theGo To <AUT Resource>dialog box, enabling you to find a specific resource by its
ID number. You can onlygo to resources that are in the current filter.

Grid Filters View and
<right-click
menu>

Enables you filter the data according to an entry in the filter box. For details about filtering
options, see theHP Application Lifecycle Management User Guide.

Import AUT Hosts Enables you to import a list of AUT hosts from anExcel file (.xls or .csv) into ALM. For details,
see "How to Import AUT Host Data from Excel" on page 218.

Information
Panel

View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

New <AUT
Resource>

<AUT
Resource>

Enables you to add an AUT resource.

Note: For AUT Pools, this is available in LabManagement only.

Organize
Favorites

Favorites Opens theOrganize Favoritesdialog box, enabling you to organize the list of favorite viewsby
changing propertiesor deleting views. For details, see theHP Application Lifecycle
Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-click
menu>

Opens theReplace dialog box in the <AUT Resource>grid, enabling you to replace a
resource field value in the grid. For more details, see theHP Application Lifecycle
Management User Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in the
grid and their order. For details, see theHP Application Lifecycle Management User
Guide.

For details about the resource fields, see:

l "AUT Host Fields" on page 222
l "AUT Pools Fields" on page 227

Set
Filter/Sort

View Enables you to filter and sort the resources in the grid. Anycurrently applied filtersor sorting
ordersare displayed below the toolbar. For details about filtering options, see theHP
Application Lifecycle Management User Guide.
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UI
Elements
(A - Z)

Where Description

Update
Selected

Edit and
<right-click
menu>

Opens theUpdate Selected dialog box, enabling you to update a field value for amultiple
selection in the <AUT resource>grid. For more details, see theHP Application Lifecycle
Management User Guide.
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Chapter 15: Project Management
After you create a LabManagement enabled project, youmanage the project in Site Administration. For
information about managing projects in ALM, see theHP Application Lifecycle Management
Administrator Guide.

In addition to themanagement tasks in Site Administration, however, there are specific use cases
where youmust be aware of additional procedures. These use cases are:

Migrating a project from a staging to a production environment
Formore information, see "How toMigrate a LabManagement System from a Staging to a Production
Environment " below.

Creating a copy of a project
For information about how to create a copy of a project, see theHP Application Lifecycle Management
Administrator Guide.

When creating a copy of a LabManagement enabled project, youmust be aware of the following:

l The new project must also have the LabManagement extension enabled.
l Details about test runs are not included in theUsage Reports.
l Timeslot and project settings are not copied.
l Result files associated with the original project are not copied.

Archiving a Lab Management project
Archiving a LabManagement enabled project means exporting or removing the project from the server
on which it is located, and in the future, importing the project back onto that same server.

For information about exporting, importing, and restoring access to projects, see theHP Application
Lifecycle Management Administrator Guide.

When archiving a LabManagement enabled project, youmust be aware of the following:

l You cannot import a project onto the original server, if a project with the same PUID exists on that
server.

l When restoring access to the project:
l Details about test runs are not included in theUsage Reports.
l Timeslot and project settings information is lost.

How to Migrate a Lab Management System
from a Staging to a Production Environment
The following task describes how to successfully move an LabManagement system from a staging to
a production environment.
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Note: As a result of migrating the system, all information contained in LabManagement originally
created in the production environment is lost.

The task includes the following steps:

l "Open Site Administration" below
l "Move LabManagement from the staging to the production environment" below
l "Activate LabManagement in the production environment"
l "Update the ALM license" below
l "Update Servers and Hosts" below
l "Move projects from the staging environment to the production environment" below
l "Activate the projects in the production environment" on the next page
l "In the production environment, configure the project settings in LabManagement " on the next page

1. Open Site Administration
For details, see theHP Application Lifecycle Management Administrator Guide.

2. Move Lab Management from the staging to the production environment
a. In the staging environment, in Site Administration, select the Lab Management tab.
b. Remove the LabManagement project from the staging and restore it in the production

environment. For details about removing and restoring LabManagement, see "Lab
Management Tab" on page 18.

3. Activate Lab Management in the production environment
For details about activating LabManagement, see "LabManagement Tab" on page 18.

4. Update the ALM license
In the production environment, in LabManagement, update the ALM license. For details, refer to
theHP Application Lifecycle Management Administrator Guide.

5. Update Servers and Hosts

Note: Perform this step if the servers and hosts in the production environment are different
than those in the staging environment.

In LabManagement, remove the existing servers and hosts and replace them with new servers
and hosts.
l For details about how to add Performance Center Server, see "How toManage Performance
Center Servers" on page 236.

l For details about how to add hosts, see "How toManage Testing Hosts" on page 97.

6. Move projects from the staging environment to the production
environment
Remove each project from the staging environment and restore them in the production
environment. For details about removing and restoring projects, see theHP Application Lifecycle
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Management Administrator Guide.

7. Activate the projects in the production environment
For details about activating projects, see theHP Application Lifecycle Management Administrator
Guide.

8. In the production environment, configure the project settings in Lab
Management
Perform this step for each project youmoved to the production environment. For details about
configuring project settings, see "Project Settings" on page 21.
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Chapter 16: PC Servers
This chapter includes:

• PC Servers Overview 236
• How toManage Performance Center Servers 236
• Performance Center Servers Module User Interface 237

HP ALM LabManagement (12.50) Page 235



PC Servers Overview
The PC Servers module enables you tomanage the information and resources needed for Performance
Center functionality. You can create new PC servers, monitor Performance Center server status, edit
server information, and check server performance.

For details onmanaging Performance Center servers, see "How toManage Performance Center
Servers" below.

How to Manage Performance Center Servers
This task describes the various options for managing the Performance Center Servers.

Note: This task is part of the following higher-level task: "How toWork with LabManagement
Administration" on page 14.

To learnmore about Performance Center Servers, see "PC Servers Overview" above.

This task includes the following steps:

l "Add a server" below
l "Check server connections to Performance Center servers" below
l "Reboot a server" on the next page
l "Install a patch on a server" on the next page

Add a server
1. In LabManagement, select Servers > PC Servers.

2. Click theNew PC Server button .
3. In the New PC Server dialog box, enter the required information. For user interface details, see

"New PC Server Dialog Box" on page 242.

Check server connections to Performance Center servers
On the LabManagement sidebar, underServers, select PC Servers. Right-click a server in the grid,
and select Check Server > Check Server.

The Task Manager opens, and the overall result of each check performed on the server, Passed or
Failed, is displayed.

You can view the progress of the server check in the PC Servers module's Check Server Status tab.

The following checks are performed:

l Ping to Server. The Performance Center server pings the selectedmachines.
l Ping URL. The selected server pings the listed URL.
Alternatively, you can perform the above checks, together with an additional connectivity check from
the server to a particular URL. Right-click a server in the grid, select Check Server > Check
Connectivity to URL, and enter the URL.
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Examples:

l Regular URL: http://www.website.com
l Machine name: machine22 or http://machine22

Reboot a server
On the LabManagement sidebar, underServers select PC Servers. Right-click the server in the grid
that you want to reboot, and select Reboot Server.

Install a patch on a server

Note: To install patches on a server, patches first need to have been uploaded to the ALM. For
details, see "How to Upload Patches to ALM" on page 212.

On the LabManagement sidebar, underServers, select PC Servers. Right-click the server in the grid
on which to install the patch and select Install Patch.

Tip: You can install a patch onmultiple servers simultaneously. To select multiple servers, hold
down the CTRL key on your keyboard while selecting the servers.

Performance Center Servers Module User
Interface
This section includes:

• PC Servers ModuleWindow 238
• PC Servers ModuleMenus and Buttons 238
• PC Servers Module Fields 240
• PC Server Details Dialog Box 241
• New PC Server Dialog Box 242
• Processes Page 243
• Check Server Status Page 244
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PC Servers Module Window
The PC Servers Module window enables you tomanage Performance Center servers.

To access On the LabManagement sidebar, under Servers, selectPC Servers.

Relevant tasks "How to Manage Performance Center Servers" on page 236

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<PC Servers
Module common
UI elements>

l PC Servers Fields.For field definitions, see "PC Servers Module Fields" on
page 240.

l PC Servers Menus and Buttons.For command and button descriptions, see "PC
Servers Module Menus and Buttons" below.

l ALM masthead, menus, and sidebar.For details, see theHP Application Lifecycle
Management User Guide.

<grid filters> Located under each column name. Displays the filter that is currently applied to a column. If the filter
box isempty, no filter is currently applied to the column.

Type directly into the box, or click the box to display the Browse button, which opens the Select Filter
Condition dialog box. For more details, see theHP Application Lifecycle Management User
Guide.

<servers grid> Displaysa list of the PerformanceCenter servers.

<Information
panel>

Located in the lower area of themodule. Displays information about the server selected in the grid.

Description tab Describes the currently selected server.

Click in the text box to displaya toolbar for formatting and spell checking the text.

Event Log tab Displaysdetailed information about the tasksperformed on the selected server, the action status,
and a description of anyerrors. For details, refer to the "PC Test Runs Module Window" on
page 141.

Processes tab Displaysdetailed information about the processesand resource usage of the selected server. For
details, see "Processes Page" on page 243.

Check Server
Status tab

Displays the statusof each step of the server checks. To see checkserver statusdetails, right clicka
line in the tab, and selectCheck Server Status Details. For details, see "Check Server
Status Page" on page 244.

History tab Lists changesmade to the currently selected host. For more details, see theHP Application
Lifecycle Management User Guide.

PC Servers Module Menus and Buttons
This section describes themenus and buttons available in the PC Servers module.

To access On the LabManagement sidebar, under Servers, selectPC Servers.

Relevant tasks "How to Manage Performance Center Servers" on page 236
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User interface elements are described below:

UI Elements Menu Description

PC
Servers
and
<right-
click
menu>

Enables you to define the internal and externalALMURL.

The internalURL isused byall PerformanceCenter components to connect to
ALM.

TheURLmust be in the following format: http://<alm>:<port>

Example: http://myalm:8080

Note: For SSL connectivity the ALM internalURLmust begin with https, for
example: https://myalm:443.

PC
Servers
and
<right-
click
menu>

Resets the system information on the selected server. For example,
internal/externalURLs, user identity, and so on.

PC
Servers
and
<right-
click
menu>

Opens the Install Patch dialog box, enabling you to select patches to install on the
selected server.

PC
Servers

Checksconnectivity between the selected server and other machines in the system.

PC
Servers
and
<right-
click
menu>

Enables you to remotely reboot the selected server.

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your
private or the public folder. For details, see theHP Application Lifecycle
Management User Guide.

Copy URL
PC
Servers

Copies the selected server and pastes itsURL asa link. The server itself is not
copied. Instead, you can paste the address into another location, such asan email
or a document. Clicking the linkopensup ALMand takesyou to the resource file or
folder. If you are not already logged in, ALM first prompts for login details.

Delete
Edit and
<right-
click
menu>

Deletes the selected server in the grid.

Export PC
Servers
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the servers in the
grid asa text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML
document.

Choose one of the following options:

l Export All.Exports all servers in the grid.
l Export Selected.Exports selected servers in the grid.
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UI Elements Menu Description

Find
View Opens the Find dialog box, enabling you to search for a server in themodule. For

details, see theHP Application Lifecycle Management User Guide.

Go to PC Server
PC
Servers

Opens theGo ToPC Serversdialog box, enabling you to find a specific server by its
ID number. You can onlygo to servers that are in the current filter.

Grid Filters View Enables you filter the data according to an entry in the filter box. For details about
filtering options, see theHP Application Lifecycle Management User
Guide.

Information Panel View Shows/Hides the Information Panel in the lower area of themodule.

New PC Server
PC
Servers

Enables you to add a PC Server.

Organize Favorites Favorites Organizesyour favorite views. For details, see theHP Application Lifecycle
Management User Guide

PC Server Details PC
Servers
and
<right-
click
menu>

Opens the PC ServersDetails dialog box, displaying details of the selected server.
For more information, see "PC Server Details Dialog Box" on the next
page.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All
View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-
click
menu>

In the PC Serversgrid, opens theReplace dialog box, enabling you to replace a
field value in the grid. For more details, see theHP Application Lifecycle
Management User Guide.

Select Columns
View Opens the Select Columnsdialog box, enabling you to determinewhich fields to

display in the grid and their order. For more details, see theHP Application
Lifecycle Management User Guide.

For details about the PC Servers fields, see "PC Servers Module Fields"
below.

Set Filter/Sort
View Enables you to filter and sort the servers in the grid. Anycurrently applied filtersor

sorting ordersare displayed below the toolbar. For more details, see theHP
Application Lifecycle Management User Guide.

Update Selected Edit Opens theUpdate Selected dialog box, enabling you to update a field value for a
multiple selection in the grid. For more details, see theHP Application Lifecycle
Management User Guide.

PC Servers Module Fields
This section describes the PC Servers module fields.

To access On the LabManagement sidebar, under Servers, selectPC Servers.
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Relevant tasks "How to Manage Performance Center Servers" on page 236

User interface elements are described below:

UI Elements (A - Z) Description

Configuration Last
Check

Displayswhether the last configuration checkpassed or failed.

Connectivity Last
Check

Displayswhether the last connectivity checkpassed or failed.

Description Adescription of the PerformanceCenter Server.

External URL TheURL used to connect to the PerformanceCenter Server from an external source.

Note: For SSL connectivity add a PerformanceCenter server using the following format for
the externalURL:

https://<pc_server>

Example: https://mypcs:443

Installation Last
Check

Displayswhether the last installation checkpassed or failed.

Internal URL TheURL used for all internal communication between the PerformanceCenter Server and ALM,
aswell as for load balancing.

Name The server name that you assign when you configure a new server.

Performance Last
Check

Displayswhether the last performance checkpassed or failed.

Server ID The server ID.

Server State The current state of the server. The possible statesare:

l Idle.The server is idle.
l Installing patch.The installation patch isbeing installed on the server, and the server is

temporarily unavailable.

l Rebooting.The server is rebooting and is temporarily unavailable.
Default: Idle

Status The current server status. The possible statusesare:

l Operational.The server isworking.
l Non-operational. The server is not working.
l Unavailable.The server is not available.

PC Server Details Dialog Box
The PC Servers Details dialog box enables you to view and update a single server.

To access 1. On the LabManagement sidebar, under Servers, select PC
Servers.

2. Right-clicka server and selectPC Server Details.
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Relevant tasks "How to Manage Performance Center Servers" on page 236

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of servers.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Server ID The ID of the server.

Name The name of the server.

Details Details the currently selected server. For details on the available fields, see "PC Servers Module
Fields" on page 240.

Event Log Displaysdetailed information about the tasksperformed on the selected server, the action status,
and a description of anyerrors. For details, see "Event Log" on page 121.

History Lists changesmade to the currently selected server. For more details, see theHP Application
Lifecycle Management User Guide.

Processes Displaysdetailed information about the processesand resource usage of the selected server. For
details, see "Processes Page" on the next page.

Server Check
Status

Displays the statusof each step of the server checks. To see server checkstatusdetails, right clicka
line in the tab, and selectServer Check Status Details. For details, see "Check Server
Status Page" on page 244.

NewPC Server Dialog Box
This dialog box enables you to add new Performance Center servers.

To access 1. On the LabManagement sidebar, under Servers , selectPC
Servers.

2. Click theNew PC Server button .

Relevant tasks "How to Manage Performance Center Servers" on page 236
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User interface elements are described below:

UI
Elements

Description

Clear All Fields.Clearsall data in the dialog box.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Details ListsPC Server fields. Required fieldsare displayed in red. For details on the available fields, see "PC Servers
Module Fields" on page 240.

Tip: Clicking in theDescription field on this page displaysa toolbar for formatting and spell checking
the text.

Name Type a name for the new server.

Syntax exceptions:Aserver name cannot include the following characters: \ / : " ? < > | * % '

Processes Page
This page displays detailed information about the processes and resource usage of the selected server.

To
access

l From the PC Servers module:
On the LabManagement sidebar, under Servers, selectPC Servers. In the information panel, select
Processes.

l From the PC Servers Details dialog box:
On the LabManagement sidebar, under Servers, selectPC Servers. Right-clicka server and select
Server Details. In the PC Server Details dialog box, selectProcesses.

Relevant
tasks

"How to Manage Performance Center Servers" on page 236

See also "PC Servers Overview" on page 236

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh.Refreshes the grid so it displays themost up-to-date information.

Kill Process.Ends the processselected in the grid.
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UI Elements Description

Note:

l Hosts module.Kill Processpermissionsare required to end the selected process.
l Performance Center Servers module.Auser with Viewer permissionshas the ability to

end the selected process.

<Processes
grid>

Displays the following details about the processes:

l Name.The name of the process.
l PID.The process ID.
l Processor Time (%).The percentage of processor time used by the process.
l Memory Usage (KBytes).The amount of memory (in kilobytes) used by the process.
l Elapsed Time (d.hh:mm:ss).The amount of elapsed time since the start of the process, whered is

the number of daysandhh:mm:ss is the number of hours, minutes, and seconds that have elapsed.

<Navigation
area>

Located at the bottom of the page, enables you to navigate through the pagesof entries in the grid. The total
number of entries is displayed on the right of the navigation area.

Check Server Status Page
This page displays the status of each step of the server checks.

To
access

l From the PC Servers module:
On the LabManagement sidebar, under Servers , selectPC Servers. In the information panel, select
Check Server Status.

l From the PC Servers Details dialog box:
On the LabManagement sidebar, under Servers, selectPC Servers. Right-clicka server and select
PCServer Details. In the PC Server Details dialog box, selectCheck Server Status.

Relevant
tasks

"How to Manage Performance Center Servers" on page 236

See also "PC Servers Overview" on page 236

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Check Server Status Details.The following fieldsare displayed:

l Actual Value.Actual value resulting from the server connectivity check.

l Check.The sub-areas in which theCheckServer feature checks the servers.
l Check Result ID.The ID of each step of the server check.

l Expected Value.Value expected to result from the server check.

l Category.The areas in which theCheckServer feature checks the server: Configuration,
Connectivity, Installation, and Performance.

l Check Date.The date the server waschecked.
l Error. If an error occurred during the check, displays the error.
l Status. Indicateswhether the server checkpassed or failed.
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UI Elements Description

Refresh.Refreshes the page.

Set Filter/Sort. Enablesyou to filter and sort the grid. Anycurrently applied filtersor sorting ordersare
displayed below the toolbar. For details, see theHP Application Lifecycle Management User
Guide.

Select Columns.Opens the Select Columnsdialog box, enabling you to determinewhich fields to
display in the grid and their order. For details, see theHP Application Lifecycle Management User
Guide.

Find.Opens the Find dialog box, enabling you to search in the grid. For details, see theHP Application
Lifecycle Management User Guide.

<Check
Server
Status grid>

Displays the statusof the server checks. Click to select columns to display in the grid.

Actual Value Actual value resulting from the server connectivity check.

Category The areas in which theCheckServer feature checks the server:

l Configuration

l Connectivity

l Installation

l Performance

Check The sub-areas theCheckServer feature checks. For example, sub-areas in the Performance checkare
Processor, Memory, and System.

Check Date The date the server waschecked.

Check
Result ID

The ID of each step of the server check.

Error If an error occurred during the check, displays the error.

Expected
Value

Value expected to result from the server check.

Status Indicateswhether the server checkpassed or failed.
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Chapter 17: CDA Servers
This chapter includes:

• CDA Servers Overview 247
• How toManage CDA Servers 247
• CDA Servers User Interface 248
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CDA Servers Overview
The CDA Servers module is used to create and configure HP Continuous Delivery Automation (CDA)
 servers within LabManagement. CDA provides a datamodel that represents the artifacts and
relationships required to define how composite applications are delivered to a dynamic set of target
environments.

CDA integrates with ALM to provide dynamic provisioning and deployment of resources. When you link
an AUT environment configuration to CDA, ALM can then run the linked tests without requiring the user
to provide specific values for the environment parameters. Once CDA servers are defined in Lab
Management, they can be used in ALM to link AUT environment parameters to CDA parameters. For
more information about CDA and AUT Parameters, see theHP Application Lifecycle Management
User Guide.

How to Manage CDA Servers
This task describes how to create CDA servers in LabManagement. Youmanage CDA servers in Lab
Management and implement CDA linkages in ALM.

Use the following workflow to configure CDA in ALM:

1. Update the Communication Security Passphrase
a. In Site Administration, update theCOMMUNICATION_SECURITY_PASSPHRASE site

parameter. For details, see theHP Application Lifecycle Management Administrator Guide.
b. Restart the HP Application Lifecycle Management service on the ALM server.

2. Create the CDA Server in Lab Management
a. In LabManagement, select Servers > CDA Servers.

b. Click theNew CDA Server button .

Note: You can only have one CDA server per site.

c. In the New CDA Server dialog box, enter your server information. For details about the
CDA fields, see "CDA Servers Module Fields" on page 251. For user interface details, see
"New CDA Server Dialog Box" on page 251.

d. After you submit, the CDA server data undergoes a compatibility check. The internal URL is
used to check connectivity. If there are no problems with connectivity, your CDA server
appears in the grid.

3. Update Project Settings
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a. In LabManagement, select Lab Settings > Project Settings.

b. Select the relevant project from the grid and click theProject Settings Details button.
c. In the Project Settings Details dialog box, update theCDA Server andCDA Domain fields.

Click OK.
Your CDA server is now ready to be linked with ALM.

CDA Servers User Interface
This section includes:

• CDA Servers ModuleWindow 249
• CDA Servers ModuleMenus and Buttons 249
• CDA Servers Module Fields 251
• New CDA Server Dialog Box 251
• CDA Server Details Dialog Box 252
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CDA Servers Module Window
To access On the LabManagement sidebar, under Servers, selectCDA Servers.

Relevant tasks "How to Manage CDA Servers" on page 247

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<CDA Servers
Module common UI
elements>

l CDA Servers Fields.For field definitions, see "CDA Servers Module Fields" on
page 251.

l CDA Servers Menus and Buttons.For command and button descriptions, see "CDA
Servers Module Menus and Buttons" below.

l ALM masthead, menus, and sidebar.For details, see theHP Application Lifecycle
Management User Guide.

<grid filters> Located under each column name. Displays the filter that is currently applied to a column. If the
filter box isempty, no filter is currently applied to the column.

Type directly into the box, or click the box to display the Browse button, which opens the Select
Filter Condition dialog box. For more details, see theHP Application Lifecycle
Management User Guide.

<servers grid> Displaysa list of the CDAservers.

History tab Lists changesmade to the currently selectedCDA server. For more details, see theHP
Application Lifecycle Management User Guide.

CDA Servers Module Menus and Buttons
This section describes themenus and buttons available in the CDA Servers module.

To access On the LabManagement sidebar, under Servers, selectCDA Servers.

Relevant tasks "How to Manage CDA Servers" on page 247

User interface elements are described below:

UI
Elements
(A - Z)

Menu Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view to your private or the
public folder. For details, see theHP Application Lifecycle Management User
Guide.

CDA
Server
Details

CDAServers
and <right-
clickmenu>

Opens theCDAServersDetails dialog box, displaying details of the selected server. For
more information, see "CDA Server Details Dialog Box" on page 252.
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UI
Elements
(A - Z)

Menu Description

Delete
Edit and
<right-click
menu>

Deletes the selected server in the grid.

Export CDAServers
and <right-
clickmenu>

Opens the Export Grid Data dialog box, enabling you to export the servers in the grid asa
text file, Microsoft Excelworksheet, MicrosoftWord document, or HTML document.

Choose one of the following options:

l Export All.Exports all servers in the grid.
l Export Selected.Exports selected servers in the grid.

Find
View Opens the Find dialog box, enabling you to search for a server in themodule. For details,

see theHP Application Lifecycle Management User Guide.

Go to CDA
Server

CDAServers Opens theGo ToCDAServersdialog box, enabling you to find a specific server by its ID
number. You can onlygo to servers that are in the current filter.

Grid Filters View Enables you filter the data according to an entry in the filter box. For details about filtering
options, see theHP Application Lifecycle Management User Guide.

Information
Panel

View Shows/hides the Information Panel in the lower area of themodule.

New CDA

Server

CDAServers Enables you to add aCDAServer.

Organize
Favorites

Favorites Organizesyour favorite views. For details, see theHP Application Lifecycle
Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-click
menu>

In theCDAServersgrid, opens theReplace dialog box, enabling you to replace a field value
in the grid. For more details, see theHP Application Lifecycle Management User
Guide.

Select
Columns

View Opens the Select Columnsdialog box, enabling you to determinewhich fields to display in
the grid and their order. For more details, see theHP Application Lifecycle
Management User Guide.

For details about the PC Servers fields, see "CDA Servers Module Fields" on the
next page.

Set
Filter/Sort

View Enables you to filter and sort the servers in the grid. Anycurrently applied filtersor sorting
ordersare displayed below the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Update
Selected

Edit Opens theUpdate Selected dialog box, enabling you to update a field value for amultiple
selection in the grid. For more details, see theHP Application Lifecycle Management
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UI
Elements
(A - Z)

Menu Description

User Guide.

CDA Servers Module Fields
This section describes the CDA Servers module fields.

To access On the LabManagement sidebar, under Servers, selectCDA Servers.

Relevant tasks "How to Manage CDA Servers" on page 247

User interface elements are described below:

UI Elements
(A - Z)

Description

External URL TheURL used to connect to the CDAServer from an external source. This field is required.

Use the following format for the URL: http://[ServerName]:[Port]/cda

Note: For SSL connectivity add aCDAserver using the following format for the externalURL:

https://<cda_server>

ID The server ID.

Internal URL TheURL used for all internal communication between the PerformanceCenter Server and ALM, as
well as for load balancing.

Name The server name that you assign when you configure a new server.

Use the following format for the URL: http://[ServerName]:[Port]

New CDA Server Dialog Box
This dialog box enables you to create a new CDA server.

To access 1. On the LabManagement sidebar, under Servers , selectCDA
Servers.

2. Click theNew CDA Server button .

Relevant tasks "How to Manage CDA Servers" on page 247

User interface elements are described below:

UI
Elements

Description

Clear All Fields.Clearsall data in the dialog box.
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UI
Elements

Description

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith asterisk "*"
and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

Details ListsCDAserver fields. Required fieldsare displayed in red. For details on the available fields, see "CDA
Servers Module Fields" on the previous page.

Tip: Clicking in theDescription field on this page displaysa toolbar for formatting and spell checking
the text.

Name Enter a name for the new server.

Syntax exceptions:Aserver name cannot include the following characters: \ / : " ? < > | * % '

CDA Server Details Dialog Box
The CDA Servers Details dialog box enables you to view and update a single server.

To access 1. On the LabManagement sidebar, under Servers, select CDA
Servers.

2. Right-clicka server and selectCDA Server Details.

Relevant tasks "How to Manage CDA Servers" on page 247

User interface elements are described below:

UI Elements Description

Save.Saves the details.

First/Previous/Next/Last Entity. Enablesyou to browse through the list of servers.

Spell Check.Checks the spelling for the selectedword or text box.

Thesaurus.Displaysa synonym, antonym, or related word for the selectedword.

Spelling Options.Enablesyou to configure how to check the spelling.
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UI Elements Description

Field Search.Enablesyou to search for a specified field name. Supportswildcard searchwith
asterisk "*" and questionmark "?".

For example: a*b returnsacb and adefb; a?b returnsacb

ID The ID of the server.

Name The name of the server.

Details Lists the details the currently selected server. For details on the available fields, see "CDA
Servers Module Fields" on page 251.

History Lists changesmade to the currently selected server. For more details, see theHP Application
Lifecycle Management User Guide.
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Chapter 18: Lab Service
This chapter includes:

• HP ALM Lab Service Overview 255
• Installing HP ALM Lab Service 255
• Using HP ALM Lab Service 261
• HP ALM Lab Service Agent 263
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HP ALM Lab Service Overview
HP ALM Lab Service acts as an agent on the testing host, enabling ALM to remotely trigger tests and
maintenance tasks on the host.

Lab Service runs in the background on the testing host. In order to integrate your testing host with ALM
LabManagement capabilities, you define the host in the Hosts/Testing Hosts module in Lab
Management or ALM and then point ALM Lab Service to the ALM server using the Lab Service Settings
page. For user interface details, see " HP ALM Lab Service Agent" on page 263.

A one-time registration process validates the identity of the agent and establishes a secure
communication channel between ALM and the host. After registration, use ALM to run functional tests
and perform maintenance tasks on the remote host.

Lab Service acts as a secure interface between ALM and your testing host. Communications with
ALM, such as test requests, test results, andmaintenance tasks pass through Lab Service. The Lab
service communicates with ALM over the standard HTTP protocol and can traverse firewalls. Stopping
the ALM Lab service prevents ALM LabManagement from using the host for running tests.

For task information, see "Using HP ALM Lab Service" on page 261.

Installing HP ALM Lab Service
This task describes how to install HP ALM Lab Service.

Note: Tomodify or repair your HP ALM Lab Service installation, see "Modify or Uninstall HP ALM
Lab Service" on page 260.

Install Lab Service using the HP ALM Lab Service - Installation Wizard
1. Download the HP ALM Lab ServiceMSI installation file from the HP ALM Add-ins page. Select

the installation path that matches your operating system.

Note: Lab Service and the ALM server to which you are connectingmust be of the same
version in order to be compatible. If your version of Lab Service is not the same as the
ALM server, the Hosts/Testing Host grid displays your testing host as Unavailable.

2. Run theMSI installation file. TheHP ALM Lab Service - Installation Wizard launches on the
Welcome screen.
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Note:

l Administrator permissions are required on themachine.
l User Access Control (UAC)must be disabled.

Click Next.
3. TheDestination Folder screen opens.

Specify in which folder you want to install Lab Service. To change the destination folder, click
Change.

Note: Youmust have read/write permissions to the destination folder.

To install to the folder displayed, click Next.
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4. TheCustom Setup screen opens.
You can enable Lab Service's Auto Login feature at this stage in the installation. Click the Auto
Login checkbox icon and select Enable this feature. For more information about Auto Login, see
"Auto Login" on page 263.

Caution: ForWindows XP, HP ALM Lab Service setup installs a file (GINA DLL) which is
necessary for Auto Login. If another application has already customized login to your host, a
different versionmay already be installed, and replacing this file could cause errors. If you
would like to enable the Auto Login feature, uninstall the other application and restart the Lab
Service installation.

Click Next.
5. TheConfirm Settings screen opens.
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To review or change any settings, click Back.
To accept the settings and start the installation process, click Next.
The Installation page opens and the HP ALM Lab Service files are installed on your machine.

6. After the installation completes, theHP ALM Lab Service Settings dialog box opens along with
the Finish screen.

You can enter your host settings into the Lab Service Settings dialog box and click OK. For user
interface details about the Lab Service Settings Page, see " HP ALM Lab Service Agent" on
page 263.

Note:

l We recommend you configure the Lab Service settings at this stage, but you can configure
it later as well. The agent will not function until the settings are configured.
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l If you enabled Auto Login during the installation, you will be prompted to restart your
computer. Make sure to enter your details into the Lab Service Settings page before
restarting.

The Lab Service installation is complete. Click Finish on the Finish screen. The Lab Service tray
icon appears on theWindows taskbar.

Install Lab Service using silent installation
From the command line, enter theMicrosoft MSI silent installation command:

msiexec /i "<msi-location>/HpAlmLabService_x64.msi" /quiet
SERVERNAME=http://<server_name>:<port>/qcbin HOSTUSERNAME=<user_name>

Note:

l Administrator permissions are required on themachine.
l User Access Control (UAC)must be disabled.

The following ALM-specific parameters are available:

Parameter (A - Z) Description

HOSTUSERDOMAIN=<domain> Required when Auto Login is enabled. Specifies the login
user's domain.

HOSTUSERNAME=<user_name> Required parameter.Specifies the user that must be
logged in when running testson the testing host.

Note: The user you select must have the following
permissions:

l Create global objects.

l AllCOMpermissions.

l Read/write permissions to the destination folder.

l All permissionsneeded to run testsof the desired
type. For example, if you intend to runUFT tests
fromALM, the selected user must have all
permissionsneeded to runUFT tests. For more
information about the permissions required per
testing tool, see the user guide for the appropriate
testing tool.

HOSTUSERPASSWORD=<password> Required when Auto Login is enabled. Specifies the login
user's password.

ISAUTOLOGIN=1 Enables the Auto Login feature. If Auto Login is enabled, you
must use theHOSTUSERDOMAIN and
HOSTUSERPASSWORD parameters. For more
information about Auto Login, see "Auto Login" on
page 263.

LOGLEVEL=<log-level> Configures the level (<log-level>) at which Lab Service will
write logs. Supports the following log levels: Error, Off,
Warning, Info, Verbose. For more information about log
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Parameter (A - Z) Description

levels, see " HP ALM Lab Service Agent" on
page 263.

LOGLOCATION="<log-directory>" Configures the location (<log-directory>) in which the
Lab Service logswill be written.

REGISTER=1 Automatically sendsa registration request to the ALM server
after the installation completes.

SERVERNAME=http://<server_
name>:<port>/qcbin

Required parameter.TheURL of the ALM server.

Example:
SERVERNAME=http://almserver1:8080/qc
bin

Additional standardMSI parameters are available. Type msiexec /? from the command line for more
information.

Modify or Uninstall HP ALM Lab Service
Modify HP ALM Lab Service Installation
1. Run theMSI installation file. TheHP ALM Lab Service - Installation Wizard launches on the

Welcome screen. Click Next.
2. TheProgram Maintenance screen opens.

Select theModify radio button. Click Next.
3. TheCustom Setup screen opens.

Use the feature icons to enable or disable HP ALM Lab Service features.
Click Next.

4. The Confirm Settings screen opens.
Click Next.

5. The Finish screen opens. Click Finish.

Remove HP ALM Lab Service

Caution: After removing Lab Service, youmust restart the host before reinstalling a different
version. If you try to reinstall a new version without restarting, the installation fails.

To remove Lab Service using the MSI file:
1. Run theMSI installation file. TheHP ALM Lab Service - Installation Wizard launches on the

Welcome screen. Click Next.
2. TheProgram Maintenance screen opens.

Select theRemove radio button. Click Next.
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3. TheRemove the Program screen opens. Click Remove.
If Lab Service was running when you ran theMSI installation file, the Files in Use screenmay
open. Click OK to complete the removal.

4. The Finish screen opens. Click Finish.

To remove Lab Service using Windows Programs and Features:
1. Open the Programs and Features screen inWindows by going toControl Panel\All Control

Panel Items\Programs and Features.
2. Right click onHP ALM Lab Service, and select Uninstall.

To remove Lab Service using the silent uninstallation, run one of the
following commands:
l msiexec /x "<msi-location>\HpAlmLabService_x64.msi"

l msiexec /x {8A0D781B-7976-419F-91D9-15F3121FCFA5}

Using HP ALM Lab Service
This task describes how to use HP ALM Lab Service. To run tests from Functional test sets on your
testing hosts using ALM, youmust register your host with ALM using Lab Service.

To learnmore about HP ALM Lab Service, see "HP ALM Lab Service Overview" on page 255.

Note: Lab Service and the ALM server to which you are connectingmust be of the same version in
order to be compatible. If your version of Lab Service is not the same as the ALM server, the
Hosts/Testing Host grid displays your testing host as Unavailable.

This task includes the following steps:

l "Create the Testing Host" below
l "Configure HP ALM Lab Service " on the next page
l "Approve the Host Registration in LabManagement" on the next page
l "Stop/Start Lab Service " on the next page

1. Create the Testing Host
In ALM or LabManagement, under Lab Resources, select the Hosts/Testing Hosts module. Click
theNew Testing Host button and input your testing host information. The Registration Status
for the new testing host is set toNot Registered.

Note: You can arrange for ALM to automatically approve a testing host registration by setting
Registration Auto Approve toY.

For task details, see "How toManage Testing Hosts" on page 97.
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For user interface details, see "New Testing Host Dialog Box" on page 119.

2. Configure HP ALM Lab Service
To configure Lab Service, you need:
l The ALM server URL.
l The dedicatedWindows user name to be used exclusively for running the test on your testing
host.

Note: The user you select must have the following permissions:

o Create global objects.
o All COM permissions.
o All permissions needed to run tests of the desired type. For example, if you intend to

run UFT tests from ALM, the selected user must have all permissions needed to run
UFT tests. For more information about the permissions required per testing tool, see
the user guide for the appropriate testing tool.

l The password and domain of theWindows user name. These are available only if you enabled
Auto Login during installation.

l (Optional) The URL and credentials of the proxy server used for communication between the
testing host and ALM.

You can configure Lab Service to communicate with ALM by using the Settings page.
To register Lab Service using the Settings page:
a. Right-click the Lab Service icon in your system tray. Open the Settings page.
b. Provide the ALM server URL and your host user information. Provide proxy server information

if necessary. For user interface details about the Settings page, see " HP ALM Lab Service
Agent" on the next page. Click Register Host.

c. Refresh the host grid in LabManagement. TheRegistration Status for the new host is set to
Pending.

3. Approve the Host Registration in Lab Management
If you set Registration Auto Approval toY when you created the host, then the registration will
be automatically approved.
If the host is not set to be automatically approved, youmust approve it manually. The host
registration request can be approved from within LabManagement by a Lab Administrator. If the
host was created as a private host from within an ALM project, registration can be approved from
within that project.
Select your host from the grid in the Hosts module, click theHost Operations drop-down arrow
and select Approve Registration. TheRegistration Status changes from Pending to
Registered.
Your new testing host is registered. You can now schedule and run Functional tests on this host
using ALM.

4. Stop/Start Lab Service
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You can start and stop Lab Service using the icon in the taskbar. Right click on the icon and do
one of the following:
l To stop, click Stop ALM Lab Service.
l To start, click Start ALM Lab Service.

Caution:

l Stopping Lab Servicemakes the testing host appear as Non-Operational in Lab
Management. You cannot run tests using server-side execution on your testing host until
you start it again.

l If you wait too long after stopping Lab Service, ALM stops polling to see if Lab Service was
restarted. Youmust manually set the testing host's Status toOperational in the
Hosts/Testing Hosts grid.

Auto Login
For ALM to run tests on your registered testing host, Lab Servicemust have a user logged in to the
testing host, and the user must have permission to run the test. To avoid a situation in which the user is
not logged in, you can configure Lab Service to automatically log in to the testing host using the user
whenever you request a test execution.

If you enable Auto Login, youmust fill out the username and password values in the Settings page. For
more information, see " HP ALM Lab Service Agent" below.

If you have Auto Login enabled and you disconnect from the session (for instance, if you close the
session window), Lab Service will automatically log the user back in and finish the test. However, if
you lock the screen, ALM is not able to run a test which requires the session user interface (such as
UFT GUI Testing).

Note:

l To enable Auto Login, administrator permissions are required on themachine.
l To enable Auto Login, User Access Control (UAC)must be disabled.
l To disable or enable Auto Login on an already existing Lab Service installation, run theMSI file
and click Modify. For more details, see "Modify or Uninstall HP ALM Lab Service" on page 260.

HP ALM Lab Service Agent
To access Right click the Lab Service icon on theWindows taskbar and selectSettings.

Important
information

You can use the Settingspage tomanage communication between Lab Service and the ALM
server.

Relevant tasks "Using HP ALM Lab Service" on page 261

See also "HP ALM Lab Service Overview" on page 255
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User interface elements are described below:

General tab

This tab contains general settings for the lab service.

UI Elements Description

Server
Settings
section

ALM Server.TheURL of the ALM server for communicating with Lab Service.

TheURL should be in the following format:
http(s)://<ServerName>:<Port>/qcbin

Host
Settings
section

l Host user name.The name of theWindowsuser to be used to run ALM testson this host. Thisname
cannot include the \backslash character.

Note: The user you select must have the following permissions:
l Create global objects.

l AllCOMpermissions.

l Read/write permissions to the destination folder.

l All permissionsneeded to run testsof the desired type. For example, if you intend to runUFT
tests fromALM, the selected user must have all permissionsneeded to runUFT tests. For
more information about the permissions required per testing tool, see the user guide for the
appropriate testing tool.
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UI Elements Description

l Host password.The password of theWindowsuser. This field is available only if Auto Login is
enabled.

l Host domain.The domain of theWindowsuser. This field is available only if Auto Login is enabled.

Host
Registration
section

l Host name.The name used byALM to identify your testing host.

l Message.Themessage sent to the LabManagement administrator.
l Register Host.Thisbutton registers the testing host with the ALM server.

For more information, see "Using HP ALM Lab Service" on page 261.

Log
Settings
section

Log files location.The directory to which the logsare written. The log records the progressof test runs
andmaintenance tasks. If the location doesnot exist, it is created. This field cannot be empty.

Note: If the write permissions for the log location path do not include the user name defined in the
Host Settingssection, the execution runsbut no logsare generated.

Log Level.Select a log level from the drop downmenu:

l Off.No logsare generated.
l Error.Onlyerrorsare written to the log.
l Warning.Errorsandwarningsare written to the log.
l Info.Errors, warnings, and general information iswritten to the log.
l Verbose.All actionsdone by the Lab Service agent are written to the log.

Caution: Raising the Log Levelmayaffect performance.We recommend leaving it atError level
unlessyou need to produce debugging information.
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Proxy tab

This tab allows you to enter proxy server information if your testing host should communicate with ALM
via a proxy server.

UI Elements (in
order of
appearance) Description

No Proxy Select this option if the testing host communicatesdirectlywith the ALM server.

Manual Proxy
Configuration

Select this option if the testing host communicateswith the ALM server via a proxyserver. If you
select this option, youmust enter a proxy type and proxyserver, and optionally a username and
password.

Proxy Type The protocol used for communication between the testing host and the proxyserver.

Proxy Server :
<port number>

The hostname or IP addressof the proxyserver. Make sure to enter a port number in the field on the
right.

Proxy server
requires a
password

Select this option if communication with the proxyserver requiresauthentication. If you select this
option, youmust enter a username and password for the proxyserver.

Username Username used to authenticate against the proxyserver.
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UI Elements (in
order of
appearance) Description

Password Password for the supplied username.

Note: Some proxy settings are unavailable from the UI. You can configure advanced proxy
settings by modifying the configuration fileHP.ALM.Lab.Agent.RemoteService.exe.config
which resides in the HP ALM Lab Service installation directory. The default installation directory is
C:\Program Files\HP\HP ALM Lab Service. To edit the configuration file, follow theMSDN
intructions that are available in this link.
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Send Us Feedback
Canwemake this LabManagement Guide better?

Tell us how: SW-Doc@hp.com
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